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“It’s Apple’s best 
iPad model yet”

 9.7-inch iPad Pro on test

 Issue 300   June 2016  
 macformat.com   @macformat

Revamp an old 
MacBook Air
 Make it useful for today’s tasks

Make your own

 Set up remote access to all your 
files from anywhere in the world!

PLUS! Build an AirPrint receiver

Master iOS 9.3’s 
all-new features
 Explore Night Shift and more

Discover how  
to use HomeKit
 From home to ‘smart home’!

THE UK’s  
BEST-SELLING 

APPLE  
MAG!

Become an Apple Genius with our very best tips for OS X,  
iWork, iTunes, Spotlight, Finder, Safari, Mail and more…

Greatest ever Mac tips

Mac iPhone iTunes PhotosiPad  Watch iCloud





During Apple’s recent March event, company exec Jeff Williams underscored the firm’s 
commitments to improving the health and wellbeing of its users. Now another company is making 

a similar pledge with the launch of the AliveCor Kardia Band. Its an Apple Watch strap with an 
embedded EKG sensor, so it can actively monitor your heart rate and detect the telltale signs of 
atrial fibrillation and other heart abnormalities. It can then send this data directly to your doctor, 

helping them with diagnoses and treatment plans. It may one day save your life.
 Price TBC  INCLUDES AliveCor Kardia Band for Apple Watch  

 WEBSITE alivecor.com  WORKS WITH Apple Watch

AliveCor Kardia Band

 iOpener
Game-changing tech from the world of Apple and beyond

Wear your heart on your sleeve with your Apple Watch

The Kardia’s EKG sensor is integrated into 
the AliveCor Apple Watch band, meaning 
you’ll have a potentially life-saving 
device wherever you go.
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 In the month that Apple turned 40, we 
also celebrated another milestone, making 
our 300th issue after almost 23 years of 
bringing you the very best Apple advice. 
Thanks to all of you for helping us get 
this far – some of you have even been with 
us since those early days in the 1990s! 

As with any technology, things have 
moved on at great pace, and Apple itself has 
gone from Silicon Valley giant to floundering 
enterprise – and back again! Altough we 
can’t bring you advice for kit that’s obsolete, 
we’ve delved into OS X as it is today to 

bring you our biggest ever tips feature – the 300 greatest ever Mac 
tips! Covering everything from Finder and text tools to iWork and 
security, you’ll find plenty of tricks you’ve never heard of before, and 
many that will refresh your memory to just how great your Mac can be.

Continuing our 300th celebrations, you’ll find a fun piece of Apple 
nostalgia on page 112, where top artist Rod Hunt has created a unique 
snapshot of Apple Campus 2. Can you find Tim Cook? The hidden Steve 
Jobs poster? Take some time to check off all the fun things to find in the 
image. Finally, we’ve got full reviews of Apple’s very latest products, the 
9.7-inch Pad Pro and the iPhone SE. Read them on pages 92 and 94.

CHRISTIAN HALL  
EDITOR
editor@macformat.com

Alan Stonebridge
Production Editor 
 Alan has been streaming 

Star Wars: Battlefront to his 
Mac in Sony’s Remote Play 
app, and lamenting the big 
games that don’t get ported.

Alex Blake
Commissioning Editor 
 Alex reviewed the tiny 

iPhone SE and it’s made 
him question his loyalty to 
his iPhone 6 Plus. If only he 
had smaller thumbs…

Paul Blachford
Managing Art Editor 
 Following hot on the heels 

of Apple’s big anniversary, 
Paul’s been celebrating his 
own 40th – issue of working 
on MacFormat, that is.

Seth Singh
Digital Art Editor 
 Having seen Wales qualify 

for this summer’s Euros, 
Seth’s been keen to get his 
footy boots back on - now 
where were they again?
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Become an Apple Genius with our very best tips for OS X,  
iWork, iTunes, Spotlight, Finder, Safari, Mail and more…

Make your house smarter with  
our top home automation advice
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17 APPLE HOME
 Build the smart home of the future today 

18 SMART MOWING
 Trim your lawn with this garden gear

22 APP AGRONOMY
 Look after your plants with iOS

24 HOME GADGETS
 Secure your home with a smart alarm

8 RUMOUR & NEWS
 The core Apple news you need to know about  

11 APPS & GAMES
 Our top picks of the month for Mac and iOS 

12 APPLE FACTS
 Amazing stats from the world of Apple

14 NEWS FEATURE & OPINION
 Going deeper into the hot topics of the month

15 SPLIT VIEW
 The team’s views on the latest Apple tech
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53 APPLE SKILLS
 Expand your knowledge with our tutorials

54 GET SMART WITH PRIVACY
 Keep your online activity under wraps

56  MAKE INTERACTIVE BOOKS
 Use iBooks Author to make your own iBooks

58 CREATE A PERSONAL CLOUD
 Set up remote access to your files

62  MASTER AFFINITY PHOTO
 Get perfect landscapes in Serif’s app

64  NEW FEATURES OF iOS 9.3
 Discover the improvements Apple just made

66  PROJECT: BUILD AN 
AIRPRINT RECEIVER

 Add AirPrint to a USB or network printer

71 GENIUS TIPS
 Howard Oakley solves your Mac and iOS issues

72 NETWORKS
 Networking not working? Fix it with our tips

74  MAC SOFTWARE
 Easy your app-fuelled anxieties with our fixes

76 iOS SOFTWARE
 Swipe away your touchscreen troubles

APPLE SKILLS 

GENIUS TIPS 

LOVE 
YOUR 
MAC

91 APPLE CHOICE
 Our verdicts on the latest hardware and apps, 

including the new iPad Pro and iPhone SE

106 STORE GUIDE
 Get help with picking your next piece of Apple 

hardware and the best add-ons to go with it

APPLE CHOICE 

Issue 300 CONTENTS

Turn to page 26
*INCLUDES PRINT AND  

DIGITAL EDITIONS

SUBSCRIBE 
TODAY! 

 Inspiring ideas for 
revamping old Apple kit

79

78 BACK ISSUES
 Head here if you’ve missed an issue 

112 WHERE’S TIM?
 Can you spot the CEO in Campus 2?

1

REGULARS 

94

WIN! 90

64

A Logi Circle 
IP cam
 Keep your home under  
surveillance with this prize

YEARS 
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PRICE OF

2
1

GET

114 NEXT MONTH
 What’s coming in MF301, on sale 7 June
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Contact us

 Email your queries 
and your questions to 

letters@macformat.com

 Keep up to date by 
following us on Twitter  

@macformat

 Join the conversation 
at facebook.com/

macformat

EDITED BY CHRISTIAN HALL 

APPLE RUMOUR

 While Apple was busy launching a new iPhone, iPad Pro and, yes, new 
Apple Watch bands at its March event, there was no mention of any 
changes to the Watch itself. Hope was offered, however, by Barry Lam, 
chairman of Watch manufacturer Quanta. He told an investors meeting to 
expect limited stock of Apple Watch 2 in late Q2 and throughout Q3 2016, 
giving a possible launch date of June 2016 – right around the time of 
WWDC. If that falls through, September 2016 is the next most likely date.

So what are we likely to see in Apple Watch 2? 
Many analysts expect it to be more of an ‘S’ update 
of the type we normally see with iPhones, meaning 
better internals and a few tweaks here and there, 
rather than the rounded face or ‘platinum edition’ 
that some people have been floating. Of course, that 
all depends on whether Apple still sees the Watch as 
an iPhone companion or as a separate device in its 
own right, deserving more extensive development.

It’s now over a year since the original Apple 
Watch began shipping, so we’d expect to hear news 
of an update sooner rather than later. What might 
that new version entail? Here’s what’s on the minds 
of the MacFormat team…

8 | MACFORMAT  macformat.com  @macformat

What’s inside 

8–10 
RUMOUR & NEWS

 The core Apple news 
you need to know about

11 
APPS & GAMES
 Our top picks of the 

month for Mac and iOS 

12 
APPLE FACTS

 Amazing stats from 
the world of Apple

14 
OPINION

 Adam Banks mulls 
over Apple’s indirect 

influence on his career

15
SPLIT VIEW

 The team’s views on 
the latest Apple tech

I’m more excited 
to see where Apple 
goes with the Watch 

than I am about iPhone 7

Alan says…

An updated Apple Watch? It’s about time!

Apple Watch 2

1

WATERPROOFING
 The current Watch has an IPX7 

water-resistance rating, so it can 
stand being submerged for a 

short duration up to one metre – 
though Apple cautions against it. 

Waterproofing is heavily 
requested, and would enhance 
the Watch’s sport credentials.

2

ZIPPIER PROCESSOR
 CPU designer ARM has just 
released its new Cortex-A32 

processor, which promises 25% 
faster performance compared 

to its Cortex-A7 processor. 
It achieves that while using 

less power as well.

1



3

2

1

Rumour APPLE CORE
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SLIMMING DOWN 
 Rumours have long 

circulated that the iPhone 7 
will be super-slim, and the 
latest suggests it will do this 
through redesigned antenna 
modules and radio chips.

OS X 10.12 FUJI
 The new version of OS X, 

supposedly codenamed Fuji, 
is mooted to ship with Siri, 
and could be released in 
September or October 2016.

THE POLL

 Hot on the heels of the 
tech giant’s latest moves…

 Log on and see next 
issue’s big question!
twitter.com/macformat
facebook.com/macformat

WE ASKED… Which size 
iPad is right for you?

DUAL CAMERAS
 The iPhone 7 may come 

with dual cameras – but only 
on the Plus – meaning higher 
quality shots and a lens that’s 
flush with the iPhone’s body.

3

FACETIME CAMERA
 Apple added support for 
FaceTime audio calls in 

watchOS 2, and rumour has it 
Apple Watch 2 will pack a built-in 
FaceTime camera. It may take a 

while to get used to making video 
calls from your wrist, but Apple 

has never been afraid of change.

4

BEEFIER BATTERY
 The Watch’s ‘all-day’ battery 

life is perfectly capable for most 
users, but a charge that lasts a 
few days would be a welcome 
addition. Apple is reportedly 

working with Samsung and LG to 
create thinner OLED screens to 

accommodate this larger battery. 

2

4

3

55.2%

17.15%27.65%

7.9-inch  
(iPad mini 4)

12.9-inch 
(iPad Pro)

9.7-inch 
(iPad Air 2)



CLASSIC 
APPLE
FACTS

S
ince bringing Force Touch and 
3D Touch to the iPhone, iPad Pro, 
Magic Trackpad and most of its 

MacBook line-up, there’s one conspicuous 
place where Apple’s deep press technology 
is missing: the Magic Mouse.

That might be set to change. A patent 
filed by Apple in early April 2016 depicts 
a Force Touch-enabled Magic Mouse that 
would be able to “[exert] pressure on the 
force sensor” within the mouse, and then 
feed that back to the user. Different 
amounts of force could be used for different 
functions, and would generate differing 
levels of feedback. As with the iPhone 6s 

 When Apple shares 
first went on sale 
at its 1980 initial 

public offering, they 
were priced at $22 

each. If you’d bought 
100 shares back then, 

they’d be worth a 
staggering $600,000 

today – and that’s 
before dividends are 
paid out. Not a bad 

return on investment!

THE COST OF 
ONE APPLE 

SHARE IN 1980

RESOLUTION 
OF THE APPLE 

QUICKTAKE

THE YEAR APPLE 
BECAME RICHER 
THAN THE USA

and Magic Trackpad 2, a haptic motor 
would be used to send this feedback to you.

It’s not clear when – if ever – Apple 
would implement such technology. 
However, the Magic Mouse 2 (released in 
October 2015) was only slightly different to 
its predecessor, switching to an integrated 
battery that charges over a Lightning cable, 
so it isn’t outside the realm of possibility 
that Apple is working on something more 
significant for Magic Mouse 3. 

A
pple has updated its MacBook 
range with new models featuring 
Skylake processors, an extra hour 

of battery life, faster memory, better 
graphics and a new Rose Gold colour.

The exterior chassis remains the same, 
though, with the same butterfly keyboard 
mechanism, 12-inch Retina display and sole 
USB-C port as the 2015 model. The price 
also remains unchanged, with the base 
model with a 1.1GHz m3 processor costing 
£1,049, while the 1.2GHz m5 version comes 
in at £1,299. The sixth-generation processor 
can also be upgraded to a 1.3GHz m7, which 
Intel’s Turbo Boost tech can take to 3.1GHz.

While available storage capacities 
remain at 256GB and 512GB, the PCIe-
based flash storage has had a speed boost, 
meaning apps load even more quickly. 

The updated specs also mean Apple 
has managed to squeeze an extra hour of 
battery life into the MacBook, so it can be 
used for 10 hours without needing to be 
charged up. Apple says it’s perfect for “all 
day, on-the-go computing”.

In addition, the MacBook Air range also 
received a slight update – all models now 
come with 8GB of memory as standard – so 
it seems Apple hasn’t forgotten this line of 
the MacBook family, as some suspected.

 Apple expanded its 
line-up in the 1990s and 
helped pioneer digital 

consumer photography 
with the QuickTake. 
It could store eight 

photos at a resolution 
of 640x480 pixels.

 Apple is one of the 
most profitable firms in 
history, and in 2011 its 

reserves exceeded even 
those of the USA. That 
year Apple’s balance 

was $76.4bn, compared 
to $73.7bn for the US.

0.3MP

2011

$22

The only new feature in Magic Mouse 2 was an integrated 
battery, and its capabilities in OS X were unchanged.
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MacBook updated 
Now comes in Rose Gold

Use the Force 
Deep press for 
Magic Mouse

Apple’s baby MacBook gets a spec boost and a new colour option

Magic Mouse 3 could enable 
wider range of gestures



Apps & Games APPLE CORE

BILLY
FREE

 Magazines, utility 
bills, TV packages, 
internet bundles – 

we’ve all got subscriptions 
to manage, but doing that’s 
easier said than done. Billy 
attempts to ease the pain with 
a beautifully simple interface 
and notifications to let you 
know every time a bill is due. 
Why you need it: Makes the 
complicated super-simple.
What’s it best for: Getting on 
top of your regular outgoings.

CHAMELEON RUN 
£1.49

 An endless runner 
with a colourful 
twist, the aim of this 

furiously fast-paced game is 
to switch your character’s 
colour to match the platforms 
he runs, jumps and flies 
across. It’s a bit like Sonic 
the Hedgehog crossed with 
a Dulux paint factory. 
Why you need it: It’s pure, 
colour-coded adrenaline.
What’s it best for: Speedy, 
challenging gameplay.

INTRODUCING KARL 
BLAU (KARL BLAU)

 Ignore this album’s 
title: Blau’s not new 
on the music scene, 

and that shows in his expert 
delivery of Nashville hits from 
the ’60s and ’70s, wrapped 
in Tucker Martine’s velvety 
production. Start with the 
exquisite cover of Link Wray’s 
undervalued Fallin’ Rain. 
Why you need it: To soak up 
Blau’s sensitive vocal style.
What’s it best for: Songs that 
sound relevant but well worn.

 A runaway Kickstarter success, 
Hyper Light Drifter is a 16-bit–
styled adventure for the 21st 
century. Taking its cues from 

old-school Zelda games and Miyazaki films, 
it’s an RPG that combines classic mechanics 
with new ideas of its own.

Your character, the Drifter, has access to 
technology long-forgotten by the world he 
explores. Filled with deep, crumbling ruins 

[ M O V I E ]

THE GOOD 
DINOSAUR 
£13.99
 What if the dinosaurs 

never went extinct? 
Humans and sauropods 
make unlikely friends in 
this family adventure.

[ A P P ]

iHEARTRADIO 
FREE
 Tune in to your 

favourite stations, 
podcasts and live 
events, covering 20 
million songs from 
800,000 artists.

[ G A M E ]

TIC TAC TOE 
4 TWO
79p
 Noughts and crosses 

on a digital chalkboard 
is like reliving childhood, 
minus the dusty hands 
and screeching chalk.

to loot, ancient forests to explore and ghastly 
enemies around every corner, you must find 
your way through this world to find a cure to 
the illness your character carries. Tactical 
combat is encouraged, making it more than 
a simple hack ‘n’ slash action game and a 
challenging experience.

Inspired by the developer’s own battle 
with heart disease, Hyper Light Drifter has 
just been released on Mac.
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Hyper Light Drifter £14.99

APPLE 
TV
 Our top picks 

of what’s worth 
watching and 
playing this month

[ M A C  G A M E ]

[ i O S  A P P ] [ A P P L E  M U S I C ][ i O S  G A M E ]

Gaming traditions new and old meet in this pixel-art RPG

APP OF THE MONTH



Apple’s new headquarters in Cupertino won’t open 
until 2017, but a multi-year project this big means there 
are lots of figures floating around – and they’re big!

APPLE CORE Facts & Figures
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The Apple

Campus 2
IN NUMBERS The total cost of Apple Campus 2, 

up from under $3 billion in 2011.

NEXT ISSUE  You’ve learned about Apple’s future home. Next time, 
get the low-down on the Cupertino tech giant itself.

The grounds of Apple 
Campus 2 will be filled with 
as many as 8,000 trees, 
in a nod to Silicon Valley’s 
agricultural roots. Apricot 
orchards, jogging paths 
and walking trails will be 
incorporated into the site, 
and 80% of the campus 
will be green space.

8,000 
trees

billion

6

5

2
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The amount of space dedicated to research facilities and 
parking. All parking spaces will be underground, leaving 
the area unspoiled by cars and concrete.

2.8 million square feet The total size of Apple Campus 2 and its 
surrounding parkland. That’s about 64.3 acres.

7

1

3

The main building’s 
natural ventilation 
means it won’t need 
air conditioning for 
three quarters of the 
year. In fact, 100% 
of the site’s energy 
will come from 
renewable sources.

75%75%75%75%75%
        6 kilometres
Roughly the amount of glass used in the 
construction of Apple Campus 2, according to 
architect Peter Arbour. He added that “normally 
we talk in terms of square feet”.

The water used at Apple 
Campus 2 will be recycled, and 
require more than 13,000 feet of 
pipeline to transport it from Cupertino. 
The water project will cost Apple 
$4.8m – pocket money to Tim Cook.

4





Every job I’ve had since the age of 18 has revolved around 
a machine that chimed when you started it up, and yet if I had 
to pick one moment that marked the transition from BC (before 
computers) to AD (Apple-driven), it didn’t involve anything 
with a half-eaten fruit on the front. 

In the early days, you see, Macs were far too expensive 
for the likes of me. Later, I’d meet people whose careers had 
turned on the day in 1984 when their Macintosh arrived; but 
they’d been 10 or 20 years older than me, with money in the 
bank. The nearest I could get, as a school leaver in the late ’80s, 
was an Atari 520ST.

This beige box with a keyboard on top didn’t look much 
different to the Commodore 64 I was upgrading from, but 
when I plugged it into my portable TV and switched it on, 
something new appeared. A little arrow, just sitting there in 
the middle of nowhere.

When I nudged the mouse and the arrow moved – not one 
character space up, down, left or right, but in a smooth line just 
as far and as fast as my hand – I knew this was a new world.

The same person, Jack 
Tramiel, ran the companies 
behind the Commodore 64 
and the Atari ST. More of an 
Alan Sugar than a Steve Jobs, 
Tramiel was a competitor, not 
an innovator: having jumped 
early into digital calculators 
and then microcomputers, he 

followed Apple into WIMP (windows, icons, menus, pointer). 
The ST ran a version of the GEM (Graphical Environment 
Manager) interface, a knock-off of the Mac’s System software, 
which meant amateurs like me could run programs such as 
Timeworks Publisher.

  Forty years after its founding, 
Apple is a byword for the best 
tech you can get. Celebrating 
the quality of its products is 
almost missing the point 

ADAM BANKS…

APPLE CORE Opinion

 macformat.com  @macformat14 | MACFORMAT | JUNE 2016

ABOUT ADAM BANKS
 Adam is Apple to the core, having 

reported on the world of Macs since the 
1990s. As a writer, designer, art director 
and print production contractor, he 
divides his time between the Northern 
Powerhouse and the Creative Cloud.

When I look back, 
I realise it wasn’t 
Apple’s products 
that changed my life

GOING DEEPER THAN  
A FORCE CLICK WITH  
MUSINGS ON THE  
WORLD OF APPLE

Almost anything the pros could do, 
I could do on my ST… after I’d designed my 
own typefaces (Timeworks only came with 
two), and bitmapped them by hand at all the 
sizes I needed, and provided that I didn’t 
mind recreating each issue of my fortnightly 
zine from scratch after the software crashed 
with an ‘Out of memory’ error two-thirds of 
the way through, every single time.

It was soul-destroying, but it worked, and 
it got me a job in publishing, where they gave 
me a Macintosh IIcx running QuarkXPress, 
and I never looked back. For this 300th issue 
of MacFormat, though, they asked me to look 
back. When I do, I realise it wasn’t Apple’s 
products that changed my life.

The pizza-box LC 475, the first Mac I ever 
owned; the big plastic G4 tower that I bought 
when I went freelance; the iMac G5, the 
aluminium 20-inch and then the 27; the 
iPhone 3GS (still the best in your hand), and 
the original iPad with its muscular curved 
back and science-fiction slimness – these 
will always stay with me, of course, but they 
weren’t essential.

Just as I got by with my ST, some people 
manage with Windows. Other smartphones 
are available. Microsoft makes tablets. None 
of these, however, would have existed without 
Infinite Loop. Apple didn’t just design better 
computers: it invented better ways of thinking 
about computers. And after 40 years, money 
can’t buy the most beautiful things it’s made.



APPLE
IN QUOTES

Split View APPLE CORE

 The MacFormat team debates the hot Apple  
issues of the day, using their iPhones of course!

“WHAT DO YOU THINK OF 
THE NEW MACBOOK?”

NEXT ISSUE  What do the next MacBook Pros need to do?

SPLIT VIEW

Alex says…

Christian says…

“Hey Siri turn off the lights”

Hmm, I don’t see anything connected. 
But if you set something up, I think I’d 
enjoy the company.

Siri...ously? tap to edit

LISA JACKSON
apple.com

“We’re constantly 
striving to find or 
invent solutions 

to important 
environmental 

challenges.”
Apple’s environmental 
head comments on the 

firm’s green efforts

STEVE WOZNIAK
woz.org

“It’s an expense 
that brought me a 

few extra niceties.”
Woz reckons the Watch’s 

reliance on an iPhone 
limits its usefulness

RON WYDEN
wyden.senate.gov

“This anti-
encryption bill 

would effectively 
outlaw tech 

that Americans 
use to protect 
themselves.”

Senator wants a bill that 
would force the likes of 

Apple to decrypt devices

PRINCE
artofficialage.com

“Tell me a 
musician who’s 

got rich off digital 
sales. Apple’s 

doing pretty good 
though, right?”

Prince sadly passed away 
as this issue went to press

Any specs upgrade is welcome, but the 
changes weren’t earth-shattering.

True, and the graphics upgrade was the part that 
really caught my eye. It’s definitely the most notable 
change – apart from the new Rose Gold colour!

Speaking of keys, that might be my main issue with 
the MacBook, upgrade or not. I just can’t get used to 
how little they travel.

You’ll really stand out on holiday       with a Rose Gold 
MacBook! Will there be gold/rose MacBook Pros too?

Rose isn’t for me, but I secretly loved the Gold 
from last year – looks great with black keys… 
better than the gold iOS devices, I think!

Last year’s was under-specced, so this feels like an 
appropriate upgrade,       especially its graphics.
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Fair point. Still, it’s ideal for actual travel though.

Possibly! I love the idea of this tiny Mac, but can it 
meet my needs? We’ll have to wait until next issue…

Turn to page 26
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EDITED BY CLIFF JOSEPH 

ost of the products that we look at in Apple Home 
are designed to make you more comfortable when 
you’re relaxing inside your home. However, Britain is a 
nation of gardeners and allotment owners, and many of 

us enjoy spending time outside getting our hands dirty in the garden. 
Of course, at this time of year there are all those gardening chores 
that we’ve put off over the cold winter months that you really need 
to catch up with. Fortunately, there are plenty of high-tech options 
available for your garden too, from labour-saving robotic lawnmowers 
and sprinkler systems, to sensors that can monitor your plants and 
send you a message when they need 
a bit of TLC. So it’s time to 
get your gardening gloves 
on and see how some 
high-tech horticulture 
can make your 
garden grow.

They say that the grass is 
always greener on the other  
side of the fence, but high-tech 
garden gear will make your 
neighbours go green with envy

M

The smart home is 
here – live the Apple 

dream today!

LIVE 
SMARTER

JUNE 2016 | MACFORMAT | 17

Bosch quotes the battery life 
of each of its three Indego 
lawnmowers at 50 minutes.
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It’s taken a while this year but 
it seems that spring is finally in 
the air, and many of us will now 
be looking out the window and 

thinking that it really is time to get to grips 
with the gardening again.

The garden is an oasis of peace and quiet 
for many people, a place where you can 
simply relax, or an absorbing hobby for 
people who enjoy cultivating their favourite 
plants and vegetables. However, it can also 
be hard work, whether mowing and watering 
the lawn, eliminating weeds, or keeping an 
eye on plants that need just the right 
conditions to flourish. Fortunately, there’s a 
wide variety of smart products now available 
that can help out with many of these tasks 
and ensure that your garden looks its best 
all year round.

The lawn ranger 
One of the most tedious and time-consuming 
chores for any gardener is mowing the lawn. 
It’s not surprising that there are quite a few 

companies that now sell robotic lawnmowers 
that promise to do all the hard work for you. 
None of them is cheap, unfortunately, but 
they’ll earn their keep if they save you time 
year after year – and perhaps prevent you 
from putting your back out as well. Bosch is 
perhaps the most well-known name in this 
area, thanks to the popularity of its washing 
machines and other household appliances, 
and its Indego robotic mowers are a good 
choice for most smaller lawns and gardens. 

Prices start at around £900 for a basic 
Indego, which uses sensors to map your lawn 
and detect obstacles – such as a pond – that 
it needs to work around. If you want to go 
the whole hog and use an app to control your 
mower, you’ll need to pay about £1,300 for 
the Indego 1000 Connect, which provides 
remote control options, as well as the ability 
to set up a mowing schedule so that your 
mower can do its own thing completely 
automatically. Should you really want to be 
lord of the lawn, there’s the awe-inspiring 
Robomow range. These can be pretty 

T
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Get started 
with

What sort of 
mower do I need?

 Just like iPhones 
and iPads, robotic 

lawnmowers are 
limited primarily by 

their battery life, 
which determines how 
much grass-chomping 
they can manage on a 

full charge. You can 
generally get an idea 

of battery life by 
checking the mower’s 

model number. 
Bosch’s Indego 1000 

Connect mower is 
designed to handle 

gardens up to 1000m2 
in size, while the 

tank-like Robomow 
RS635 can cope with 
larger gardens up to 

3500m2 in size.

Spring is here, so here’s our guide to 
the smart garden kit that can help you 

tackle the lawn and other gardening chores
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expensive, with the top-of-the-range RS635 
model trimming more than £2,500 off your 
bank balance, but it’s built like a tank and 
includes features such as the ability to divide 

larger gardens into separate zones, and a 
superpowered TurboMow option for that 
tricky ‘first cut of the year’.

Waterworks
Watering is another tedious gardening chore 
and, of course, many people already have 
simple sprinkler systems to help with this. 
Over in the US, where temperature and 
climate are more extreme, there are several 
smart watering systems, such as the popular 

Blossom Smart Watering Controller ($199 – 
about £141) that provides precise control over 
multiple watering zones within your garden. 
You can order the Blossom from the US via 
Amazon, albeit at a bit of a premium, but a 
prominent home-grown choice here in the UK 
is the Hozelock Cloud Controller. Priced at 
around £115, this can be used to add some 
smart tech to your existing sprinkler or 

Are robotic 
lawnmowers safe?
 All robotic mowers 

include sensors that 
help them avoid 
obstacles, and they’ll 
cut out automatically 
if anything lifts the 
cutting blades up off 
the ground for some 
reason. Even so, it’s 
still wise to keep an eye 
on the mower when it’s 
in action, and not let it 
run unattended unless 
you’re sure your family 
and pets are all well 
out of harm’s way.

Explained
Garden jargon
 Agro-hacking takes 

existing tech gadgets 
and finds ways to 
use them in the 
garden. Want to 
know how to ‘see’ 
photosynthesis with 
a digital camera? 
Just check it out on 
farmhack.org.

A £900 basic smart 
mower uses sensors to 
map your lawn and work 
around obstacles

Setting up a smart watering system is as simple as adding 
to your existing tap and setting up a schedule.

Robot lawnmowers have 
sensors to avoid obstacles, 
and, for safety, the blades 
will stop if anything raises 

them off the ground.



iFacts…
99%
 The percentage of 

semi-detached homes 
with gardens in the UK.

163m2

 The size of the 
average UK garden.

77%
 British citizens who 

are active gardeners, 
according to a survey 
conducted by the Royal 
Horticultural Society.

330,000
 The number of 

allotments in the UK – 
and there are 100,000 
people on the waiting 
list for one.

Plants aren’t the only things that grow in 
gardens, of course. You can even get smart 
sensors for your pond, such as Seneye’s range 
of water monitors, which come in tank and 
pond versions for indoor and outdoor use, 
respectively. These monitor temperature, 
PH levels for acidity and alkalinity, and 
ammonia levels, and can send warnings 
to their iPhone app if they detect anything 
that might harm your fish or other pond life.

How do I get Wi-Fi 
in my garden?

  Many garden gadgets 
require Wi-Fi to connect 

to an app on your 
iPhone. If your router 
isn’t too far away, you 

might be able to get 
a decent signal in the 

garden without too 
much trouble. If not, 
you can buy a range 
extender – a kind of 

mini-router that plugs 
into a nearby power 

socket and gives your 
Wi-Fi network a boost 

so it can reach out 
into your garden

 
 
 
 
 
 
 
 
 

How can I keep 
my garden safe?

  We’ve looked at 
several security 

webcams recently that 
are designed for indoor 
use. Several companies 
make weather-resistant 

webcams that are 
suitable for use in the 

garden, with additional 
features such as night 

vision and sound 
detection. While 

these are useful for 
home security, many 

people also use them to 
watch wildlife that may 

pass through their 
garden at night.

Koubachi’s plant sensor 
is less discreet than 

rivals, adding a clear 
technological presence 

to your plant pots.

So that it doesn’t spoil the look of your garden, Parrot’s 
Flower Power sensor is designed to blend in with plants.

watering system. 
The Cloud Controller 
connects directly to 
the tap in your garden 
and can control the 
flow of water to most 
conventional sprinkler systems. It can be 
controlled by an iPhone app that allows you 
to set up automatic watering schedules, 
and can even check the latest weather 
reports online to see if it needs to make 
any adjustments.

Plant life
If you really want to take a close interest 
in the wellbeing of your plants, you could 
also invest in a plant sensor. One of the 
best-known models is the Flower Power 
sensor from Parrot, the company behind 
those headline-grabbing minidrones. 
Flower Power is a cheap and cheerful 
option, costing about £40 and consisting 
of a little plastic widget that’s designed to 
look a bit like a twig. You stick the sensor 
into the soil and it then uses Bluetooth to 
report back to your iPhone app with info on 
temperature, moisture and fertiliser levels. 

Also popular is the Koubachi range of 
Wi-Fi Plant Sensors (between £90 and 
£170), which include features such as 
infrared sensors and thermometers for 
both soil and air temperature. However, 
Koubachi was recently taken over by the 
German company Gardena, and has 
announced that it will end support for its 
existing products by the end of 2018. 
There are other sensors available, such as 
PlantLink from Oso Technologies, although 
these aren’t widely available in the UK, so 
you’d need to order them from abroad.

A pond sensor can 
warn via your iPhone 
if it detects conditions 
that are harmful to life
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FIVE OF THE BEST

Bosch Indego 
1000 Connect 
£1,300
bosch-garden.com
 The Indego range is a 

good choice if you have a 

smaller lawns or garden. 

There are less expensive 

models in the range too, 

all with built-in sensors 

to navigate your garden, 

but only this one offers 

an app with remote 

control and scheduling.

Robowmow 
RS635 £2,700
robomow.com
The Robomow is a real 

beast, with a price tag to 

match, but it can cover 

lawns up to 3500m2 

on a single charge. 

Its TurboMow option 

can tackle the toughest 

lawns, and its app lets 

you divide your garden 

into zones, with separate 

schedules for each.

Hozelock Cloud 
Controller £115
hozelock.com
The Cloud Controller 

adds some smart tech to 

your existing watering 

system. It connects to 

your garden tap to 

control the flow of water, 

and Wi-Fi connectivity 

provides remote control 

from an iPhone, as well as 

scheduling and checking 

weather forecasts.

Seneye Pond 
Monitor £110
seneye.com
Seneye makes sensors 

for small fish tanks, large 

aquaria, and this floating 

pond monitor for outdoor 

use, which checks water 

temperature, acidity and 

ammonia levels. It can 

send notifications to your 

iPhone if conditions in 

your pond seem likely to 

harm your fish.

Parrot Flower 
Power £40
parrot.com/uk
The Flower Power is one 

of the less costly plant 

sensors, and it uses 

Bluetooth for wireless 

connectivity, so you 

need to be on the spot 

with your iPhone to use 

it. However, it’s a quick 

and easy way to check 

water, temperature and 

fertiliser levels.

The robot revolution is upon us, so 
you can save your energy for other 
tasks while a mechanical slave does 
your gardening graft.



 HOW TO Manage your plants 
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1 Tap to plant
It’s easy to organise and cultivate plants 

with a device like Koubachi’s plant sensor. 
Its app starts with a garden plan with a strictly 
rectangular layout on the screen, but the main 
thing is to identify your plants. Tap to add one.

2 The name of the rose
If you know which plants you’ll be growing, 

you can use the app’s search tool to quickly 
look them up. There are photos of thousands 
of plants, with info such as the Latin name and 
the moisture and fertiliser levels each needs.

Genius Tip!
 The Koubachi app is 

free to download, so you 
can use its database to 

identify thousands of 
plants, and find out 

about the soil conditions 
they need, even if you 

don’t own one of the 
Koubachi plant sensors.

1

2

If you really want to  
take a close interest in  
the wellbeing of your plants,  
invest in a plant sensor

Explained
Garden jargon
 A weed is sometimes 

described as a plant in 
the wrong place, so a 
weed could just be any 
plant that you don’t want 
in your garden. However, 
many weed-like plants, 
such as brambles and 
dandelions, have adapted 
to damaged soil conditions 
so that they can thrive in 
areas where other plants 
might struggle.

1

FLOWER POWER
 Parrot’s Flower Power sensor 

can be used in gardens or 
indoor pot plants to monitor 

fertiliser and water levels. 
However, it only uses 

short-range Bluetooth to 
communicate with your iPhone.

2

GREEN FINGERS
 The Flower Power app can 
use your iPhone’s internet 

connection to look up 
information about different 

types of plant, so you can check 
what conditions are best for 

your prize petunias.
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 WHAT ELSE SHOULD I CONSIDER?

Smart gardens APPLE HOME

3 Leaf it to me
The Koubachi app can also help if you 

come across a plant you don’t recognise. It will 
ask a series of questions about leaf shape, the 
stalk, and other details, and then suggest the 
type of plant it thinks you have.

4Early warning
Once you’ve identified all your plants, the 

sensor will know what conditions it needs to 
look out for. You can then set up the app to 
notify you over Wi-Fi of any major changes to 
water, light, temperature and fertiliser levels.

Jargon Buster
 NPK refers to the 

nitrogen, phosphorous 
and potassium found 
in garden fertilisers. 
Different fertilisers 
contain different levels 
of each substance, 
indicated by numbers 
such as 10-20-10 on the 
label. Plant sensors can 
monitor fertiliser levels 
and warn you if a plant 
needs a bit of a top-up.

he whole point of doing 
all that work in the 
garden is so that you 
can kick back, grab 

a drink and relax in your personal 
little paradise. There are some nice 
gadgets that can help out here too. 
A set of Bluetooth speakers will 
always come in handy.

There are also smart lighting 
systems designed specifically for 
the garden. Osram’s app-controlled 
Lightify range works well, and 
includes special mini-spotlights (£70, 
plus a £30 adaptor for your router) 
that have a spiked base so you can 
stick them in the ground around 
the edge of a flower bed or a pond. 
Philips’ Hue range isn’t quite so 
garden-friendly, but it does include 

T

When all the hard work’s done, it’s time to 
kick back, relax and enjoy your smart garden

FINAL TOUCHES 
FOR A RELAXING 
GARDEN SPACE

portable options such as the Hue Go 
lamp (£80), which has a rechargeable 
battery, so you can use it outdoors 
occasionally. Philips supports Apple’s 
HomeKit, so you can impress your 
neighbours by using voice commands 
to control your lights, though this 
requires the latest Hue Bridge (£50).

Philips’ Hue Go includes a mains adaptor, but it 
also has an integrated battery for portable use.
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HOME GADGETS 

Smanos W100 
Wi-Fi/Phone 
Alarm £160
smanos.com

Amsterdam-based Smanos has 
specialised in security systems 
for 16 years, but it has only 
recently brought some of its 

latest smart tech to the UK. It has several 
new products lined up for this summer, and 
we like the look of its existing W100 system. 
This home security system includes a sensor 
that can be attached to a door or window in 
order to warn you when they’ve been opened, 
along with a separate motion sensor that can 
scan a room for movement when you’re away 
from home or sleeping.

Both sensors are controlled by this very 
1960s-style space-pod device, which also 
houses a powerful 110dB siren that’ll probably 
scare any intruders to death, as well as 
waking your neighbours. The W100 has a 
touch-sensitive control panel that lets you 
create a PIN to control the alarm system, and 
you can connect it to your home Wi-Fi so that 
it can send alarms to the Smanos app on your 
iPhone. You can link six different iPhones (or 
Android phones) to it, so that each member 

1

 WHAT YOU NEED NEXT…

Indoors or outdoors, here’s the tech you  
need to create your new smart home

of your family 
has the ability 
to control the 
alarm as they 
come and go during 
the day. The kit also 
includes two handheld remote 
controls that you can use at home 
to quickly turn the alarm on or off without 
having to use your phone. You can buy 
additional sensors for other rooms as well, 
and the W100 can also link up with other 
Smanos devices, such as the new security 
cameras and video doorbells that the 
company will be launching soon.

Make it even smarter
There are other security systems that offer 
similar features, but the W100 has one other 
trick up its sleeve as well. To provide an 
extra security backup, you can also 
connect the device to your telephone 
landline, which enables it to make a 
voice call to your phone if you’re ever 
in a location where you don’t have 
internet access, or if there’s a power cut 
at home that puts your Wi-Fi network 
out of action. It can play a recorded 
message over the phone to tell you what’s 
going on, and it even allows you to listen to 
what’s going on at home so that you can 
make a decision over whether to turn off 
the alarm or call the police.

The W100’s powerful 
110dB siren will probably 
scare intruders to death, 
and wake the neighbours

For even  
more smart 
home advice 

subscribe 
today!
See page 26

You can control the alarm system 
from the LED screen or an iOS app.

The W100 talks to its sensors over 
either the 868MHz or 915MHz 
frequencies to avoid interference 
with more commonly used ones.
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Pure Highway 400 

£130

Philips AmbiLux 65PUS8901 £3,999

pure.com

philips.co.uk

Smart  
ideas

Philips has really gone 
over the top with its latest 
AmbiLux TV. This 65-inch 
monster not only sports a 

high-resolution 4K display, it also includes 
nine small projectors on the back of the TV 
that cast colours onto the wall behind it, 
creating a kind of ambient light show that 
matches the image on screen. The TV itself 
is driven by Android, though you can also 
connect an Apple TV to watch Netflix and 
download apps. There’s also an AmbiLux 
app for iOS devices that can link the TV to 
Philips’ Hue light bulbs so they match the 
colours of the TV’s light show.

 It looks like Siri could 
have some competition 
coming, in the form of 
Amazon’s Alexa. Like 
Siri, Alexa is a personal 
assistant technology 
that can be controlled 
with voice commands. 
At the moment, it’s only 
built into Amazon’s new 
Echo speakers, which 
aren’t on sale in the UK, 
but there’s an iPhone 
app (in the US) that lets 
you connect Alexa to 
the internet so it can 
look up information and 
answer questions, just 
like Siri. In some ways, 
Alexa goes even further 
than Siri, as third-party 
developers can add 
‘skills’ to it, enabling it 
to link up with other 
apps and perform tasks 
such as ordering a 
pizza or booking a cab.

Alexa can work with 
other smart gadgets, 
which is something 
Apple’s HomeKit is still 
struggling with. Alexa 
isn’t perfect – one user 
in the US reported it 
reset his thermostat 
after hearing its name 
on TV – but it’s another 
sign Apple needs to get 
HomeKit working with a 
wider range of gadgets 
to maintain its lead in 
home automation.

Seek Compact 

£229
thermal.com

We’ve looked at a number of 
smart thermostats that can help 
keep your heating bills under 
control, but if you really want 

to know how efficient – or inefficient – your 
heating and insulation is, hunt down the Seek 
Thermal Compact. This thermal imaging 
camera has a Lightning connector to connect 
it to your iPhone, and its infrared sensor can 
detect heat loss through doors and window 
frames, as well as variations in temperature 
caused by electrical problems, water leaks or 
damaged insulation in cavity walls. It can also 
take fun thermal pics of your pets.

Pure has been a real champion 
of DAB – digital radio – in the 
UK, and has already released a 
couple of its Highway adaptors 

that let you receive DAB in your car, as well 
as plugging in your iPhone to listen to your 
music library. Its new Highway 400 adaptor 
adds Bluetooth for wireless streaming, and 
also works with Siri. So, you can tell it to 
check the weather or news reports without 
taking your hands off the steering wheel. 
Prices start at £130 for the Highway 400 
shown here, but there’s also a Highway 600 
model priced at £150 that has a built-in 
microphone for hands-free voice calls as well.

3

Secure your home the smart way with 
cameras, sensors, locks and more!NEXT ISSUE  

2

4
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1 Mission Control
In El Capitan, Apple has switched 
Mission Control’s presentation to 
spread out all of your windows 
instead of stacking them up. If you 
have many windows open in the same 
workspace, their previews in Mission 
Control can get pretty small. To take 
a closer look at one, put the pointer 
over it and then press the Spacebar 
to pull it forward of the others.

3 Return to owner
Even if you have no need for any other 
iCloud services, it’s worth setting up an 
account just to use Find My Mac, which 
lets you track your Mac when it’s online 
using Wi-Fi, and play a sound, lock or 
erase the Mac when online over Wi-Fi 
or Ethernet. Also consider putting your 
contact details on the login window in 
System Preferences > Security & 
Privacy > General > Set Lock Message.

2 A hidden gesture
If your Mac has a trackpad, there’s an 
extra gesture for it tucked away in the 
Accessibility preferences pane, under 
Mouse & Trackpad > Trackpad Options. 
Put a check mark next to ‘Enable 
dragging’ and select three-finger drag 
from the adjacent pop-up menu. This 
gesture may feel more comfortable for 
you than clicking and dragging things 
due to its relative lack of friction.

4 Keyboard shortcuts
If a menu item you use often doesn’t list 
a keyboard shortcut, you can assign it 
one in System Preferences > Keyboard > 
Shortcuts > App Shortcuts. Click the + 
button, select the app in which the item 
appears, then enter the item’s name 
exactly as it appears, right down to 
capitalisation and any ellipsis at its end. 
Click in the bottom box, then press the 
key combo you want to trigger the item.

Words: Craig Grannell, Christian Hall, Howard Oakley, 
Christopher Phin, Alan Stonebridge

Greatest ever Mac tips
Become an Apple Genius with our very best tips for OS X,  

iWork, iTunes, Spotlight, Finder, Safari, Mail and more…
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hen did you last 
consider whether 
the way you take 
on tasks is the 
most efficient use 
of your Mac, and if 

taking time to learn shortcuts 
and discover hidden features 
in tools you use daily could 
save you time? Every issue of 
MacFormat helps you with these 
things, naturally, but in honour 
of our 300th anniversary we’ve 
put together hundreds of tips for 
you to truly master your Mac.

Whether you need help with 
Finder, Safari, working with text, 
or some other facet of your Mac, 
you’ll find plenty of tips and 
tricks here to turn you into a 
power user. We’ve also included 
a few indispensable third-party 
tools that, for a few pounds, 
further streamline your system.

All of the tips here have been 
written with the latest Mac OS, 
El Capitan, in mind. However, 
you’ll find that many of them 
work with older versions too.



11 Reset user password
If you can’t get past the login window 
because you’ve forgotten your account 
password, you can reset it by starting 
up in OS X Recovery by holding ç+r 
when you hear the startup sound. 
Choose Utilities > Terminal, then enter 
resetpassword, select the account to 
reset and provide a new password. 
(Note that this won’t change FileVault’s 
password If you’ve encrypted your disk.)

6 Check the Clipboard
Although Finder is primarily a way to 
manage files, its Edit menu has a Show 
Clipboard command that’s capable of 
displaying other kinds of content you’ve 
copied there, such as images. However, 
OS X’s Clipboard is fairly basic in its 
functionality, and its contents are easily 
overwritten and lost before you’ve used 
them. If you find this a problem, try out 
Paste (£4.99, Mac App Store), which 
offers a searchable Clipboard history 
and many more great enhancements.

7 Switch audio devices
Your Mac remembers volume levels for 
speakers and headphones individually, 
and makes adjustments as you connect 
or disconnect them. However, you may 
not want to unplug your headphones 
just to demo something to another 
person. Rather than opening the Sound 
preferences pane, hold å and click the 
volume icon in the menu bar to switch 
to a different input or output device. 
If that icon isn’t present, turn on ‘Show 
volume in menu bar’ at the bottom of 
the Sound preferences pane.

8 Eject a stuck disc
If your Mac has an optical drive and you 
can’t get Finder to eject a disc from it, 
there are a couple of workarounds. 
With a USB-connected optical drive, 
disconnect and then reconnect it, which 
should reset the connection and allow 
Finder to eject the disc. Otherwise, 
restart your Mac and hold ≠, ™ or the 
mouse or trackpad button when you 
hear the startup sound to eject the disc.

9 Your contact details
Contacts lets you choose to include just 
some of your card’s details to share 
with people. In its vCard preferences, 
place a check mark next to ‘Enable 
private me card’. In the main window, 
press ß+ç+M to go to your card, 
then click Edit. On the right is a column 
headed ‘Share’ and a checkbox next to 
each item that determines whether it’s 
included when you share your card.

5 Keyboard navigation
If you’ve come to the Mac after years 
with another operating system, you 
may find it frustrating that pressing Tab  
doesn’t cycle through every control or 
field in forms, and it can be aggravating 
if you like to jump between toolbar 
items. In System Preferences’ Keyboard 
pane, click Shortcuts, then switch Full 
Keyboard Access from ‘Text boxes and 
lists only’ to ‘All controls’. Depending on 
how many forms you fill out, there may 
be times when the default is preferable. 
You can toggle between these settings 
without coming here by pressing ≈+&; 
if the top row of keys is set to control 
special functions, press ƒ+≈+&.

12 Power shortcuts
There are no keyboard shortcuts listed 
for Sleep, Restart and Shut Down in 
the  menu, though they exist. To put 
displays to sleep, perhaps because 
you’ll be away for a few minutes, press 
ß+≈+≠ . Press ç+≈+≠ to restart, 
or press ç+å+≈+≠ to shut down; 
in both cases, you’ll be asked whether 
to save changes to documents. In the 
first and last shortcuts above, if your 
keyboard has no Media Eject key but 
has a power one, press that in its place.

13 Bypass Gatekeeper 
When Gatekeeper is enabled, it’ll refuse 
to allow apps from unknown developers 
to run in case they contain malware. 
However, if you’re certain you want an 
app to run, because you trust its source, 
≈-click it in Finder and choose Open. 
When you’re presented with a security 
warning, confirm you want to open the 
app anyway. This exempts the app from 
Gatekeeper’s usual restrictions, and in 
future it can be opened in a normal way.

10 Live encrypt a drive
You can make a Mac-formatted portable 
drive’s contents more secure to carry 
around. There’s a catch, though: if the 
drive’s partition map scheme is set to 
MBR, which is common with drives in 
their factory state, you’ll need to erase 
the whole thing to an encrypted format 
in Disk Utility. Either way, it’s wise to 
make a copy of the drive’s contents 
in case something goes wrong. After 
doing so, ≈-click the drive in Finder, 
choose the Encrypt option, then set a 
password and a reminder. Progress is 
shown when you ≈-click the drive. 
During this process, you can eject the 
drive; it continues when reconnected.

14 Search the menus
If you can’t find a menu item, because 
you don’t recall its exact name or just 
its location, press ç+ß+[?] to open 
the Help menu, then type part of its 
name – it needn’t be from the start of 
the item’s name. Matching items will be 
listed in the Help menu; put the pointer 
over one and the corresponding menu 
opens with the item highlighted. 
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App and window management

26 Stacks can show folder or file icons, which Image2Icon (img2icnsapp.com) can customise.

Take control of your workspace with desktop, Dock and Mission Control tips
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15 Enlarge a window’s dimensions 
The green button at the top-left of 
windows can confuse if you’ve come 
from Windows, because it switches to 
full-screen mode. Hold å and click it 
to enlarge its window; in some apps, 
this resizes a window to a ‘best fit’ for 
its content, in which case hold å and 
drag from a corner to fill the desktop. 
16 Use all available screen space 
Consider hiding the Dock and the 
menu bar so that windows can use 
more space. Do this in the General and 
Dock preference panes, respectively.
17 Adjust the Dock’s size
You can tweak the Dock’s height by 
dragging the dividing line near its 
right end, and magnify what’s under 
the pointer by ≈-clicking the divider 
and choosing Turn Magnification On.  
18 Minimise into app icons
As you add many icons to the Dock, 

the shorter its height becomes. This is 
apparent if you minimise windows to 
manage your workspace, which puts 
them in the Dock’s right end. A setting 
in the Dock’s preferences helps to 
avoid this by minimising windows into 
their app icon instead.
19 Stacks Make any folder you need 
to access regularly available as a stack 
in the right part of the Dock: drag it 
there from Finder. Hold ≈ and click 
a stack to set how it’s presented (as a 
fan, grid or list of icons) and how its 
contents are sorted.
20 Icon size in grid-based stacks 
When you open a stack that you’ve set 
to Grid view, use ç++ and ç+- to 
adjust the size of icons in it. 
21 Open a recent item’s container 
OS X keeps track of recently used 
apps, documents and servers for you 
in  > Recent Items. Hold ç and the 

document links in that menu change 
to open their location in Finder.
22 Recent items in a stack Perhaps 
you’d rather access recent documents 
through a stack. Enter this in Terminal: 
defaults write com.apple.dock 
persistent-others -array-add  
'{ "tile-data" = { "list-type" = 1; }; 
"tile-type" = "recents-tile"; }'; 
killall Dock. Hold ≈ and click the 
stack to pick between showing apps, 
docs and servers; enter the command 
again if you want more than one.
23 Get your bearings The spaces 
and full-screen apps in the top bar of 
Mission Control rearrange based on 
which you’ve used most recently. 
If you find this disorienting, turn off 
the corresponding option at the top of 
System Preferences > Mission Control. 
Items in the top bar then stay in the 
positions you drag them to.
24 Quicker access to the menu bar 
On large displays in particular, moving 
the pointer to the menu bar can be 
wearing. In addition, if you’ve set the 
menu bar to hide itself when you don’t 
need it, the delay before it slides into 
view can be annoying as well. Check 
out PopClip (£4.99, Mac App Store), 
which enables you to hold a key and 
then click to access a replica of the 
menu bar’s contents as a contextual 
menu at the pointer’s position.
25 Keyboard menu access You can 
keep your hands on the keyboard to 
use the menu bar. Press ≈+& (and 
ƒ on some keyboards), then use the 
arrows and ® to browse and choose.

 macformat.com  @macformat

30 Group Dock icons
You can group apps in the Dock by  
inserting blank tiles. In Terminal, type: 
defaults write com.apple.dock 
persistent-apps -array-add ‘{tile-
data={}; tile-type=”spacer-tile”;} and 
press ®, type killall Dock and press 
® again. When the Dock reappears, 
drag the space from the right of its app 
icons to where you want it. To remove it, 
drag it out of the Dock, like with an app.

29 Pin the Dock
if you have multiple displays and have 
the Dock set to be hidden, you can call 
it up on any display. The app switcher 
appears on whichever display the Dock 
last appeared. If you have the Dock set 
to be permanently visible, it always 
appears on your primary display, which 
you can set in the Displays pane: in the 
Arrangement tab, drag the menu bar 
on the previews to the desired display.

27 Resizing windows
Besides the ability to resize a window 
from any edge or corner, you can 
constrain the way they change by 
holding modifier keys. Hold å to grow 
the window in both the direction you 
drag and its opposite. Hold ß to resize 
while keeping the window’s proportion 
of width to height the same as before 
you started dragging. You can hold both 
keys together to apply both effects.

28 Mimic Microsoft
Former Windows users may lament the 
lack of something like its Snap feature 
in OS X, and even if you’ve used a Mac 
for years, you might like the extra 
shortcuts for window management that 
Magnet (79p, Mac App Store) gives you. 
It lets you drag a window to a desktop 
edge or corner to fill a corresponding 
region. You can also assign a keyboard 
shortcut to each region.

31 The app switcher
The quick way to switch between your 
two most recently used apps is to press 
ç+†. If you hold ç and press † 
once, the app switcher opens, showing 
additional apps; press † until the one 
you want is highlighted, then let go of 
ç to switch to it, or move the pointer 
over an app’s icon and let go of ç. With 
an app highlighted or under the pointer, 
ç+q will quit it, and ç+H  will hide it.

32 Focus on an app
If you find managing multiple spaces is 
overkill, there’s an older method for 
hiding apps you don’t need right now. 
Switch to one you want to use, then 
press å+ç+H to hide all others, or 
hold å and click that app’s Dock icon; 
the other windows still exist, but they’re 
invisible until their app is brought to the 
foreground. To hide an individual app, 
switch to it and press ç+H.



37 Assign to a space
With multiple spaces created, exit 
Mission Control, then hold ≈ and click 
an app’s Dock icon. Under Options, the 
three items under Assign To determine 
the space where that app appears: on 
all desktops; in whichever space you 
place it manually (None); or always in 
the space you’re currently viewing (This 
Desktop – there’ll be an instance of this 
for each display that’s connected).

35 HyperDock
If you find it hard to remember gestures 
and keyboard shortcuts, HyperDock 
(about £4, bahoom.com) puts window 
previews above the Dock when the 
pointer is over an app icon, including 
any that are minimised or in another 
space. It also has shortcuts for moving 
and resizing windows when you hold 
keys and move the pointer, or when you 
drag a window to a screen edge.

38 Web Clips
Many Dashboard widgets are better 
served by Notifcation Centre these 
days, but one remains invaluable as a 
way to keep watch on website updates. 
With Dashboard enabled, go to a site in 
Safari, choose File > Open in Dashboard, 
mark the region of the page you want to 
monitor, then click Add. In Dashboard, 
click the ‘i’ at the bottom-right corner of 
the Web Clip to customise how it looks.

41 Split View
If you find you can’t merge 
two full-screen–capable 
apps in a Split View space,  
their minimum widths can’t 
be squeezed into the 
current display resolution. 
If your Mac has a Retina 
display, try increasing the 
‘looks like’ resolution in its 
Displays preferences pane.

40 See a space
Swiping horizontally with two 
fingers on a Magic Mouse, or 
three on a trackpad, moves 
through your spaces one at a 
time. To save time, hold å and 
then click a space’s thumbnail in 
the top bar to jump to it without 
also exiting Mission Control.

39 Quickly open
Opening Mission Control 
manually makes sense to 
give your workspace a 
thorough spring-clean, but if 
you only need to move one 
window, you can do it more 
quickly by trying to drag it 
past the menu bar, which 
opens Mission Control, then 
drop it where you want it.
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33 App Exposé
Apple’s multi-touch trackpads and mice 
provide gestures to open Mission 
Control, so you can see all windows in 
the current space, but often you’ll want 
to focus on windows from one app. In 
the Trackpad preferences pane, turn on 
the App Exposé gesture. You can then 
swipe down with three fingers to see a 
Mission Control-like arrangement of 
only the current app’s windows.

36 Group by app
In El Capitan, Mission Control presents 
windows the way very old versions of 
OS X did, without any overlaps. When 
dragging windows around to organise a 
busy workspace, you may find it quicker 
to (temporarily) turn on ‘Group windows 
by application’ in Mission Control’s pane 
in System Preferences, then drag from 
the app icon at the bottom of a group to 
move all of that app’s windows at once.

34 More App Exposé
You won’t find an App Exposé gesture 
in the Mouse preferences pane, but 
there is a way to trigger it without 
reaching for its keyboard shortcut 
(which is ≈+æ). Put the pointer over 
an app icon in the Dock, then use the 
same gesture you’d use to open Mission 
Control – double-tapping two fingers on 
the highest point of the Magic Mouse’s 
surface avoids an accidental click.



Work smarter in Finder
42 Select multiple items or a range 
You can select a sequence of files in two 
ways: either drag through them, or click 
the first, hold ß, then click the last one 
to select them and all between – this is 
handy if the latter is initially out of sight 
and you need to scroll down. To select a 
scattering of files, hold ç and click each 
one you want to add to your selection.
43 Check a folder’s location Turning on 
the path bar (View > Show Path Bar) 
shows the current folder’s location across 
the bottom of its window. Double-click a 
folder in the bar to jump to it, ç-click to 
open it in a new window, or drag and drop 
items onto one to move them there.
44 Check location from a title bar Save 
space on a small display by ≈-clicking the 
folder name in a Finder window’s title bar 
as another way to jump to a higher folder.
45 Copy and paste or move files The 
title bar shortcut doesn’t allow for drag 
and drop, so it can help to memorise an 
extra keyboard shortcut. Naturally, ç+C 
and ç+v copy and paste items, but you 
can instead press å+ç+v to move files 
you’ve ‘copied’ to the Clipboard.
46 Spring open a folder When you drag 
items over a folder (or another tab or 
window in Finder), it springs open. If the 
delay in doing so is too long, press the 
Spacebar to instantly open the folder. The 
delay is adjustable in System Preferences 
> Accessibility > Mouse & Trackpad.
47 Quickly focus a Save dialog Saving 
a file for the first time means digging 
down to the folder where you want to put 
it. If that folder is already open in a Finder 
window, just drag the icon from that 

window’s title bar onto the Save dialog to 
switch the dialog to that location.
48 Set the default scope for searches 
When you type in the search bar, or press 
å+ç+[spacebar] to create a Smart 
Folder, the window’s options bar lists This 
Mac, the current folder (or Desktop), and 
Shared as search locations. In Finder’s 
Advanced preferences, you can tell it to 
default to either of the first two or your 
most recent choice in future.
49 Open in a new tab or window 
When you hold ç and double-click a 
folder, it opens in a new tab or window – 
which you get depends on a setting at the 
bottom of Finder’s General preferences.
50 Copy the path to an item When you 
need to point someone to an item on a 
network drive, you don’t need to type its 
path. Select a file or folder, then press 
å+ç+C to copy the full path to it to the 

Clipboard, switch to a messaging app, say, 
then press ç+v to paste the path. 
51 Type folder paths quickly Finder’s 
Go to Folder command (ß+ç+G) has a 
great productivity shortcut: type part of 
a folder name, then press † to complete 
it. If there are multiple matches, this fills 
in the first alphabetical one.
52 Check iCloud Drive’s progress 
If files saved to iCloud Drive aren’t soon 
available on another device, look for an 
indicator next to Drive in Finder’s sidebar, 
or press å+ç+I and choose View > 
Show Status Bar for precise details.
53 Navigate search suggestions
The suggestions shown when you type in 
the search bar are categorised. Rather 
than reach for your mouse or trackpad to 
choose an item lower down the list, use 
ç+æ to jump down a category at a time. 
This also works with Spotlight results.

54 Sidebar categories can be dragged to reorder them, or hidden by clearing checkboxes in Finder’s prefs.

Discover the many powerful productivity shortcuts in the Mac’s file manager
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56 Switching views
You may want to view one folder in 
a particular view and deeper ones in 
another – your Home folder in Icon view 
and Documents in List view, say. Go to 
the enclosing folder, set its view as you 
want it, press ç+J and put a check 
mark next to ‘Always open in’, but not 
‘Browse in’. Next, open a subfolder of 
that one, set its view as you want, press 
ç+J and clear both of those options.

59 Keyboard shortcuts
Finder’s sidebar contains shortcuts to 
various commonly used folders, but you 
may have removed some of them. Even 
then, each of the default selection still 
has a keyboard shortcut, listed in the 
Go menu, that you can use to jump to 
the corresponding place. These work in 
Open and Save dialogs, too. Should you 
accidentally close a folder you need, 
use the Go > Recent Folders command.

55 Set a default view
Finder can present the contents of your 
Mac’s storage in four ways – Icon, List, 
Column and Cover Flow views. Switch 
between them using ç+1 through to 
ç+4. Each view offers a degree of 
customisation: press ç+J to change 
how the current view displays the folder 
you’re in, now and in future. To apply 
your choices to all folders, press Use as 
Defaults at the bottom of that window.

58 Batch rename
Select more than one item in Finder and 
choose File > Rename <some number of> 
Items. The dialog that opens lets you 
add or replace text in the items’ names, 
or rename them to a format you specify. 
If this doesn’t offer enough flexibility, 
consider Better Rename 9 (£14.99, Mac 
App Store), which offers a preview of 
how file names will be affected before 
you apply changes.

57 Arrange and sort
The View > Arrange By menu contains 
options that group files and folders by 
attribute. So, you may want to organise 
files by the apps used to create them, 
for example. Open the View menu and 
hold down å and you’ll see that 
Arrange By changes to Sort By, which 
contains similar options. These allow for 
sorting on a secondary attribute within 
Arrange By’s visual groupings.

60 More shortcuts
Add a keyboard shortcut to any folder 
by creating a Service in Automator that 
takes ‘no input’ in ‘Finder’. Add the Run 
Shell Script action and set its contents 
to open, a space, then the folder’s path. 
Add a backslash (\) in front of every 
space in the path. Save the Service, 
then add an App Shortcut for Finder 
in Keyboard preferences > Shortcuts, 
using the service’s exact name.

 macformat.com  @macformat
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61 Adjust columns

63 Preview column

65 Cumulative total

62 Add attributes

64 Quick Look

66 Smart Folders

Organise using tags
In Column view, if a column is too 
narrow to show filenames in full, 
double-click the divider to its right to 
extend it to the required width. Hold 
å and double-click a divider to snap 
all columns to their required widths. 
Alternatively, hold å and drag one 
divider to set all columns to the same 
width. If these are hard to remember, 
hold ≈ and click a divider, then pick 
an option from the contextual menu.

Each view can have a column added to 
its right-hand side to preview whatever 
single file is selected. Choose View > 
Show Preview Column to switch it on 
for the current view. This can give you 
a clue to a file’s contents without even 
having to use Quick Look – you can 
even scroll through PDFs and some 
other file types. The column can be 
resized by dragging the line to its left, 
and by adjusting the window’s height.

Pressing ç+I opens one summary 
for each item that’s selected. Press 
≈+ç+I for a cumulative total. 
Press å+ç+I to open a similar 
window that summarises everything 
that’s selected, but the total here 
updates as your selection changes. 
To see size totals in List view, press 
ç+J and turn on ‘Calculate all sizes’; 
this info can take a while to appear, 
especially on a traditional hard drive.

In the List and Cover Flow views, hold 
ç and click a column heading to see 
a few extra columns you can add, or to 
turn off any unwanted ones. The Date 
Added and Modified attributes are 
helpful in folders such as Downloads, 
and for the All My Files view that’s 
automatically provided. Remember, 
you can click any column heading in 
these views to sort items based on it, 
in descending or ascending order.

Select one or more files, then press 
the Spacebar to open a Quick Look 
window, which you can resize. To go 
straight into a full-screen slideshow of 
the items, press å+[spacebar] . With 
a multiple selection, the button that 
shows four squares displays an index 
sheet, so you can jump straight to 
another item. If an image doesn’t fill 
the view, hold å to zoom in on it. 
Double-click a preview to open its file.

Smart Folders (File > New Smart 
Folder) find all files and folders that 
match your criteria. When specifying 
rules, hold å and click an ellipsis (…) 
button to the right to add a nested 
group of rules to match against more 
flexibly (‘Any’) or to exclude results 
(‘None’). To amend a saved Smart 
Folder, open it, click the cog in the 
toolbar and pick Show Search Criteria. 
Click Save to preserve your changes.

67 Add tags to a new file
When you first save a file, many apps offer 
a field where you can add tags. Should you 
neglect to add any, you don’t need to find 
the file in Finder to do so retrospectively. 
Just click the open document’s name in its 
title bar. You can quickly move the file here 
too, if you saved it to the wrong location.

68 Tag existing items
There are several ways to tag files and 
folders in Finder. First, you can ≈-click an 
item and choose from seven favourite tags 
near the bottom of the contextual menu. 
Those seven can be changed in Finder’s 
preferences: in the Tags tab, drag one from 
the top pane onto a position in the Favorite 
Tags box. In the top pane, click the circle to 
the left of a tag to assign it a colour. Put a 
check mark to the right of one to pin it to 
Finder’s sidebar. Click a tag to rename it 
(which propagates to files tagged with it), 
or select it and click the – (minus) button to 
delete it, which also removes it from files.

69 Favourite tags
You can drag items onto tags in the sidebar 
to assign them. Alternatively, choose Tags 
in the contextual menu or click the Edit 
Tags button in the toolbar, then type one’s 
name; matches appear as you type, so you 
may not have to type the whole thing. 
Select a match using the arrow keys and ®.

70 Search on a tag
Type a tag name in a Finder window’s search 
bar and the suggested results will include 
matches. Select one and the window will show 
items that carry that tag. More complex 
criteria based on tags can be constructed by 
choosing Other as the attribute for a Smart 
Folder criterion, then selecting Tags in the list 
of all available ones. 

71 Turn a tag into a stack
Tags are a helpful way to keep track of all 
the files associated with a project. Often 
you’ll just click a tag in Finder’s sidebar to 
see all the files that have it attached, but 
there’s another way that doesn’t depend on 
you having a Finder window to hand. Drag a 
tag from Finder’s sidebar to the right-hand 
side of the dividing line in the Dock to turn 
it into a stack, then ≈-click the stack to set 
its presentation and sort options.
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Turn the beat around with iTunes

72 The classic look
If you prefer iTunes’ look of a few years 
ago, with columns for selecting a genre, 
artist or album across the top of the 
window, you can get something close to 
it in iTunes 12. In the My Music view, set 
the option at the top-right corner to 
Songs, then choose View > Column 
Browser > Show Column Browser. 
Among the view options at the top right 
are artwork-related settings that make 
this layout look at least a little prettier.

75 Notifications
The app uses notifications to tell you 
when a new track starts playing, and 
what it is. However, you won’t find a way 
to turn this off when you select iTunes 
in System Preferences’ Notifications 
pane. Instead, go to iTunes’ own prefs, 
click General, and then amend the two 
settings next to Notifications there, 
which control whether you’re informed 
about track changes and whether 
they’re retained in Notification Centre.

78 Auto-import media
There’s an often overlooked feature of 
iTunes that makes it easier to manage a 
complete copy of your music library on 
one Mac if you don’t use iCloud Music 
Library. From the folder that stores your 
iTunes library on that main Mac, add the 
Automatically Add to iTunes folder 
under File Sharing in the Sharing 
preferences pane. Now you can drop 
iTunes-compatible files there over your 
network to add to your master library.

73 Go to current track
Whether you’re listening to your own 
music library on shuffle or one of Apple 
Music’s online radio stations, press 
ç+l to jump to the album from which 
the current track originates. If you’ve 
changed the view options (top right) 
since starting playback of your own 
music, you’ll remain in that view. With 
online radio, the New view becomes 
selected, but shows the album’s tracklist 
instead of its usual content.

76 Clean your library
A new setting in iTunes 12.3.3 avoids 
Apple Music tracks added to a playlist 
ending up in your library. So what about 
tracks added in the past? Though you 
can use a Smart Playlist to find them, 
then add them to a regular playlist, if 
you select them in the former and press 
å+∫, references to them are deleted 
from your library and playlists. To tidy 
up, you’ll need to add tracks to a playlist 
by searching Apple Music’s library again.

79 Hide Apple Music
Until iTunes 12.3.3, hiding Apple Music – 
the music suggestion pages and the 
Connect social side of things – would 
also disable iCloud Music Library, but 
not now. In iTunes’ General preferences, 
ensure iCloud Music Library is switched 
on, then switch to the Restrictions tab 
and put a check mark next to Connect 
and Apple Music to hide them. This 
leaves you with the My Music, Playlists 
and iTunes Store views.

74 Only local music
If you have an iTunes Match or an Apple 
Music subscription, you can hide the 
items in your iCloud Music Library that 
aren’t stored locally. Go to the My Music 
view, then pick View > Only Downloaded 
Music. This is especially helpful for 
determining what’s stored on a portable 
Mac before going offline for some time. 
A reminder that you’re not viewing your 
whole library appears across the top of 
the view, with a shortcut to switch back.

77 Stars and Loves
Since the introduction of Apple Music, 
iTunes favours a system of rating tracks 
as ‘loved’, yet star ratings (out of five) 
are still available – and still useful for 
making fine-grained Smart Playlists. 
In iTunes’ preferences, click General, 
then set the Ratings item to Stars, 
Loves or Stars & Loves. You may want 
to use both systems because loved 
tracks influence suggestions that 
appear in the For You page.

80 Enhance iTunes
Whether you want a quick way to tidy 
up the metadata attached to tracks, 
a fast way to resume whatever was 
playing before you last quit iTunes, 
or you want to back up an extensive 
collection of playlists and are battling 
against iTunes’ inability to export them 
more than one at a time, or some other 
failing of iTunes is getting in your way, 
you’ll probably find an AppleScript 
that’ll help at dougscripts.com.

Get more from your Mac’s music management app
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Master Safari

 macformat.com  @macformat

Top tips for getting more out of Apple’s web browser

81 Manage tabs
Although you can have 
loads of browser windows 
on the screen, it’s tidier to 
use Safari’s tabs. Pressing 
ç+t gives you a new one. 
You can drag tabs around 
to rearrange them or move 
them between windows. 
To merge a web page from 
a window that has only one 
tab with another window, 
you’ll need to make the tab 
bar visible (choose View > 
Show Tab Bar). Window > 
Merge All Windows gathers 
all tabs in a single window.

82 Favourites
If there are sites you visit 
constantly and always need 
quick access to, pin them to 
the tab bar. To get started, 
open a site in any window, 
then choose Window > Pin 
Tab. The site’s icon will slide 
to the left end of the tab bar 
and subsequently appear in 
every Safari window. There’s 
no escape! OK, there is: drag 
pinned tabs away from that 
end of the tab bar to unpin 
them. You can rearrange 
pinned tabs simply by 
dragging them left or right.

83 Suggestions
In Safari’s preferences, 
in the Search tab, turn on 
Include Safari Suggestions. 
Now Safari’s Smart Search 
Field (address bar) works 
rather like Spotlight in 
responding to certain search 
terms with more than just 
website suggestions. Type 
‘weather’ and you’ll get a 
local forecast. Enter a major 
sports team to get its latest 
result. Suggestions also 
include things you can buy 
on Apple’s online stores, and 
Wikipedia article synopses.

85 Full address
Presumably in an attempt to 
be minimal and tidy, Safari 
no longer by default displays 
a web page’s full address in 
the Smart Search Field. Click 
around apple.com, say, and 
the field’s contents will stay 
unchanged throughout your 
visit. If that’s unnerving or 
annoying, tick ‘Show full 
website address’ in Safari’s 
Advanced preferences. The 
field then shows addresses 
in full. (Even with this setting 
off, the full address is shown 
when you click in the field.)

86 Notifications
It’s not just apps that can 
bug you throughout the day. 
Now websites can also ask 
permission to fling alerts 
your way. It’s all too easy to 
accidentally allow this when 
a site first asks permission, 
so it’s worth periodically 
checking out Safari’s 
Notifications preferences. 
There, you can allow or deny 
an individual site’s ability to 
trigger notifications. If you 
never want any site to ask 
you, there’s a switch here 
that prevents them doing so.

84 Search sites
If Quick Website Search is 
enabled in Safari’s Search 
preferences, you can bypass 
a website’s homepage to 
search its contents. All you 
have to do is search on the 
site once. After that point, 
start typing the site’s 
address in the Smart Search 
Field, tap Tab when it’s the 
first suggestion, then type 
your search term. Press ® 
and you’ll automatically be 
sent to the site’s results 
page for your search terms – 
quite a time-saver!

91 Web inspection
Develop > Web Inspector lets you dive 
beneath the surface of any web page, 
exploring the code that makes it work. 
Although really for developers to debug 
sites, the Timeline tab’s interesting in 
a geeky way for discovering a site’s 
various components and how long they 
take to load, while Resources lets you 
extract images from a site. (Obviously, 
don’t reuse stuff without permission.)

93 Disable things
There’s a bunch of Disable options in 
the Develop menu. Generally speaking, 
we wouldn’t recommend messing with 
them, but if you’re struggling with a 
slow internet connection, temporarily 
disabling images can be useful. 
Disabling caches (temporary storage 
that helps pages load more rapidly) can 
help if you have a problem accessing a 
site. You can empty caches here, too.

92 Get responsive
The Develop menu’s Enter Responsive 
Design Mode command gives you the 
means to see how sites look in a range 
of devices. For iPhones, click the device 
icons to switch between landscape and 
portrait orientations. iPads have more 
options to cycle through, taking into 
account Slide Over and Split View. Note 
that if a full-size view won’t fit in the 
browser window, it will be scaled.

103 Subscribe
Choose View > Show 
Shared Links Sidebar and 
then click Subscriptions. 
Here, you can add and 
track feeds from your 
Favorites, so you don’t miss 
important posts. If you get 
the bug, consider a full-on 
RSS client such as Reeder 
(reederapp.com) and a 
service like feedly.com.

94 Try Chrome
It might sound a bit odd to have a tip 
that essentially says ‘use something 
other than Safari’ here, but Google’s 
Chrome comes with a built-in version 
of Flash Player. This means you can 
uninstall Flash from your Mac, thereby 
removing it from Safari, but still use 
Chrome as a fail-safe of sorts – say, to 
watch the odd bit of video that demands 
it, or to play a Flash-based game.
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87 Keyboard access If you don’t want 
to enable full keyboard access (tip 5) 
throughout OS X, use å+† to step 
between every interactive item on a 
web page in Safari.
88 The Develop menu In Safari’s 
Advanced preferences, turn on ‘Show 
Develop menu in menu bar’. If a page 
doesn’t work in Safari, rather than 
copy and paste its address into another 
browser, choose Develop > Open Page 
With, then a browser listed here, which 
Safari has detected on your Mac. 
89 Change the user agent 
By default, the Mac version of Safari 
identifies itself as such, but you can 
change this under User Agent in the 
Develop menu. This can be useful when 
a site blocks Safari for some reason. 
Also, you can switch it to identifying 
itself as Safari for iPad when visiting 
sites that use Flash for video on a Mac.  
90 Bonjour In Safari’s Advanced 
preferences, you can add Bonjour to 
the Favorites bar. Some hardware on 
your network may advertise its admin 
page under this item for convenience.



95 Manage downloads
In Safari’s General preferences, you can 
choose where file downloads are sent. 
If you don’t want them to go to your 
Downloads folder, select Other in the 
pop-up menu. Should you want Safari 
to ask where to save each one, you can 
specify that. There’s also a checkbox 
regarding opening safe files. Clear it if 
you don’t want your Mac to open docs, 
distracting you from what you’re doing.

97 Access passwords
Safari’s Passwords preferences are 
worth exploring. Here you can enable 
or disable AutoFill for usernames and 
passwords, and check the details it uses 
to sign into sites. The search bar here 
filters the list, and double-clicking an 
obfuscated password requests an 
administrator username and password 
to reveal it – you can then copy and 
paste the password elsewhere.

96 Quick shortcuts
In Safari’s Tabs preferences, there’s a 
checkbox labelled ‘Use ç+1 through 
ç+9 to switch tabs’. If this is filled, 
you can switch to any of the first nine 
open tabs in a window (including 
pinned ones) by pressing ç and a 
number. If you clear it, Safari reverts 
to older behaviour, enabling you to use 
the same shortcuts to quickly access 
the first nine links on the Favorites bar.

106 iCloud tabs
If you’re all connected up 
to iCloud, you can access 
tabs open on your other 
devices. Either click the 
Show All Tabs button and 
scroll down to see them, 
or click the iCloud Tabs 
button. If either of these is 
missing, add it by choosing 
View > Customize Toolbar.

104 Top Sites
Apple seems quite keen on 
the Favorites view for new 
tabs, but you can click the 
grid button at the top-right 
corner of it to switch back to 
the old Top Sites view, which 
shows large previews of up 
to 24 regularly visited sites. 
Put the pointer over one for 
options to pin or remove it.

98 Local keychain
The idea behind iCloud Keychain is to 
save time on devices you approve to 
use it by storing account credentials, 
bank card details, and known Wi-Fi 
network information. By default, this 
information is backed up to iCloud, but 
by skipping the creation of an iCloud 
Security Code, it’s stored locally only 
on approved devices. Apple can’t help 
recover your keychain in this scenario.

105 New focus
Safari’s General prefs let you 
separately set what’s 
displayed in new windows 
and new tabs. They can be 
set to Top Sites/Favorites, 
a user-defined ‘Homepage’, 
or nothing. New windows can 
automatically open a folder 
of bookmarks, but be wary 
that this can be slow.

107 Favourites
If you open the same set of 
sites often, open them all in a 
single window and then go to 
Bookmarks > Add Bookmarks 
for These Tabs. Put them in 
the Bookmarks menu and 
their folder there will contain 
an item at the bottom that 
lets you open the lot in just 
two clicks.
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99 Grab some extensions In Safari’s 
Extensions preferences, click the Get 
Extensions button to add features to 
the browser. Also, search online for 
more – Apple doesn’t list NoMoreiTunes 
(nomoreitunes.einserver.de), yet we like 
how that one stops the app opening on 
visiting iTunes Preview web pages. 
100 Read things later Safari provides 
the means to stash pages to read later, 
even when you’re offline. Place the 
pointer over the address bar and click 
the +. Choose View > Show Reading List 
Sidebar to access saved pages.
101 Try Instapaper Alternatively, try 
the free Instapaper service (instapaper.
com), which not only saves web pages 
for later, but strips away cruft, leaving 
only text and images. It integrates with 
Safari through a free extension.
102 Share things Use the Share 
button to add the page you’re reading 
to your bookmarks, or to share it by 
email or on a social network you’ve 
signed into in the Internet Accounts 
pane. Click More to manage the Share 
menu’s contents. 



Remotely access Macs

System Preferences

 macformat.com  @macformat

Make it easy to pick out a setting from the many your Mac offers

109 Use Spotlight
Another way to quickly connect is to 
search for the Screen Sharing app in 
Spotlight. Opening it gives you a small 
dialog box that needs the name or 
Apple ID to connect to. Enter one and 
click Connect. The recipient will receive 
a notification and be asked whether 
they accept or decline the connection. 
If they agree, their desktop will appear 
in a window on your Mac.

115 Fast navigation
While in a preferences pane, you don’t 
need to return to the full list to access 
another. Click and hold the toolbar’s 
grid button for a list of all panes, or go 
to the View menu (any item in which 
can be given a shortcut in Keyboard 
preferences), or press ç+F and type 
in the search field. When you’re at the 
top level of the app, the last method 
highlights relevant panes as you type.

112 Remote control
To perform a task on another Mac 
that requires you to control its screen, 
find that Mac under Shared in Finder’s 
sidebar and click Share Screen. If you 
are already signed in on the other Mac, 
its desktop should quickly appear, and 
response time should be pretty good 
over a typical home network. If Edit > 
Shared Clipboard is on, you can easily 
copy and paste between the two Macs.

118 Uninstallation
Plenty of third-party utilities install as 
(or with) a System Preferences pane. 
If you no longer use one, you can get rid 
of it: ≈-click its icon and pick Remove. 
Note that some panes will be apps that 
have deep integration with the system 
and may need an admin password to 
proceed further. Also, if you continue to 
use an associated product but not the 
pane, consider hiding it instead.

108 Use Messages
Friends can temporarily access each 
other’s Macs using Messages. Open a 
conversation and then click Details (or 
≈-click a contact in the sidebar and 
choose Details). Click the overlapping 
rectangles icon next to the contact’s 
name and invite them to share your 
screen or ask to see theirs. If control of 
the screen isn’t granted, the viewer can 
still click to highlight areas of it.

114 Speedy access
Rather than clicking a pane’s icon in 
System Preferences, try opening the 
pane using Spotlight. Type the first few 
characters of a pane’s name and it’ll 
likely be the top result. Alternatively, 
if you keep System Preferences in the 
Dock, you can ≈-click its icon there 
and then select the pane you want it to 
show immediately upon opening from 
an alphabetically ordered list.

111 Browse storage
Select the Mac you want to browse in 
the Shared section of Finder’s sidebar, 
then click Connect As at the top-right 
corner of the window. Connect as a 
registered user, and provide your 
username and password. On doing so, 
the other Mac’s folders appear in the 
Finder window. They can be browsed 
like local storage, and you can copy 
documents to the Mac you’re using.

117 Reorder panes
By default, icons for preference panes 
are organised by category, but recent 
versions of OS X no longer label those 
categories. (The one with Displays used 
to be called ‘Hardware’.) If you find it 
tricky to locate a pane, choose View > 
Organize Alphabetically to reorder 
them. Third-party panes are then 
integrated into the main list, though 
the alternating row colours disappear.

110 Access your Macs
If you have several Macs, it pays to set 
them up to share services over your 
network. You can do this in the Sharing 
pane of System Preferences. Within that 
pane, you can give the Mac a unique 
name (handy if, for example, you have 
two Macs of the same type), and turn 
on the likes of Screen Sharing and File 
Sharing. The defaults should be fine, 
but you can limit access by accounts.

116 Hide panes
If you find you never use certain panes 
and want to reduce clutter when at the 
top level of System Preferences, choose 
View > Customize. Clear the check mark 
next to any pane you want to hide, then 
click Done. Note that any such panes 
remain accessible via any of the means 
outlined in previous steps. To undo, 
choose Customize again and place a 
mark next to those you want back.

113 Back to My Mac
Back to My Mac lets you connect to a 
Mac over the internet. Both Macs must 
be signed in to the same iCloud account, 
The feature must be switched on in 
iCloud preferences on the remote Mac, 
along with ‘Wake for network access’ in 
the Energy Saver pane. With Back to My 
Mac checked in Finder’s preferences, 
you should be able to access files or 
share screens as per the last two tips.

119 Hidden talents
In recent versions of OS X, the Displays 
pane doesn’t show everything right 
away. To see recommended resolutions 
your monitor can handle, click Scaled. 
To see all resolutions, hold å and click 
Scaled (if Scaled is already selected, 
click ‘Default for display’ first). Hold å 
then click the Detect Displays button 
and the desktop should extend to any 
displays that aren’t automatically found.

Use screen sharing and network features to control and access other Macs
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Tone down system animations

120 Speedy Dock
When the Dock is set to hide itself, the 
time it takes to slide in and out of view 
can get annoying. Get rid of the delay 
by entering defaults write com.
apple.dock autohide-time-modifier 
-int 0; killall Dock. The Dock then 
appears and disappears instantly. 
To simply shorten the delay before the 
animation starts, enter defaults write 
com.apple.dock autohide-time-
modifier -float 0.15; killall Dock.

123 Mission Control
Some Mission Control animation can be 
removed by entering defaults write 
com.apple.dock expose-animation-
duration -float 0. This seems to 
disable animation for Mission Control 
and viewing the Desktop (ç+£), but 
not for App Exposé if any windows are 
minimised. Also, if you have many open 
windows, you may get a split-second 
delay on first opening Mission Control 
after running this command.

126 New windows
In many apps, creating a new window 
causes it to zoom in from the centre of 
the screen, which seems unnecessary 
and can be a bit slow on older Macs. 
To kill this animation, use defaults 
write -g NSAutomaticWindowAnim 
ationsEnabled -bool NO. On our Mac, 
this seemed to take effect immediately; 
but if that doesn’t happen, restarting an 
app should be enough to have windows 
instantly appear on prodding ç+n.

121 Calm Launchpad
Launchpad uses a crossfade with a 
fairly subtle zoom. This can feel laggy 
and cause problems for people with 
vestibular conditions. Get rid of both 
the entry and exit animations by 
entering defaults write com.apple.
dock springboard-show-duration 
-float 0; defaults write com.apple.
dock springboard-hide-duration 
-float 0; killall Dock. This takes 
effect as soon as the Dock restarts.

124 The menu bar
You might wonder at what point the 
menu bar animates, given it seemingly 
stays rooted in place. When you put an 
app in full-screen mode and then move 
the pointer to the top of the screen, 
the menu bar animates in a manner 
similar to an auto-hiding Dock. If that 
annoys you, disable the animation with 
defaults write -g NSToolbarFullScr
eenAnimationDuration -float 0; 
killall SystemUIServer.

127 Reverse changes
All of the tips on this page trigger 
‘hidden’ settings buried deep in OS X, 
which, for whatever reason, Apple has 
decided to not provide a graphical 
interface for. Most can be reversed by 
switching a 0 for a 1 or a NO for a YES. 
Alternatively, use defaults delete 
before a setting’s name, and any 
relevant killall command, like: defaults 
delete com.apple.dock autohide-
time-modifier; killall Dock.

122 Launchpad pages
When you have multiple pages of apps 
in Launchpad, swiping or pressing ç 
and an arrow key will trigger a dizzying 
full-screen slide transition. Disable this 
with defaults write com.apple.dock 
springboard-page-duration -float 0. 
(On our Mac, using a trackpad after this 
command still nudged the icons a little 
before snapping to the new page, but 
using keyboard shortcuts resulted in no 
animation at all.)

125 Open and Save
When opening and saving documents, 
the Open and Save dialogs typically 
animate in as a sheet, which can seem 
sluggish and also, again, cause issues 
for people with vestibular disorders. 
Kill the animation with defaults write 
-g NSWindowResizeTime 0.001. 
Note here that a setting of 0 will not 
work. (0.2 is the default.) Furthermore, 
any changes you make will only take 
effect after an app is restarted.

128 TotalSpaces
The animation we’d like to see the back 
of is the sliding transition when moving 
between spaces and apps in full-screen 
mode. Sadly, a Terminal command for 
modern flavours of OS X eludes us. 
One solution is TotalSpaces2, which can 
disable these transitions. However, in 
El Capitan it requires you to disable 
System Integrity Protection settings 
(see bit.ly/tssip), so use extreme caution 
when exploring this option.

Use Terminal to zap animations and get a snappier Mac
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Hardware upgrades

Second-hand selling

 macformat.com  @macformat

Essential steps for protecting your purchases and files when selling an old Mac

130 Fusion power
Boost a desktop Mac by making a 
Fusion Drive, which combines fast flash 
storage with the large capacity of your 
hard drive in a single volume. This is 
possible in OS X 10.8.2 onwards, and is 
done using the command-line version 
of Disk Utility and Apple’s Core Storage 
tech. The SSD is best fitted internally or 
to a Thunderbolt or USB 3 port. (See 
MF296 for a full project on doing this.)

136 Prepare to sell
Ensure that you have copies of all 
documents from your Mac when you 
start preparing it for sale. If you’re 
unsure, clone its drive to an external 
one so that you have a copy even after 
you wipe the Mac’s storage. Check that 
you have registration information for all 
apps installed on it too. It’s a good idea 
to keep copies of your keychain and 
other important data too.

133 Add memory
In many Macs, it’s possible to increase 
the amount of memory (RAM). Check 
yours in  > About This Mac > Support > 
Hardware Support and look for memory 
upgrade instructions, or use Mactracker  
(free, Mac App Store). Recent versions 
of OS X need 2GB, but benefit from 4GB 
and come alive with 8GB or more. If you 
have less than 4GB, look seriously at 
this – you may be able to do it yourself.

139 Wipe new OS X
On more recent versions of OS X, start 
up in OS X Recovery (ç+r) or from a 
USB disk (see apple.co/1Mq5cca). Open 
Disk Utility, select your startup disk and 
click Erase. Set the slider for performing 
multiple passes to an appropriate level 
for the sensitivity of data on the drive. 
When erasing’s complete, reinstall OS X, 
then press ç+q once the Mac restarts 
and invites you to select your country.

129 Boost storage
Add to your MacBook’s built-in storage 
with a flush-fit SD card designed for 
your model, such as the Nifty MiniDrive 
(minidrive.bynifty.com). Older models 
with optical drives can have that one 
replaced by a 2.5-inch hard drive or SSD 
in a special caddy; as this gives you an 
extra volume for files, create a symbolic 
link for Documents, say, so it’s easier to 
access directly from your startup disk.

135 The right model
Ensure you list the correct model 
designation, so the purchaser knows 
exactly what they’re getting. Use the 
exact name given in the About This Mac 
dialog; though bought in mid-2014, your 
27-inch iMac may be a Late 2013 model. 
Add the identifier shown when you click 
System Report, such as iMac17,1. Other 
details, such as memory and storage 
type and size, are important too.

132 Use your cores
In Activity Monitor, choose Window >  
CPU History to keep an eye on the load 
placed on your processor’s cores. Older 
versions of some apps may hog a single 
core, leaving the other cores only lightly 
loaded. If that’s the case, consider 
upgrading to the latest release (check 
for a trial), which may make better use 
of multiple cores. Sadly not all tasks can 
be split across cores in this way, though.

138 Wipe older OS X
If your Mac’s on OS X 10.6.8 or earlier, 
make an external boot disk or use an 
install DVD. Start up from that, open 
Disk Utility, then erase the internal drive 
completely to prevent the purchaser 
recovering your old files. The benefits 
of multiple passes are debated by some, 
but, generally, the more sensitive your 
files, the more passes you should make. 
Once erased, install OS X afresh.

131 A new hard drive
If you can’t make a Fusion Drive for a 
desktop Mac, install a larger and faster 
hard drive instead to give OS X more 
breathing room. To do it yourself you’ll 
need to be brave enough to dive deep 
inside your Mac’s internals, and have a 
suitable dust-free environment in which 
to work. You’ll find detailed instructions 
for many Mac models on ifixit.com, 
complete with photos to guide you.

137 Deauthorise it
Work systematically through all apps 
that have required authorisation, such 
as Adobe products and QuarkXPress, 
and deauthorise them from that Mac – 
check with its publisher’s site or help 
desk if you don’t know how. Deauthorise 
the Mac from your iTunes and App 
Store accounts, and sign out of iCloud 
and similar services. This is better done 
on the Mac, as it’s more complex later.

134 Even more RAM
Even if you bought your Mac with the 
maximum amount of memory provided 
by Apple, it may be capable of taking 
more. Check the Mactracker app’s 
current recommendations, which take 
into account more recent availability of 
larger memory modules. Don’t use RAM 
models other than those recommended, 
as different ones are unlikely to work 
properly and could damage your Mac.

140 Recycle wisely
If you can’t sell or store your old Mac, 
or donate it to charity, then recycle it. 
Prepare as if selling it, and wipe its hard 
drives. Erase each one to minimise any 
risk of someone recovering data. Once 
shut down, remove the hard drives. 
Smash them with a sledgehammer on 
a hard surface until the cases are well 
opened and the platters are physically 
disrupted or destroyed.

Boost your Mac’s performance by improving its specs
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Software-based updates

141 Update server
If you have several Macs, including one 
which you can leave running, install 
OS X Server on the latter and set up its 
Caching service. This keeps a copy of 
software updates, App Store apps, and 
some iCloud data. Macs running recent 
versions of OS X then obtain updates 
from that server, saving download time 
and bandwidth. If any of your Macs use 
iCloud, encrypt the server’s drive that’s 
used to cache, for privacy and security.

144 Fix permissions
When updating or upgrading versions of 
OS X prior to El Capitan, use Disk Utility 
to repair permissions on your startup 
disk after performing system software 
installations. This often fixes otherwise 
puzzling problems. It’s neither so easy 
nor so useful to do this in El Capitan 
due to System Integrity Protection (SIP), 
which prevents things tampering with 
most system files, except for Apple 
installers or in Recovery mode.

147 App receipt list
All software updates and installations, 
except those you perform by manually 
moving files, are recorded in the file 
InstallHistory.plist in /Library/Receipts, 
in chronological order from top to 
bottom. If you’re unsure what has been 
installed or when, select that file in 
Finder and press the Spacebar to open 
it using Quick Look, then scroll to the 
end. Never edit the original: to browse 
it in a text or XML editor, use a copy.

142 Download updates
Instead of an update server, download 
large updates for things like OS X from 
Apple’s support pages, rather than 
updating each Mac from the App Store. 
Use smaller ‘delta’ packages when 
only upgrading to the next release, 
or Combo updaters to move up more 
than one minor version at a time. 
Copy updates to a common shared 
folder on one Mac, or onto a USB flash 
drive to connect to each Mac in turn.

145 Disk first aid
Sometimes updates can result in (or 
worsen existing) disk problems. Running 
Disk Utility’s First Aid feature is a good 
first-line treatment for such issues. It’s 
most effective when run from a volume 
other than your usual startup disk; use 
OS X Recovery if it’s available. Beware 
that some errors, such as cross-linked 
files, are likely to lead to some data loss, 
hence the importance of ensuring you 
have good backups before updating.

148 Silent updates
Yosemite and El Capitan now undergo 
silent updates to security files, which 
may have odd effects. An update to the 
XProtect security blacklist, say, might 
disable an old version of Flash or Java. 
Updates which affect SIP can disable 
hardware such as network ports when 
your Mac is next started up. If you think 
a silent update has altered your Mac, 
check /Library/Receipts/InstallHistory.
plist to see what has occurred.

143 Combo curative
If you’re left with strange issues after an 
OS X update that can’t be fixed by other 
means, such as changing preferences, 
download that version’s Combo updater 
from Apple’s support site and install it 
over your current installation: you may 
find your problems suddenly vanish. 
This can also restore normal function 
to a Mac App Store app that refuses to 
offer updates. It’s not a universal cure, 
but worth trying when other ideas fail.

146 Check manifests
App installers (PKG files) that leverage 
OS X’s built-in Installer app can be 
manually uninstalled by working out 
what was added and where. To see the 
full list of everything in a package, open 
it and choose File > Show Files to display 
a textual listing. This doesn’t include 
additional files created by the app post-
install, such as preferences or additional 
folders it may create in Library folders, 
but it helps you know what to remove.

149 Keep a fallback
Before updating any app you depend 
on, ensure you either have a good Time 
Machine backup of it, or make an extra 
copy of the previous version. Should an 
update turn out to be dysfunctional, 
or vital features are broken or missing, 
you can then revert to your fallback 
copy and work normally again, waiting 
for a further update to fix the problems. 
Make sure automatic updates aren’t 
enabled, so that you keep control.

Learn how to tackle problems caused by troublesome software updates
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Text editing and replacement

 macformat.com  @macformat

162 Keyboard Viewer
Open Keyboard Viewer from the menu 
bar. Its representation of your keyboard 
reflects any keys that are pressed. Hold 
one or more modifier keys (ß, ç, å) 
and it shows characters available when 
using them in combination with specific 
keys. Hold å and some keys go orange 
to indicate all those you can hold in 
order to call up the pop-over of 
accented characters described earlier.

165 Favourites
If there are symbols you want faster 
access to, you have two options. First, 
those you use often are automatically 
collected under Frequently Used (its 
contents can be cleared from an option 
behind the cog). Alternatively, build a 
favourites list: select any symbol and 
click Add to Favorites. This may seem 
like more work, but it’s beneficial with 
the pop-over version of this window.

163 Emoji & Symbols
Choose Show Emoji & Symbols from 
the menu bar icon mentioned earlier. 
The Characters window is displayed as 
a floating window belonging to the app 
you opened it from (several instances of 
it can exist, each from a different app 
and in different places on the screen). 
Select a category to filter the list, or use 
the Search field to find a specific one, 
such as ‘phone’ emoji or the letter ‘eth’).

166 Pop-over window
If you click the button at the top-right 
corner of the Characters window, it 
collapses into a simpler form, with a 
search field at the top, then frequently 
used and favourite symbols. Categories 
can be accessed by clicking icons at the 
foot of the window. If not already open 
in its larger version, this window can be 
called upon as a pop-over in many apps 
by pressing ≈+ç+[spacebar].

164 Customise
Click the cog at the top-left corner of 
the Characters window to customise it. 
Character size can be adjusted, which is 
good for more easily telling characters 
apart. (The window can be resized to 
accommodate this.) The Customize List 
item reveals a list of categories. Those 
that are checked appear in the window’s 
sidebar. Symbols in hidden categories 
remain accessible in search results.

167 View fonts
Some text editors have built-in palettes 
for adjusting fonts, but many still enable 
you to work with OS X’s Fonts window, 
accessed using ç+t. Use the window 
to select a font and size, picking from 
collections in the sidebar. If there are 
specifics you use often, add them to 
Favorites by clicking the cog and 
choosing Add to Favorites. Pick Show 
Preview there to check your choices.

150 Master the basics It can pay to keep 
your hands on the keyboard and not get 
distracted by finding items in the menu 
bar. Try to memorise commonly used 
shortcuts, especially Cut (ç+x), Copy 
(ç+C), Paste (ç+v), Undo (ç+z) 
and Select All (ç+A).
151 Learn formatting basics Whether 
you’re working on a formatted rich-text 
document or a Markdown file, you will 
sometimes need to emphasise text. 
You can typically make a selection bold, 
italic or underlined by pressing ç+B, 
ç+I, or ç+U, respectively.
152 Paste and match styles In some 
apps, you’ll find the text style comes 
along for the ride when you paste a 
copied selection into another document. 
(To see this happen, copy from Safari 
and paste into TextEdit.) To avoid this 
happening, use Edit > Paste and Match 
Style (or press å+ß+ç+v).
153 Align text Most languages have a 
default text alignment (for example, left 
for English). You may want to override this 
for stylistic reasons, in order to make 
headings or quotes stand out. OS X’s 
default keyboard shortcuts for align left, 
centre and right involve holding ç and 
pressing {, |, or } respectively. Note that 
alignment is only available in some text 
editors, and shortcuts may vary — 
Microsoft Word, for example, has its 
own ideas about what you should press. 
154 Use arrow keys The arrow keys 
move the insertion point a character or 
line at a time, but you can make larger 
jumps by combining them with modifier 
keys. Press å+“ or å+‘ to move the 

insertion point one word at a time. ç+“ 
or ç+‘ moves to the start or end of the 
current line. å+æ or å+æ moves to the 
start or end of the paragraph (usually — 
some apps vary), and ç+… or ç+æ 
jumps to the start or end of the document.
155 Shift to select Hold ß as part of 
any of the previous tip’s shortcuts to 
make a selection as you go.
156 Select with pointer Double-click to 
select a word, or triple-click to select its 
paragraph. Keep the button held on the 
last press and then drag to extend the 
selection in whole words or paragraphs.
157 Delete more easily To get rid of the 
character to the left of the insertion point, 
press ∫. To delete in the other direction, 
use ƒ+∫. Press å+∫ to remove an 
entire word, or ç+∫ for an entire line.
158 Insert a new line Apple’s system-
level text-editing system supports 

shortcuts used by Emacs, a text editor 
favoured by programmers. One is really 
handy: ≈+o adds a new line after the 
insertion point.
159 Hold for extended characters  
If you can’t recall shortcuts for accented 
and other common special characters, 
hold the key for the basic letter form. 
A pop-over menu will provide options: 
pressing the number below the one you 
want will insert it. So for é, hold e and 
then press 2 when the pop-over appears.
160 Show the character viewers 
The rest of this page explores OS X’s 
character viewers, which make it easier 
to find all sorts of exotic glyphs to insert 
into a document. In System Preferences > 
Keyboard > Input Sources, turn on ‘Show 
input menu in menu bar’ to add an icon 
you can click to open the Emoji & Symbols 
window or the Keyboard Viewer.

161 To select a range of words, double-click the first one in it, hold ß, then click the last one.

Speed up working with text and adding characters and emoji to your documents
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168 Replacements

170 Symbols

172 Multiline text

169 Have a system

171 Your details

173 Go further

Choose your corrections
In Keyboard preferences, click Text. 
On the left is a large area that enables 
you to configure OS X’s system-wide 
text replacement feature. There are 
two columns: Replace and With. When 
something in the former is typed (in a 
compatible app), it’s replaced by what 
is next to it in the latter. Add an entry 
by clicking the + button, and use the – 
(minus) button to remove one that’s 
selected. Be mindful; there’s no undo.

When used in tandem with the 
Character window, text replacements 
can be powerful and a real time-saver. 
For example, type ,,musicalnote in 
the Replace column, and in the With 
column press ≈+ç+[spacebar] to 
open the pop-over, then type ‘note’ in 
the search field. Click the note to use. 
You can employ similar thinking for 
emoji, or in shortcuts for star ratings, 
such as ,,threestars for .

Although it’s not really set up for 
multiline text replacements, OS X’s 
built-in system can accept them. 
This means it’s feasible to have the 
likes of ,,address be replaced by a 
properly formatted address — simply 
hold å when pressing ® after each 
line. Alternatively, you can type your 
text into TextEdit, copy it, then click in 
the relevant space in the With column 
and paste it by pressing ç+v. 

When defining replacements, don’t 
use plain words. For example, if you 
set ‘email’ to become your full email 
address, every typed instance of that 
word would be replaced. We suggest 
prefixing the text to replace with a pair 
of symbols, such as two commas, that 
you’re unlikely to use in typical writing. 
A comma is easy to access on iOS too; 
text replacements sync to iCloud and 
your other devices signed in to it.

Beyond symbols that aren’t easy to 
access normally from the keyboard, 
text replacement is handy for 
speeding up text you write regularly. 
For example, if you have a blog, you 
could use ,,blog and the replacement 
could be its address. Similarly, you can 
cut down how long it takes to type out 
your email address, by replacing 
,,email (or a specific service, such as 
,,gmail) with the relevant address.

With careful planning, OS X’s text 
replacement system is hugely useful, 
but it has drawbacks – notably, some 
shortcuts taking time to become 
active (sometimes requiring an app 
restart), and limitations to formatting 
and content. If you feel restricted, try 
TypeIt4Me (£14.99, ettoresoftware.
com), which enables images, advanced 
formatting, markup and macros, with 
better tools for managing snippets.

174 Enable autocorrect
Under Text in the Keyboard preferences 
pane are options for activating spelling 
correction (which defaults to automatic 
by language). In many apps, you may have 
to manually turn on spelling correction: go 
to Edit > Spelling and Grammar, and activate 
the relevant options (Check Spelling While 
Typing and Correct Spelling Automatically). 

175 Make corrections
When something’s typed that OS X thinks is 
wrong, a pop-over suggests an alternative. 
Its suggestion will be used as a replacement 
if you continue typing (and the new word 
will be temporarily underlined blue). Press 
ç+z to revert it. If OS X often changes 
something that’s correct, ≈-click the 
reverted word and choose Learn Spelling.

176 Use substitutions
The aforementioned location contains 
settings for using smart quotes and dashes 
in documents. These also sometimes need 
to be activated manually, which you can do 
in most apps by turning on the relevant 
options under Edit > Substitutions. 

177 Show substitutions
You can get more of an overview of which 
settings in Edit > Substitutions are active by 
choosing Show Substitutions in that menu. 
This brings up the floating Substitutions 
window, with checkboxes for activating 
smart dashes, smart links, text replacement, 
and various kinds of smart quotes. OS X will 
typically pick appropriate options for your 
primary language, but you can override it 
here, if, say, writing in English, but adding 
a quote that needs French-style marks.

178 Use smart links
When you’re working with rich text, OS X 
can intelligently transform plain text into 
clickable links. So, you can type in an email 
or web address, and later click on it to open 
Mail or Safari, respectively. For the most 
part, OS X picks up web addresses in the 
format apple.com – continue typing and the 
text will become a link. Sometimes, esoteric 
domain name suffixes trip it up. When that 
happens, try prefixing the text with ‘www.’ 
(without quotes, and if relevant) or http://. 
Note that an individual link can be removed 
by ≈-clicking it and choosing Remove Link.
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Notifications

Security settings

 macformat.com  @macformat

Understand more about locking down your Mac and keeping everything safe

180 Quick peeks
If a notification disappears from view 
before you get a chance to read it, you 
needn’t move the pointer to the menu 
bar to open Notification Centre. If you 
have a trackpad, swipe two fingers in 
from its right edge (check this gesture’s 
enabled in the Trackpad preferences 
pane), or set a keyboard shortcut for the 
same effect under Shortcuts > Mission 
Control in the Keyboard pane.

186 Reset password
If a user’s login (not firmware) password 
is lost or forgotten, an admin can reset 
it in the Users & Groups pane: click the 
padlock and unlock the pane, select a 
user, then click Reset Password and set 
a new one. For an admin password, you 
can attempt to sign in until challenged 
to use an Apple ID, or, if FileVault is 
turned on, potentially use the steps 
Apple outlines at apple.co/1TLWPJx.

183 Think privacy
If your Mac’s in a shared space where 
people might see personal messages, 
be mindful that notifications default to 
previewing messages, even on the Lock 
screen. To prevent this, select a relevant 
app in the Notifications pane, then turn 
off ‘Show notifications on lock screen’. 
If you leave that on, you can turn off the 
item immediately below to see only an 
indication of who has contacted you.

189 Parental controls
Although designed to create limited 
accounts for children, the Parental 
Controls preferences pane has other 
uses. Because you can explicitly limit 
access to apps and services, it can be 
a useful means of setting up a Standard 
account to work like the Guest one, but 
without everything being lost at logout. 
At any point, an admin can delete or 
adjust settings for managed accounts.

179 Make it quiet
If you want some quiet time, suspend 
notifications with Do Not Disturb. This 
can be scheduled in the Notifications 
preferences pane, or manually turned 
on: scroll up in Notification Centre for a 
switch, or å-click Notification Centre’s 
menu bar icon. Do Not Disturb can be 
important if you have a 2015 MacBook, 
which may wake up for ‘enhanced 
notifications’ — see apple.co/23ocK6L.

185 Extra protection
Your account’s login password won’t 
help if a thief starts it up from another 
disk, so set a firmware password to stop 
them doing that. A firmware password 
can be set by starting in OS X Recovery 
(hold ç+r at the startup sound). Pick  
Utilities > Firmware Password Utility, 
click Turn On Firmware Password, set 
a password, quit the app, then restart 
your Mac. Don’t forget this password!

182 Hidden options
In the Notifications pane, some apps, 
such as Mail and Messages, have extra 
options beyond the usual ones, but you 
may find further settings exist within an 
app’s own preferences. For example, in 
Mail’s General preferences, the ‘New 
message notifications’ item can restrict 
notifications to your inbox, VIPs or a 
Smart Mailbox – great for being alerted 
to emails that need immediate attention.

188 Gatekeeper
This feature restricts what apps can run 
according to their source, to reduce the 
likelihood of installing malware. It offers 
three options in the Security & Privacy 
pane, under General: Anywhere gives 
total freedom, essentially turning off 
Gatekeeper; Mac App Store only lets 
apps from there run; and the middle 
item also allows apps from other places 
that are signed by identified developers.

181 Sort order
If you receive a lot of notifications, 
make stuff easy to find by selecting 
a sort order that suits you at the 
bottom of the Notifications preferences 
pane. Recents is reverse-chronological, 
and Recents by App is the same, but 
grouped by app. For a custom order, 
select Manually by App, then drag items 
on the left into the order you want them 
to appear in Notification Centre.

187 Assistive apps
Some apps, such as window managers 
and dictation software, use accessibility 
features to control your Mac. When first 
opened, they’ll likely direct you to allow 
this (old apps may direct you to an out-
of-date place). In System Preferences > 
Security & Privacy > Privacy, unlock the 
pane with admin credentials, select 
Accessibility in the sidebar and enable 
apps you want to have this capability.

184 iOS notifications
Continuity features in OS X and iOS 
are intended to make your devices work 
better together, but they don’t extend 
to notifications. Those received on your 
iPhone or iPad don’t appear on your 
Mac (unless an equivalent Mac app also 
shows it). Third-party apps fill this gap: 
put Pushbullet on your iOS device and 
PushPal (£2.29) or the free Pushbullet 
extension for Chrome on your Mac.

190 System protection
El Capitan introduced System Integrity 
Protection (SIP) to protect system files, 
which stops tools that used to patch the 
system from working. It can be disabled 
(though it’s not generally advised) using 
csrutil disable in Recovery’s Terminal. 
You can disable bits of it – TotalSpaces 2 
works with csrutil enable --without 
debug – but there’s no guarantee such 
commands will exist in future updates.

Gain more control of your notifications – including those from iOS!
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191 Text styles
Styles help with consistency 
and make it easier to change 
things later on. Select some 
text, choose the Title style in 
the Format sidebar, then set 
the formatting options as you 
want them. The asterisk next 
to ‘Title’ indicates the text’s 
look is based on that but 
doesn’t use it exactly. Click 
Update to amend the style 
and every instance of it. 
To make a new style, format 
some text, click the triangle 
next to its name, then + in the 
pop-up, and name your style.

192 Capitalise
Click the cog in the Text pane 
of the Format sidebar, next to 
the Bold, Italic and Underline 
buttons, for a capitalisation 
option. Select some text and 
you can force it to uppercase, 
for example. Note that the 
mixed- or lowercase text you 
typed is still stored that way 
behind the scenes; it’s merely 
transformed for display. This 
is really handy if you start 
with an All Caps caption style, 
for example, but change your 
mind – so long as you wrote in 
mixed case to begin with.

193 Apply styles
You can apply styles quickly 
by pressing ! through to *. 
In the Format sidebar, click 
the downwards-pointing 
triangle next to the style 
name, place the pointer to 
the right of the style you 
want to associate with a 
function key and click the 
rightwards-pointing chevron 
that appears, then pick a 
function key under Shortcut. 
To use the shortcut on Macs 
without dedicated function 
keys, hold ƒ and press the 
corresponding number key.

195 Placeholders
If you frequently update the 
images in a document, make 
use of Media Placeholders, 
onto which you can drag and 
drop new images. Images are 
scaled and cropped to the 
correct size, and object styles 
set on the placeholder are 
applied to them. Set up an 
image how you want it (with 
crops, borders, reflections 
and so on), then pick Format > 
Advanced > Define as Media 
Placeholder. Images in 
placeholders can be scaled 
and moved within them.

196 Templates
Once you’ve set up your 
styles, letterheads and so on, 
you can easily share the 
template with others. Choose  
File > Save as Template. You’ll 
be given the option of adding 
it to your Template Chooser – 
the gallery that pops up when 
you create a new document – 
or saving the file externally to 
share with others; they only 
need to double-click the  
.template file, and they’ll be 
given the option of adding it 
to the Template Chooser for 
their copy of Pages.

194 Cascade
If you always switch to your 
Body style after using 
another one you’ve made 
called Pullquote, for example, 
you can instruct Pages to 
automatically switch to the 
Body style when you press ® 
after typing something in the 
latter style. To set up this 
rule, select a piece of text 
that’s formatted with the 
Pullquote style, then click 
More in the Format sidebar 
and ensure Body is selected 
for the Following Paragraph 
Style option.

202 Extend formulae
Select a cell that contains a formula, 
then move the pointer to the centre of 
one of its edges and drag the yellow 
handle that appears across adjacent 
cells. Numbers is smart enough to 
update cell references in the formula to 
be relative to each newly filled cell. This 
also works with a series of numbers or 
dates; enter at least two, then select 
them and drag from the yellow border.

204 Special cell types
Numbers supports some special cells 
that make it really easy to enter certain 
kinds of data. These include clickable 
checkboxes, star ratings, and pop-up 
menus so you can pick from a range 
of predetermined values. With a cell 
selected, open the Format sidebar’s Cell 
pane and click the Data Format pop-up 
menu at the top of it, then pick one of 
the last group of five formats.

203 Concatenate
The ampersand symbol (&) has a special 
function on a spreadsheet: to bring 
together values from other cells into 
one. It treats them as strings of text, 
not mathematically, and it’s handy for 
grouping stuff. So, with surnames in 
column A, forenames in B, and titles 
in C, entering =C2&" "&B2&" "&A2 in 
column D would concatenate those 
values with spaces between them.

205 Interpret types
If you want to have a formula act on the 
data in special cell types, look at the 
window’s bottom-left corner and you’ll 
see what the actual, behind-the-scenes 
value that’s recorded in that cell is – for 
example, it’s FALSE for an unchecked 
checkbox and TRUE for a checked one. 
This tells you what values to enter in 
your formula – to check a special cell’s 
condition using the IF function, say.

214 Spacing
Although you don’t have 
fine-grained kerning 
control between just two 
characters in Pages, you 
can tweak the spacing for 
a word or a longer piece 
of text from the cog menu 
next to the Bold, Italic and 
Underline buttons in the 
Format sidebar.

Pages, Numbers and Keynote

 macformat.com  @macformat

Boost your productivity with these essential iWork techniques
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197 Custom bullet points Pages lets 
you use anything you like as the bullet 
point for a list. Set your list to use text 
bullets, then replace the • with any 
character. (Press ≈+ç+[spacebar] to 
browse for one.) Image bullets let you 
use any graphic on your Mac.
198 The default template In Pages’ 
preferences, you can specify which 
template to use when you press ç+N. 
If you then want a different one, hold 
å and pick File > New from Template 
Chooser, or just press å+ç+N.
199 Copy and paste styles If you 
won’t reuse settings for text, a picture 
or a shape extensively then, rather 
than define a style, select the object, 
choose Format > Copy Style, select 
another, then Format > Paste Style.
200 Lock objects Select an object, 
then press ç+l to prevent changes 
and deletion. To make changes to the 
object, select it and press å+ç+l.
201 Carriage returns in cells 
Pressing ® usually goes to the next 
cell down in Numbers. Use å+®  to 
move to a new line in the same cell.



206 Organise slides
Keynote lets you organise your slides 
into sections. Grab one or more slides in 
the left pane (hold ç when selecting 
them) and as well as being able to move 
them up and down, you can group them 
by dragging them a little to the right. 
Afterwards, click the triangle next to the 
group’s top slide to collapse it. You can 
skip slides too: select some, ≈-click one 
of that selection, and choose Skip Slide.

208 Make templates
Once you’ve changed a template’s 
Master Slides (choose View > Edit 
Master Slides) you can save it out for 
colleagues to use by choosing File > 
Save Theme. To build a template from 
scratch, you’re probably best picking 
the White template and amending that. 
Delete the slide types you don’t want, 
add any extras you need, and set them 
up how you want them before saving.

207 Combine actions
Select an object, click Animate in the 
toolbar, Action, then Add an Effect. 
Pick from the list of basic effects to 
make it move, rotate, resize or change 
opacity. Extra actions run in sequence 
by default. To run them at the same 
time, apply your first one, click Add 
Action again, set up the new action, 
click Build Order, click the new action 
and change On Click to With Build 1.

209 Distribute slides
It’s easy to distribute a presentation. 
Choose Play > Record Slideshow and 
walk through it, recording yourself 
speaking as you go. (Make sure the 
correct mic is selected by å-clicking 
the volume icon in the menu bar.) 
You can pause recording at any point. 
Once done, choose File > Export To > 
QuickTime and set the Playback option 
to Slideshow Recording.

217 Format
You can have cells change 
their appearance based on 
whether criteria are met, 
such as making a total red 
if you go over budget. 
Select the cells to act on, 
open the Format sidebar’s 
Cell pane, and then click 
Conditional Highlighting 
to set rules and styles.

218 Highlights
It’s easy for your eye to skip 
a row or a column, so hold 
å while the pointer is over a 
cell to highlight the cell’s row 
and column in blue. (If you 
do this often, consider using 
Numbers’ Alternating Row 
Color formatting option, 
which makes it easier to read 
across wide spreadsheets.)

216 Live counts
Pages has a live word count, 
which you can activate from 
the View menu or button. 
Click it to see other stats 
about your doc or selected 
text, and choose which stat’s 
always visible. You can also 
drag the counter anywhere 
on the page, or snap it to the 
document’s horizontal centre.

215 Toolbar
You can customise the 
toolbar in many apps, yet 
it’s really useful in iWork. 
Choose View > Customize 
toolbar, then drag features 
you use often onto the 
toolbar, drag out those you 
don’t, and rearrange and 
group the buttons using 
spaces and flexible spaces.

 macformat.com  @macformat
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210 Set default text style If you find 
yourself setting the same styles on 
every text box you create in Keynote, 
do it once, then pick Format > Advanced 
> Set as Default Text Box Appearance. 
Existing boxes are unaffected by this.
211 Share a link or a copy When you 
choose Share > Share Link via iCloud, 
anyone with the link can access your 
document, and their changes (if you’ve 
allowed editing) are reflected in your 
copy. Choose Share > Send a Copy to 
give them a copy independent of yours.
212 Share a collection of files Create 
a Pages, Keynote or Numbers doc, then 
add and select some text (or an object 
in Keynote) and add a link to it (Format 
> Add Link); paste the link to another 
doc hosted on iCloud as the target. Add 
more links, then share this master list.
213 Reduce shared file sizes Choose 
File > Advanced > Reduce File Size to 
remove detail in high-resolution images 
and delete parts of media beyond your 
chosen in and out points. This can help 
large docs fit in iWork for iCloud’s 1GB 
limit and reduce upload/download time.



System maintenance

 macformat.com  @macformat

Indispensable tools for fixing problems and keeping data secure

219 At startup
The most commonly useful 
startup key combos are: 
ß to enter Safe Mode; å to 
select an alternative startup 
disk; D to start a hardware 
diagnostics test, if available, 
or hold å as well to start it 
over the internet; ç+r to 
enter OS X Recovery, or 
hold å too for the online 
version; ç+å+p+r to 
reset NVRAM (see bit.ly/
mf-nvram); ç+s or ç+v 
for single-user or verbose 
mode (bit.ly/mfsuverb); and 
t for target disk mode.

220 Top folders
The /System/Library folder 
and hidden ones like /bin 
and /sbin are covered by 
System Integrity Protection 
(SIP) as they contain vital 
files; In /Library are items 
common to all users, such 
as most app support files, 
fonts, scripts, and more. 
Your user’s Library folder 
(in Finder, hold å and 
choose Go > Library) holds 
user-specific support and 
preferences, and sandboxes 
for Mac App Store apps in 
the Containers folder there.

221 Check logs
When your Mac keeps 
spinning the wait cursor, 
apps quit unexpectedly, 
or just isn’t working right, 
browse the logs immediately 
in Console. In it, select All 
Messages and look for clues 
to explain what went wrong. 
Entries are chronological. 
Many processes are named 
as if they are websites in 
reverse – com.apple.WebKit, 
for example, which refers to 
Apple’s WebKit components 
that support Safari and 
other internet connectivity.

223 Caches
Apps store temporary data 
in cache files in /Library/
Caches, ~/Library/Caches, 
and hidden system folders 
such as /tmp. These can get 
overburdened, orphaned, or 
corrupted, losing free disk 
space and causing unwanted 
behaviour. Starting in Safe 
Mode cleans some caches, 
including fonts. Go through 
each folder trashing caches, 
but be careful of what you 
remove. Tools such as 
TinkerTool System can clean 
caches – see bit.ly/mfcac.

224 Go to sleep
Macs should sleep when 
inactive for the delay set in 
the Energy Saver pane, or 
when you shut a MacBook’s 
lid. If yours won’t, this may 
result from a process 
preventing it. Open Activity 
Monitor, and add a column 
to the table of processes 
by ≈-clicking the column 
header row: select the 
Preventing Sleep item in 
the contextual menu, which 
helps to identify what’s 
preventing sleep, and then 
quit those processes.

222 Auto-start
Apps listed under Login 
Items in the Users & Groups 
pane open when you log in 
to your account. However, 
each Library folder can 
contain LaunchAgents and 
LaunchDaemons, XML files 
that control many periodic 
and background processes, 
and more, which are run 
automatically by the system 
launcher, launchd, and 
controlled at the command 
line by launchctl. Use Lingon 
(peterborgapps.com) or 
similar to manipulate them.

229 Stay smart
Use a tool such as DriveDx (binaryfruit.
com) or SMART Utility (bit.ly/1S7Kga9) 
to keep a watch on the SMART status of 
hard drives. Drives can still fail out of 
the blue, but this tech can give early 
warning and enable you to prepare by 
backing up and replacing them. You’ll 
need to install an extension to check the 
status of USB and FireWire drives, which 
OS X normally can’t monitor.

231 Hidden tools
The /System/Library/CoreServices 
folder and Applications within it contain 
valuable tools for solving problems: 
Archive Utility, with more compression 
and decompression options than Finder; 
Network Utility, with various graphical 
network tools, Wireless Diagnostics for 
testing Wi-Fi; and Network Diagnostics 
for general network testing. All but the 
last can be opened from Spotlight.

230 Use permissions
Don’t just leave disk, folder and file 
permissions at their defaults. They’re 
intended to protect your own files and 
folders, just as much as for system use. 
Select items to protect, press ç+I (or 
≈+ç+I for multiple files), then refine 
access under Sharing & Permissions. 
To control more subtle aspects, such as 
inheritance using Access Control Lists 
(ACLs), use MacPilot (koingosw.com).

232 Check tasks
Some of the tasks running on your Mac 
may be puzzling or suspicious. To check 
which are genuine or might result from 
adware or malware, use TaskExplorer 
(objective-see.com). It checks network 
connections, code signatures, and more, 
and returns a malware risk assessment 
from VirusTotal (virustotal.com). It isn’t 
a substitute for antivirus checks, but 
should form part of your protection.

242 Image type
When most disk images get 
backed up by Time Machine, 
the whole image is copied 
no matter how small the 
changes to it. Sparse bundle 
disk images start out small 
and grow as you add to 
them – Time Machine only 
backs up the changed parts 
to be more economical.
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225 Delete broken aliases To clear 
out aliases that are broken, TinkerTool 
System (£12.82, bresink.com) can find 
and delete them when you give it a 
volume or a folder as a starting point.
226 Hide folders Keep private 
documents from prying eyes by putting 
them in a folder in Documents, then 
enter in Terminal: chflags hidden, 
type a space, then drag the folder onto 
Terminal’s window and press ®. You 
can still use Finder’s Go > Go to Folder 
command to open the folder again.
227 Repeat keys If you don’t want to 
see accented key options when you 
hold a key, but want the key to repeat, 
enter in Terminal: defaults write -g 
ApplePressAndHoldEnabled -bool 
false then log out and in. To return to 
accents, replace false with true.
228 Lock keepers Protect important 
files from inadvertently being trashed 
by locking them when not being edited. 
Select them in Finder, press ç+I and 
put a check mark next to Locked under 
General. Attempting to trash locked 
files prompts for confirmation.



233 Complete backup
Keeping a complete backup of your 
startup volume enables you to get up 
and running as quickly as possible in the 
event of disk or other hardware failure. 
Time Machine is easy to set up and use, 
but takes a while to restore to another 
drive. You can use Carbon Copy Cloner 
(bombich.com) or SuperDuper! (shirt-
pocket.com) to periodically update a 
bootable copy of your system and apps.

235 Rotate backups
If you use your Mac in two or more 
places, such as home and work, and 
want to use Time Machine at each, 
click Select Disk in Time Machine’s 
preferences pane and add two volumes 
to use. When asked, opt to use both and 
not replace the existing disk. The first 
backup to each destination will be 
complete, after which it’s incremental, 
rotating through the list of disks.

234 Tune backups
Time Machine runs its automated 
backup service once an hour while 
your Mac’s awake. Adjust that in Time 
Machine Editor (timesoftware.free.fr) 
which takes over control of backupd, 
the background service which runs the 
backups. You can no longer change it 
manually in the com.apple.backupd-
auto.plist file as that’s protected by 
SIP, and so could break Time Machine.

236 Older backups
To browse backups made on another 
Mac, or on an old backup disk you filled, 
å-click Time Machine’s menu bar icon, 
(or ≈-click its Dock icon) and choose 
Browse Other Backup Disks to locate 
and select one, then click Use Selected 
Disk to browse it. If it’s on a network 
drive, you may have to manually mount 
the .sparsebundle disk image on the 
networked drive first.

245 FileVault
A Mac that could be lost or 
stolen, and which contains 
sensitive data, particularly 
that covered by the Data 
Protection Act, should be 
encrypted using FileVault. 
Turn this on in the Security 
& Privacy pane, and keep 
copies of the keys separate 
for recovery purposes.

246 Restore
Disk images are ideal for 
keeping a restorable image 
of a clean Mac configuration. 
To restore from a disk image, 
start in OS X Recovery, open 
Disk Utility there, erase the 
destination volume, select 
that volume, choose Edit > 
Restore, then browse to 
and choose the image.

244 Secure disk
Volumes on external hard 
disks and SSDs, and non-
bootable internal ones, can 
be erased to a format with 
encryption to store sensitive 
or personal data. In Disk 
Utility, select a volume, 
click Erase, and select 
OS X Extended (Journaled, 
Encrypted) as the format.

243 Images
When moving sensitive 
data and documents 
around, particularly those 
covered by the Data 
Protection Act, store them 
in encrypted disk images. 
When the image contains 
personal information 
protected by law, choose 
256-bit AES encryption.

30
0

 G
reatest ever M

ac tips

JUNE 2016 | MACFORMAT | 49 macformat.com  @macformat

237 Burn a CD/DVD Burning optical 
discs has been removed from Disk 
Utility, but still works just fine in Finder. 
Put files in a Burn folder, or select them 
all and choose File > Burn to Disc (or its 
equivalent in the contextual menu).
238 Burn DVD-Video Authoring discs 
in DVD-Video format isn’t possible on a 
new Mac since iDVD was axed, but Burn 
(burn-osx.sourceforge.net) can do it.
239 Test restore Never just assume 
that Time Machine backups are working 
okay. Every few weeks, enter Time 
Machine, browse through your backups 
and restore an old document and folder 
to check. Ensure you don’t overwrite 
any current work in the process.
240 Exclude virtual machines  
If you have virtualisation software, such 
as Parallels Desktop, add any virtual 
machines to Time Machine’s exclusion 
list or they’ll swallow much disk space.
241 File and folder shortcuts When 
working in Terminal, rather than type 
the full path to a file or folder as part 
of a command, just drag it from Finder 
and drop it on the Terminal window.



247 Mail drafts
In full-screen mode, new messages are 
created in a panel that’s displayed in the 
middle of the screen, and in El Capitan you 
don't have to save them as a draft to look 
at other messages. Clicking outside of the 
panel causes it to slide out of the way to 
the bottom. To get the composition panel 
back, click the small bar at the bottom.

257 Compress to email
If you’re sending a folder full of large files, 
you’ll want to compress them to save 
upload time for you, and download time 
for the recipient. In Finder, put the files in 
a new folder, ≈-click the folder (or right-
click it with a two-button mouse) and pick 
Compress in the contextual menu. A Zip 
file is then created alongside the folder.

248 Labelling in Mail
Mail shows your inbox by default, but if 
you organise your email in folders (or in 
Gmail’s case, by label) then clicking on the 
Mailboxes button in the top-left corner of 
the window shows them. You can create 
a new folder by choosing Mailbox > New 
Mailbox, then give it a meaningful name 
and choose where you want to put it.

258 Use Mail Drop
Mail Drop lets you send large attachments 
between 20MB and 5GB in size, even if the 
recipient’s server would normally reject 
them. In Mail’s preferences, click Accounts, 
select an account, click Advanced to the 
right, and turn on ‘Send large attachments 
with Mail Drop’. Recipients not using Mail 
will see the attachment as a download link.

249 Sort with a swipe
If you have a Mac with a trackpad, you can 
easily triage your emails with a swipe, 
much like you can on an iPhone or iPad. 
Put the pointer over a message and then 
simply swipe two fingers left to trash the 
message, or right to toggle the message’s 
read status. No trackpad? Press ∫ or 
ç+ß+u , respectively.

259 If Mail Drop fails
If you ever have trouble sending things 
with the Mail Drop feature, you can check 
the status of the service at apple.com/uk/
support/systemstatus; given how many 
things this page details, you may find it’s 
worth bookmarking. If you want to know 
more about Mail Drop’s limits, head over 
to bit.ly/droplimits for more tips.

250 VIPs in Mail
Mail has a VIPs mailbox that only includes 
your most important contacts, and it can 
notify you of only those messages. To set 
a contact as a VIP, place the pointer over 
their name at the top of a message, click 
the arrow to its right, then choose Add to 
VIPs. In Mail’s General preferences, set 
'New message notifications' to VIPs.

260 Send in iCloud Mail
You can use an iOS device to send large 
attachments via Mail Drop too, and the 
option is also open to you in iCloud Mail in 
a web browser. To send large files using 
iCloud Mail, click the cog below the sidebar, 
choose Preferences, then click Composing 
and turn on Mail Drop – now you can use it 
away from your Mac or iOS device.

Did you know?

261 You can ‘sign’ documents in Mail. Click the Sign 
button in the Markup toolbar and you'll be asked 
if you want to write your signature by hand, using 
your trackpad. The tool can also use your Mac’s 
camera to take a photo of your signature on paper.

262 As well as processing mail as it arrives on your 
Mac, you can set rules at iCloud.com to deal with 
any whose subject mentions viagra, say, before it 
reaches your devices. In iCloud Mail, click the cog 
at the bottom of the sidebar and choose Rules.

263 OS X’s Handoff feature lets you start writing 
an email on your iOS device and then switch to your 
Mac to attach a photo or file from there. Devices 
must use the same iCloud account, be on the same 
network, and be a model listed at apple.co/1I34axX.

264 If you get an error saying you can’t send using 
Mail Drop, go to iCloud’s preferences, click Options 
next to iCloud Drive, and put a check mark next to 
Mail in the list of apps that store data in iCloud. Mail 
Drop doesn’t actually use space on Drive, though.

Your Mac and its apps can do even more!
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251 Make a Smart Mailbox  
Choose Mailbox > New Smart Mailbox and 
enter a name – something like ‘Old mail’ 
to archive old messages, say – and set 
criteria messages must meet in order to 
appear in the mailbox – such as ‘Date last 
viewed is not in the last year’. Click OK 
and you’ll have a collection of messages 
you’re unlikely to read again.
252 Archive old mail ≈-click the Smart 
Mailbox you made in the previous tip, and 
pick Export Mailbox to save its contents 
outside of Mail. You can now delete the 
Smart Mailbox’s contents to clear out old 
messages, freeing space in your account. 
Use File > Import Mailboxes > Apple Mail 
and choose the exported MBOX file if you 
need to refer back to archived messages.
253 Process new mail You can use rules 
to process new mail as your Mac receives 
it. Create and name a new mailbox. In Mail 
> Preferences, click Rules then Add Rule. 

Set your conditions for processing 
messages, such as ‘If any’, ‘Any recipient’, 
‘contains’, and then list known addresses. 
In the actions section below, choose to 
move messages to your new mailbox.
254 Apply rules To apply rules to mail 
you’ve already received, select a mailbox, 
press ç+A to select all messages in it, 
then choose Message > Apply Rules.
255 Markup menu You can make quick 
annotations on images or PDF files that 
you attach to your emails. Put the pointer 
over the image or PDF attachment within 
your email and you’ll see a little arrow 
appear at the attachment’s top-right 
corner. Click on this and select Markup 
from the pop-up menu.
256 Annotations The Markup toolbar 
includes tools for adding text and shapes 
for annotating. The pen tool can be used 
for freehand sketches. Mail smoothes 
drawings to make them look better too!



270 Add Facebook events
You can add appointments from other 
popular services to Calendar – notably 
Facebook, but also Exchange, CalDAV and 
Yahoo. Choose  > System Preferences 
and click Internet Accounts, then click the 
+ button. Choose the account type and 
enter your credentials. With the account 
selected, put a check mark next to 
‘Calendars’ to add its events to Calendar.

265 Schedule events
To schedule an event in Calendar, just 
double-click anywhere on the calendar to 
add an event at that time. The Inspector 
window that appears allows you to add 
invitees, and set a time, location and more. 
Drag an event to reschedule it. Double-
click an existing event to edit it. The + 
button at the app’s top-left corner lets 
you create events using natural language.

276 Time a reminder
Place the pointer over a to-do you’ve 
created in Reminders and click the ‘i’ that 
appears to the right. In the box that pops 
up, put a check mark next to ‘On a Day’, 
then click the date for a mini-calendar. 
Simply choose the date to be alerted about 
the item, or choose ‘At a Location’ and 
then type an address or place name to be 
reminded when you’re there – or set both!

281 Battery checking
It's easy to check on the health of your 
MacBook’s battery by å-clicking the 
battery icon in the menu bar. Click on the 
status there for an explanation of how it’s 
doing (‘Normal’ is best). You can get 
additional information about how many 
charge cycles it’s been through (to aid a 
repair person, say) in  > About This Mac > 
Overview > System Report, under Power.

271 Attach files to events
You can attach a file directly to an event 
in Calendar (for example, a document to 
share at a meeting). Just drag and drop 
the file onto the event, or double-click 
the event, click Add Attachment, then 
choose a file. To preview an attached file, 
double-click the event, select the file, then 
press the Spacebar. To remove a file, select 
it as before, but press ∫ instead.

266 New calendars
By default, OS X includes two calendars: 
Work and Home. If you want to create a 
new one – say, to separately keep track of 
events for a social group you run – choose 
File > New Calendar and enter a name. For 
a list of all calendars you’ve created, click 
the Calendars button (top left). Use the 
checkboxes next to each of the calendars 
to decide which appear in the main view.

277 Drag/drop reminders
Double-click one of your Reminders lists to 
open it in another window. You can drag a 
reminder from one list to another this way 
(or by dragging to a list name on the left) 
by clicking in the space after its text but 
before the ‘i’ to the right (note the change 
of cursor). This is useful if Siri on your iOS 
device defaults to a particular list that 
happens to be the wrong one for an item.

282 Better resolutions
Switching screen resolutions is easy 
enough in System Preferences > Displays, 
but a far more flexible switcher is EasyRes 
(£5.99, Mac App Store). It can run in both 
the menu bar and Notification Centre, and 
provides live previews of how much space 
windows will use at different resolutions. 
It’s very handy when you quickly need 
more desktop space on a Retina display.

272 To set up a repeating event, double-click (or 
force click) the event to view its details, then click 
the date. Click the Repeat pop-up menu, then pick a 
frequency. To set the event to repeat on a schedule 
not listed, such as on specific days, choose Custom.

273 You can view your entire schedule based on a 
different time zone than your Mac’s location, and 
set individual events to use a different one. Go to 
Calendar > Preferences > Advanced and turn on time 
zone support. Switch zone next to the search bar.

274 Calendar’s travel time option only calculates 
times for driving or walking, yet Maps also includes 
transit info that shows routes and times for public 
transport (see bit.ly/AppleMapsTransit). If you don’t 
drive, look up this info in Maps before you leave.

275 To turn an email into a reminder, drag and drop 
it from Mail onto a list in Reminder’s left pane or a 
blank space in the list on the right. The reminder 
will display a ‘Show in Mail’ link, which opens the 
full original message in Mail.
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267 Change calendar colour 
To change the colour or name of a 
calendar, select it in the calendars list, 
then choose Edit > Get Info. To remove a 
calendar and all of its events, ≈-click it 
in the list on the left and choose Delete 
from the contextual menu. You can 
share calendars with other Apple device 
and iCloud users from this menu too. 
268 Use the Inspector The Inspector 
helps you fill out your events using 
autocomplete. Start typing an address 
and Calendar suggests matching places. 
Start typing the name of a contact in 
your address book and the app suggests 
matching names based on people’s and 
companies’ details you've added to the 
Contacts app.
269 See event locations You can see 
an event’s location on a miniature map 
in the Inspector. Click it to open a full- 
size view in the Maps app. The mini-map 
shows estimated travel time to your 
appointment, and the weather there.

278 Sort reminders  
Choose a sort order (due date, priority, 
creation date or alphabetically by title) 
in View > Sort By. There’s a manual 
option too, but you needn’t choose it: 
drag an item up or down and Reminders 
switches to that sort method for you.
279 Manage subscriptions Not sure 
whether Apple Music or a digital mag 
subscription will renew automatically? 
Simply click your name in iTunes (next 
to the search bar), choose Account Info, 
then sign in and click Manage next to 
Subscriptions at the bottom.
280 Two-factor authentication  
Since OS X 10.11.4, iCloud’s two-factor 
authentication feature is available for 
all accounts. This security layer ensures 
only you can access your account by 
requiring your password and a trusted 
device. Set it up in  > System Prefs > 
iCloud > Account Details. If you’ve enabled 
two-step verification before, you may need 
to turn it off first at appleid.apple.com.

 macformat.com  @macformat



288 Font collections
As an admin user who uses the Font Book 
app to install new fonts on your Mac, you 
may want to change a preference for the 
app so that those fonts are made available 
to other user accounts on the computer, 
not just your own – so your kids can make 
use of them for design work, say. In the 
app’s preferences, change the default 
install location from User to Computer.

283 Default camera app
Want to open an app other than Photos 
when you connect your camera or an iOS 
device? Open Image Capture (found in the 
Applications folder), select the device in 
the left pane, then click the triangle in a 
rectangle at the bottom-left corner of the 
window if you don’t see an option labelled 
‘Connecting this <device> opens…’ there. 
Open that pop-up menu and pick an app.

294 Speak to Spotlight
In System Preferences’ Dictation pane, 
turn on Enhanced Dictation, then go to the 
Accessibilty pane, select Dictation and turn 
on the keyword phrase. Click the Dictation 
Commands button and enable advanced 
commands. Now say something like, 
“Computer, search Spotlight for emails 
from Christian”. Note that you can even 
personalise the keyword phrase.

299 Multiple libraries
Photos and iTunes let you create and 
switch between multiple libraries: hold å 
while opening them. This is helpful if your 
collection exceeds iCloud Music Library’s 
100,000-track limit or you don’t want 
every photo to go to iCloud Photo Library. 
Only one local library can be set as your 
System Photo Library (in Photos’ prefs), 
which is the one that uploads to iCloud.

289 Fonts for everybody
Text formatting tools in Pages and other 
apps provide access to all available fonts. 
If that list is uncomfortably long, consider 
using the Fonts window instead, which is 
revealed in many apps with ç+D. In it (or 
Font Book), make a collection in the left 
column, drag families or typefaces from 
the right onto it, then select the collection 
to work with just the fonts you need.

284 With multiple cams
If you have more than one camera, such as 
an iPhone and a DSLR, and you use Image 
Capture to import from them to a folder on 
your Mac, connect and select a camera on 
the left, then open the Import To pop-up 
menu and choose ‘Make subfolders per 
camera’. Importing then creates a folder 
based on the camera/storage card name in 
whatever folder you choose in that pop-up.

295 Open an app
There’s no guarantee entering an app’s 
name in Spotlight will list it above other 
results. Launchpad is more reliable: recent 
Mac keyboards have a dedicated key in the 
top row to open it. On others, set up a key 
combo in the Keyboards pane > Shortcuts 
> Launchpad & Dock. In Launchpad, type 
an app’s name, select a match using the 
arrow keys, and press ® to open that app.

300 Secure keychain notes
In OS X 10.11.4, Notes lets you protect items 
with a password, but all such notes share 
the same one – not so good if Notes syncs 
to iCloud and then to a shared iOS device 
on which you’ve allowed Touch ID to unlock 
them. For things you want to keep private, 
open Keychain Access, click the iCloud 
keychain (if you want it on all of your 
Macs), then pick File > Secure Note Item.

290 If you watch videos in iTunes with subtitles but 
dislike their style, go to Accessibility preferences, 
select Captions on the left, then choose a preset or 
click + to pick a font, colour, size and background, 
and to stop videos overriding your choices.

291 Though Maps works best with a trackpad, it has 
mouse and keyboard shortcuts for the camera: 
å+“ and å+‘ rotate the map, and ç+… 
resets to facing north. Hold the mouse button and 
drag up or down to change the angle of elevation.

292 To try out several fonts at once, open Font 
Book and choose View > Custom. Click the sample in 
the right pane and type some words, then ç-click 
whole families or individual typefaces in the middle 
column to see how your words look in all of them.

293 Archive Utility (/System/Library/CoreServices
/Applications) provides smart behaviours for 
archiving files, such as trashing originals and where 
archives are created when you drop things onto it. 
To archive multiple items, first put them in a folder.

285 Extract a frame in QuickTime 
Rather than go through the rigmarole 
of importing a video into iMovie, say, to 
extract a single frame, import the video 
from your iPhone using Image Capture, 
then open it in QuickTime Player 10, find 
the frame you want, press ç+C, open 
Preview and press ç+n to paste it as a 
new image. Choose File > Export to save 
the photo. If you’re working with a 4K 
video from an iPhone 6s, say, this will 
give you an 8-megapixel photo.
286 Adjust colours in Preview 
Photos you’ve extracted from a video 
may look less nice than those taken with 
a filter app. Choose Tools > Adjust Color 
for a set of basic adjustments similar to 
those available in the Photos app.
286 Share on a social network 
Once you’ve improved a pic’s look, post 
it from Preview to Facebook or Twitter 
(if signed in through System 
Preferences > Internet Accounts) using 
the Share button in the app‘s toolbar.

296 Mute noisy conversations  
If a conversation in Messages distracts 
you with a swarm of notifications at 
the corner of the desktop, rather than 
turning on the Do Not Disturb feature 
of Notification Centre, which mutes all 
notifications, open the conversation, 
click Details at its top-right corner, and 
put a check mark next to Do Not Disturb 
here to mute only this conversation.
297 Mute unknown senders  
If you’re making use of OS X’s capability 
to receive and send SMS and MMS 
messages through your iPhone (when 
it’s nearby), make sure ‘Notify me about 
messages from unknown contacts’ in its 
General preferences is disabled, so you 
don’t get unwanted notifications from 
marketers on your Mac as well.
298 Text size adjustments  
Pressing ç++ or ç+- tweaks the 
text size in Messages, and your choice is 
remembered. You can also change the 
font in the app’s General preferences.
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 Understand iOS gestures

EDITED BY ALAN STONEBRIDGE 

What’s inside 

54–55 
BROWSE THE 

WEB IN PRIVATE
 Keep online activity 

under wraps to avoid 
spoiling family surprises 

56–57  
MAKE YOUR 

OWN EBOOKS
 Use Apple’s free tool 

to make great-looking 
books with interactivity

58–60  
MAKE YOUR OWN 
CLOUD STORAGE
 The cloud is really just 

an online server, so you 
can make up your own

62–63 
NEW FEATURES 

IN iOS 9.3
 Discover Night Shift 

and other new features 
for iPhone and iPad

64–65  
MASTER 

AFFINITY PHOTO
 Make your landscape 
photos look stunning 

with a graduated filter

66–69 
ADD AIRPRINT TO 

YOUR PRINTER
 Add wireless printing 
for your Mac, iPhone 
and iPad at low cost

 When you see a shortcut like 
ç+å+C, hold all but the 
last key, then press that one.

 ç is the Command key, 
which is also labelled cmd.

 å means the Option key, 
labelled alt or opt.

 ≈  means the Control key, 
labelled ctrl, and shown as ^ 
in shortcuts in the menu bar.

 ß  is the Shift key, which is 
typically just labelled shift.

 ∫  means the Delete key, 
which deletes to the left of the 

insertion point. Press ƒ+ ∫ 

to delete to the right.

 † is the Tab key, which shifts 
the focus between some 
controls in windows and web 
forms. Turn on Full Keyboard 
Access in System Preferences 
to jump between all controls.
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 Master Mac keyboard shortcuts

 A tap is a brief contact of 
(usually) one finger on your 
device’s screen.

 To drag is to move a finger 
across the screen to scroll 
or pan around content.

 Swipe means move one or 
more fingers across an item 
or the screen, then let go. 
 
 A flick is like swiping, but it’s 

quicker, and is often used to 
scroll content more quickly.

 Pinch means move two 
fingers together or apart, 
usually to zoom in or out.

 Touch and hold means lightly 
rest your finger on an item 
and wait for a reaction.

Your new-look guide to 
getting more from 

your Apple kit

NEW 
IDEAS

DISCOVER 
WHAT’S NEW 

IN iOS 9.3
p62



If you buy 
gifts for your 
family online, 
you can hide 
that activity 
from them

1

Shortcuts
 In View > 

Customize 
Toolbar, you can 
add buttons for 

your browsing 
history and 

favourite sites.

2

Show all tabs  
This displays all 

the open tabs 
from the current 
Safari window as 
thumbnails, and 

tabs left open on 
your iOS devices.

2
3

3

Private 
browsing   
Any activity in 
a Safari window 
whose address 
bar is dark grey 
isn’t recorded 
on your Mac. 
This includes 
any files you 
download, which 
are omitted from 
the browser’s  
Downloads list. 

1

APPLE SKILLS Mac Software
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Browse the web in private
Keep your online activity under wraps to avoid spoiling family surprises

IT WILL TAKE
 30 minutes

YOU WILL LEARN
 How to cover your 

tracks when you 
browse the web 

in Safari on a Mac

YOU’LL NEED
 Safari 9

If you share a Mac with other 
people at home or at work, or 
particularly if you regularly step 
away from your Mac without 

logging out, your web browsing habits are 
easily discoverable. For most of us, most of 
the time, that’s not a problem. However, if you 
use the web to search for and buy gifts for a 
family member, or you indulge in personal 
browsing on a work-owned computer during 
breaks, you may want to keep that activity 
hidden from other people’s sight.

Until relatively recently, that just meant 
deleting the browser’s History cache, but now 
there’s more to think about, both in terms of 
how your web browser responds to your 
activity and extra ways to keep your browsing 
private. For example, if you use an iPhone or 
an iPad in addition to a Mac and you’re logged 
into iCloud on all your devices, sites you visit 
on one of them are visible on the others linked 
to your account. Also, modern browsers learn 
about what sites you visit regularly and use 
that data to display ‘favourite’ and frequently 
visited sites, or to autocomplete addresses.

Keeping browsing private, then, isn’t just 
a matter of deleting pages from your history 

any more; you need to make sure the browser 
and your account forget you ever visited the 
web pages in question.

A silent witness
There’s another problem to consider in the 
form of tracking. You’ll have noticed that when 
you research a new purchase online, you seem 
to be pursued endlessly by adverts for the 
very products you’ve been investigating. 
That’s because your browser stores ‘cookies’, 
which track the pages you’ve visited, and that 
information is then used by advertisers to 
decide what adverts to show you. The last 
thing you want a week before your partner’s 
birthday is for an advert for the gift you’ve 
carefully researched to pop up while they’re 
using your shared iPad, or while looking at 
something together from your Mac account.

If dealing with all that sounds like too much 
trouble, there’s another option. Safari, Chrome 
and many other browsers feature a mode 
where nothing you do and none of the sites 
you visit are recorded. By enabling that mode 
before you start surfing, you ensure that none 
of the pages you visit are stored locally and 
you won’t be tracked. Kenny Hemphill



1 Start Private Browsing
In Safari, choose File > New Private Window. 

A new window with a dark grey address and 
search field will open. None of the sites you 
visit in this window will be remembered, and 
websites will be asked not to track you. 

2 Close iCloud Tabs
Left a page open on another Mac or iOS 

device that uses your iCloud account? Click the 
‘Show all tabs’ button in Safari’s toolbar, then 
scroll down to iCloud Tabs, put the pointer over 
the one to close, then click the ‘x’ next to it.

3 Clear a period from History
To cover up a large amount of activity, 

choose History > Clear History, then choose a 
duration. When you click Clear History, sites 
visited, cookies and cached data from that 
period are cleared from your Mac and iCloud.

4 Clear specific History items
To clear the record of a specific page, 

choose History > Show History, then hold ≈, 
click on the page’s row and choose Remove. 
To clear several at once, hold ç and click each 
in turn to select them all, then press ∫.

5 Clear a site’s cookies
In Safari > Preferences, click the Privacy 

tab, then the Details button halfway down the 
window. Scroll through the list of sites to find 
the one you want (or enter part of its name in 
the search box), select it, then click Remove.

6 Hide frequently visited sites
Safari’s Favorites view shows sites you visit 

often as well as those you’ve explicitly added to 
it. To remove one of them, ≈-click its icon and 
choose Remove, or just drag its icon out of the 
group until the pointer shows an ‘x’, then let go.

Genius Tip!
 The ultimate way to 

cover your tracks is to 
use your Mac’s guest 
account. Everything you 
do in it is deleted when 
you log out of it.

Jargon Buster
 Do Not Track (‘Ask 

websites not to track 
me’ in Safari‘s Privacy 
preferences) is a 
request made by a web 
browser to sites you 
visit, asking them not 
to track you. It’s up to a 
site whether it complies.

Cover your tracks online APPLE SKILLS
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 HOW TO Use Safari’s privacy protections 
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iBooks Author 
is surprisingly 
sophisticated, 

and works a 
lot like Apple’s 

iWork apps

1Choose a template
The Template Chooser makes layout 

decisions extremely easy. If you want an 
easy life, just pick a template that you like  
the look of – for horizontal or portrait 
layout – and add your content to it. You 
can adjust almost anything about it.

2The Blank template
Alternatively just pick the ‘Blank’ 

template to get the kind of empty page 
starting point you get in professional 
desktop publishing tools. Choose this if 
you want to create layouts from scratch, 
though we’ll work with a template.

3Add a cover design
Begin with your book’s cover, called 

Book Title on the left. This will be shown 
in your iBooks library and on the iBooks 
Store, so make it look good small as well 
as large. Add an image, then enter and 
format a title (View > Show Format Bar).
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Make interactive books
Use Apple’s free authoring tool to make your own great-looking iBooks

IT WILL TAKE
 30 minutes

YOU WILL LEARN
  How to make ebooks 
rich with interactivity.

 
YOU’LL NEED 

 iBooks Author, 
iBooks, and some 

media files.

Want to be a published author? 
Apple’s iBooks platform is 
fantastic for digital publishing, 
and its iBooks Author app is a 

surprisingly good tool for creating beautiful 
interactive books. Unlike basic Kindle-style 
ebooks, iBooks Author lets you create proper 
page layouts with beautiful typography and 
enhance the pages with a range of interactive 
media tricks. It’s free, and so is publishing to 
the iBooks Store. You can keep your creations 
to yourself, but once you’ve completed our 
tutorial and produced your first rich-media 
masterpiece, why not share it with the world?

iBooks Author will feel familiar to anyone 
who’s used Pages, Keynote or even Numbers. 
In fact, you can even import Pages and 
Keynote documents directly into an iBook 
document. But before you begin, the first 
thing to do is sketch out a plan. Seriously, get 
a pencil and paper and scribble out your ideas, 
then gather your media: photos, movie files, 
audio clips, and any writing you’ve done.

The structure of an iBook is quite 
straightforward. Everything is arranged in 
chapters, each chapter has one or more 
sections, and each section can have one or 
more pages. Every one of these – chapters, 

sections and pages – can be set to use one of 
a range of ready-made templates or, for 
pages, you can use blank ones and build things 
yourself if you prefer, and make your own 
templates. It’s a fairly foolproof system, as 
long as you work with it rather than against it.

Books with a special touch
What makes iBooks Author really interesting 
are its ‘widgets’. These are ways of adding 
content that’s more interactive to your pages, 
from slideshows and movies to multiple-choice 
quizzes, embedded Keynote presentations, 
and even custom HTML content. Widgets can 
be played ‘inline’ in the layout or set to open 
full-screen, hiding the rest of the page as they 
do. The one point to remember is that they 
show a preview image until they’re touched, 
and only then do they become active.

If you want more than the standard set 
of widgets, take a look at bookry.com and 
bookwidgets.com. Both sites have extensive 
libraries of widgets, many of them free. 
Alternatively, you can create widgets from 
scratch to serve your exact needs. To get 
started with this, you only need basic HTML 
skills and some information provided by Apple 
on how to package things. Keith Martin

 HOW TO Make interactive digital books 
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CONTINUED… Make interactive digital books  

4Add an intro video
The ‘Intro Media’ stage, listed on the 

left, is optional. It plays a video when the 
book is opened. Use the Media palette to 
browse your videos, or drop one into this 
page directly. When this video ends, the 
first chapter is automatically shown.

5Add pages to your iBook
Under Insert > Pages, pick a template 

and add media to it. Text boxes are linked 
so that words flow from one to the next. 
Under Insert > Insert Chapters From, you 
can add text from Pages or Word docs or 
whole layouts from InDesign IDML files!

6The Media widget
The Media palette enables you to 

browse and add items from your Movies 
folder, or you can just drag a video from 
Finder into your book to add it as a 
‘Media’ widget. Use the Preview icon in 
the toolbar to check your work in iBooks.

7The Keynote widget
Click Widget in the toolbar, choose 

Keynote, then click the rightmost icon at 
the top of the Inspector to choose your 
Keynote file. Almost anything that works 
in a presentation played in Keynote itself 
will also work within an iBook.

8Create a custom widget
How about adding a map to your 

book? We’ll use bookry.com to make one 
of these. Sign up on the site, then go to 
My BookShelf and start a new ‘book’ to 
store your work in your Bookry account. 
Click Add Widget and pick Google Maps.

9Configure the widget
In Google Maps, click the menu icon 

(three lines) and choose ‘Share or embed 
map’. Copy the code under Embed Map 
and paste it into Bookry’s Google Maps 
Link field. To the left, ‘Freeform’ sets your 
widget to a specific size on a page layout.

10Use it in your iBook
Click Save & Preview to check the 

map widget’s appearance, then download 
it, unpack the Zip archive, and drag the 
widget file into your iBook. It’s branded 
with the Bookry logo unless you pay to 
remove it or write your own widget.

11Roll your own widgets
It turns out that writing your own 

widgets isn’t all that hard; basic HTML5 
skills are really all you need. Make a web 
page that displays what you need, such 
as a map, then use the guide at bit.ly/
ibookshtml to turn it into a widget.

12A new perspective
Some third-party media tools have 

started supporting widget production too. 
If you have a 360° camera such as the 
Ricoh Theta, Pano2VR has a widget-
making template (bit.ly/360widget) for 
embedding 360° panoramas in iBooks.
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If you want a 
fully functional 

alternative to 
Dropbox or 

iCloud Drive, 
try ownCloud
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Create a personal cloud
Set up remote access to your files and add personal cloud services

IT WILL TAKE
 45 minutes

YOU WILL LEARN
 How to set up  

Back to My Mac 
and ownCloud.

YOU’LL NEED
  An AirPort Extreme 

with a USB drive, or an 
AirPort Time Capsule, 

or a NAS or Raspberry 
Pi 3 running ownCloud.

Anyone who’s used iCloud 
Drive, Microsoft OneDrive or 
Dropbox will know the many 
benefits of cloud storage. 

Firstly, your data is stored remotely in another 
physical location, protecting it should your 
Mac be damaged or stolen. Secondly, cloud 
storage makes it easy to keep files in sync 
between all of your computers and mobile 
devices, giving you convenient access to them 
wherever you happen to be.

There are drawbacks too, though – if you 
have a lot of data to back up, you may end up 
paying an expensive monthly subscription to 
retain access to it. There’s also the question of 
trusting a third-party provider – how long will 
they provide the cloud storage for, and is your 
data safe and secure in its hands?

If you’re tempted by the pros, but put off 
by the cons, setting up your own personal 
cloud storage system is the answer. If you 
have an AirPort Extreme or AirPort Time 
Capsule router, the Back to my Mac feature 
provides a decent solution to keeping your 

files accessible wherever you happen to be. 
If you want to replicate the feature set of 
iCloud and its ilk, you can build your own cloud 
using a network attached storage (NAS) drive 
or the versatile Raspberry Pi. Your data won’t 
be stored offsite, but you can keep it stashed 
away somewhere relatively safe (under the 
stairs or in your attic, say), giving you full 
control over how far your data can travel and 
who can access it. Read on to find out how.

The Apple solution
Our first approach may appeal if you own an 
AirPort Extreme or Time Capsule. This won’t 
give you all the features of the cloud in your 
personal system, but you’ll be able to attach 
a USB hard drive to your router and make it 
available as a central location for backups 
(using Time Machine), and you can set up 
shared folders for other purposes. By default, 
access is restricted to your local network, but 
by enabling the Back to My Mac feature, you 
can gain secure access to your files over the 
internet too from other trusted Macs.
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Genius Tip!
 In ownCloud’s web 

interface, select admin > 
Admin, then ‘Server-
side encryption’ to add 
extra protection to the 
files on your server.

Jargon Buster
 NAS stands for 

Network Attached 
Storage, and refers to 
hard drives that are 
connected directly to 
your network using 
an Ethernet cable.

1

2

3

4

1

Sync markers
 Look out for 

the handy icons 
next to files and 

folders, which 
indicate their 

sync state with 
your server.

3

Client settings
 These buttons 

alter the client’s 
options, such as 
whether or not it 
starts up when 
you log in.

2

Configure 
ownCloud

 Click ownCloud’s 
menu bar icon to 

access server and 
client settings, 
and to review 

recent changes.

4

Detailed 
overview
 The main view 

lets you browse 
your sync folder 
in greater detail, 
and switch 
user accounts.

EXPLAINED… The ownCloud client app 
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We covered the process of sharing folders 
over the internet using an AirPort Extreme 
router back in MF293, but here are the basic 
steps you need to follow: first, open System 
Preferences and click iCloud, scroll down the 
list of services, put a check mark next to ‘Back 
to My Mac’ and wait. If your firewall throws up 
a warning, make sure you give Back to My Mac 
the access it needs. Once done, you’ll be able 
to access that Mac’s drive whenever you’re 
signed in to your iCloud account on another 
Mac with internet access. Just enable the 
feature on all your Macs and you’ll be able to 
access any of them securely when required.

Back to My Mac also works with any USB 
hard drive connected to your AirPort Extreme 
router, as well as the internal drive of a Time 
Capsule. The drive needs to be formatted with 
Apple’s OS X Extended file system. This will 
wipe the drive, so back up its contents first. 
Next, connect it to your Mac, open Disk Utility 
and format the drive using the recommended 
OS X Extended (Journaled) option, and then 
connect it to your AirPort Extreme router.

Open AirPort Utility (from /Applications/
Utilities), click your router’s icon in it, and click 
Edit in the pop-over. In the Base Station tab, 
link Back to My Mac to your Apple ID (you can 
link it to multiple IDs if you want). Next, switch 
to the Disks tab and put a check mark next to 

both ‘Enable file sharing’ and ‘Share disks over 
WAN’ to allow access over the internet, then 
choose ‘With accounts’ from the ‘Secure 
Shared Disks’ pop-up menu. Click Update and 
choose to restart the router. Once done, you 
should have access to the disks over the 
internet through Back to My Mac.

A full-blown cloud solution
If you want a fully functional alternative to the 
likes of Dropbox and iCloud Drive, you’ll need 
to explore an alternative method: ownCloud 
Server (owncloud.com). This open-source 
software solution offers the same features as 
cloud storage, but your data is stored inside 
your own network on a file server, so there 
are no subscriptions to pay and you retain 
complete control over who gets to access it.

You’ll have to pay upfront for your file 
server, which can either be a NAS drive that 
supports ownCloud, or a PC running Linux. 
If you go down the NAS drive route, Zyxel and 
Synology drives support ownCloud – just make 
sure you purchase a model with enough 
processing power to run it efficiently. Zyxel’s 
NAS520 (£110, plus the cost of hard drives) 
is a reasonable entry-level model, but if you 
want maximum performance, try Synology’s 
LinkStation DS216+ (£240, plus the cost of 
drives – see review in MF299) instead.
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Jargon Buster
 If you plan to use your 
ownCloud server over 

the internet, set up 
a free static address at 

noip.com/free to ensure 
you can reach it.

1Access the admin tool
Open a web browser on your Mac and 

enter 192.168.x.y/owncloud in its address 
bar, substituting 192.168.x.y with the IP 
address or hostname of your NAS drive 
or Raspberry Pi. Click Continue if you’re 
prompted about the address’s identity.

2 Set up administrator
Provide an administrator username 

and password, then expand ‘Storage & 
database’ and choose the MySQL option 
for faster file transfers, if it’s available. 
Set up a database, a username and a 
password, then click ‘Finish setup’.

3 Set up a regular user
Clear the first screen, then choose 

‘Users’ from the ‘admin’ pop-up menu. 
Enter a username and password, then 
click Create. Click the pop-up menu in the 
Quota column, which says Unlimited, to 
cap a user’s storage if you require that.

 HOW TO Set up ownCloud 

4 Log in as a user
Click admin > Logout. Now log in as 

the user you just created to set up your 
personal storage space through your 
web browser. Start by clicking the link to 
download and install the client software 
on your Mac.

5 Set up client
Launch the app and enter the 

address for your ownCloud server. Click 
Next, trust the certificate that’s shown, 
log in with your user details, and then 
choose what to sync, and which folder 
on your Mac to sync it to.

6 Browser configuration
Explore the options given for your 

personal user profile through the web 
interface – you can tweak your profile 
(using the username menu), access files 
through the browser, and even recover 
deleted files too.
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If your budget doesn’t stretch that far, 
then consider pairing a USB hard drive with 
the inexpensive Raspberry Pi 3 – a starter 
kit costs about £50 from thepihut.com, 
including a case, cables, a power adapter 
and a MicroSD card preloaded with NOOBS. 
The Pi 3 has a quad-core 1.2GHz processor, 
which should provide decent performance.

You then need to install ownCloud on your 
file server. NAS users need to install it from 
their drive’s package manager. Version 7.0.4 
is provided with Zyxel drives, but LinkStation 
owners first need to add the SynoCommunity 
repository – see synocommunity.com for info. 
Installation on Pi is less straightforward, but if 
you follow the guide at bit.ly/owncloudpi you 

should have few problems. To avoid issues 
with access permissions on the Pi, make sure 
you format the USB drive in ext3 format.

Sync your files
Once ownCloud is installed, the step-by-step 
guide below walks you through the key steps 
in setting up the server, as well as downloading 
the client on your Mac, which makes it easy 
to set up and manage the syncing of folders. 
It’s pretty straightforward, but refer back to 
the annotation on the previous page, which 
reveals some useful tips and tricks. You can 
also install the free ownCloud app on your 
iPhone, iPad or Android device to get access 
to your files on those too. Nick Peers 
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Make perfect landscapes
Overcome the challenges of tricky landscape exposures in Affinity Photo

IT WILL TAKE
 About an hour

YOU WILL LEARN
 How to work with 
masks, graduated 
overlays, and the 
Develop persona.

YOU’LL NEED
  Affinity Photo

Landscape photography is hard 
to get right. Getting a balance 
between composition and light to 
create unique images is tough 

enough, and that’s before you start spending 
big money on posh lenses and filters to try to 
make your images stand out.

One big problem landscape photographers 
have is the big difference in brightness that 
scenes often exhibit. Even on days with blue 
skies, the top part of an image can often be 
extremely bright relative to the ground in the 
bottom part of a shot. That means if you set 
your camera to provide the correct exposure 
for the sky, you can end up underexposing the 
ground beneath, but if you set your exposure 
to get the foreground correct, you can end up 
overexposing the sky instead.

Balancing exposure is hard, which is why 
many professionals opt for a graduated filter. 
This handy sliver of glass is translucent at the 
bottom and dark at the top, with a graduation 
in between, so the bottom part of an image 
exposes faster than the top part, allowing you 

to get exposure levels right for both areas. 
A really good set of these filters can cost 
about £200, and they’re fiddly, needing to be 
repositioned with each composition change. 
If you snap landscapes only occasionally, 
there’s a digital solution that takes seconds 
to apply, yet it can make a huge difference.

Doing it digitally
A digital graduated filter works the same way 
as a piece of glass over your camera’s lens. 
The ‘graduated’ part means blending the 
difference in exposure gradually, avoiding a 
sudden transition between the two areas.

Affinity Photo gives you nearly limitless 
control over graduated filters. Here we’ll use 
a series of adjustment layers to get our sky 
looking right, then use a graduated layer 
mask to blend our corrected colours with the 
unaltered foreground beneath. The app’s own 
file format preserves layers, adjustment layers 
and layer masks, so you’ll be able to revisit 
your file and make adjustments until your 
image looks its very best. Dave Stevenson

1

2

3
4

1

Think pink
 Pink overlays 

show the bits of 
your image that 
will be affected 

by your changes 
in Affinity Photo’s 
Develop persona.

3

Take control
 Until you leave 

the Develop 
persona, you 
can move the 
overlay by 
dragging the 
handles at 
either end of it.

2

Basic edits
 These tools are 

normally used 
for initial editing. 

You can use a 
graduated overlay 

to control where 
edits show up.

4

Experiment
 This type of 

filter is usually 
applied to 
landscapes, but 
it can help with 
many other 
image types.

EXPLAINED… How a digital graduated filter works 

3
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1Developing agent
One way to set a graduated filter is to 

use a series of adjustment layers, then 
put a layer mask over the top, which 
allows later alteration. We’ll use a method 
that can’t be changed after saving, but is 
faster. Switch to the Develop persona.

2Get the foreground right
Before you go further, get the pic’s 

foreground ready, including saturation 
or exposure tweaks. Once you leave the 
Develop persona, any changes you make 
will affect the entire image, so get the 
foreground looking how you want.

3Create an overlay
Press g to select the Gradient tool. 

Drag downwards from the top-centre of 
your image and you’ll see a red overlay 
that fades at the bottom. For our image, 
we’ve dragged until the overlay’s bottom 
rests on the foreground’s top edge.

4 Fix exposure
In the panel on the right, select the 

Basic tab and click on the main Exposure 
slider at the top of that tab. As soon as 
you start dragging it left to reduce the 
exposure in your image, you’ll see the top 
part of your image start to change.

5Saturate weak colours 
The main problem with this image 

is saturation – the sky isn’t blue enough 
to do the scene justice. Further down the 
Basic tab, drag the Saturation slider right 
to embolden the colours in your image. 
A tug on Vibrance can work wonders too.

6Go easy on adjustments
If your changes start to look a bit 

dramatic, it’s often worth dialling them 
back. Edits that look great on a glossy 
screen can look silly in print – you’re 
aiming to perfect your image, not make 
it unrecognisable from the original.

7Move the gradient
As long as you’re in the Develop 

persona, you can change your gradient. 
Click the control blob at its top, say, and 
you can drag the gradient overlay side to 
side – useful if, as here, you’ve got bright 
white clouds towards a shot’s corner.

8New gradient overlays
In the Overlays tab, click the Add 

Gradient Overlay icon (bottom-right). 
This will create a new gradient on top of 
your first one, allowing you to infinitely 
fine-tune your edit. Each gradient you 
add is listed here – click one to change it.

9 Fear of commitment
Got it right? Click the blue Develop 

button near the top-left corner of the 
window and your changes will be saved; 
you can’t go back and change them now, 
but you can still work on your image with 
Affinity Photo’s normal tools.

 HOW TO Create a graduated filter 
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Night Shift 
counteracts 

the disruption 
caused by blue 
light from your 
device’s screen

1 Set a colour temperature
As you adjust the slider in Settings > 

Display & Brightness, the screen’s colour 
previews how things will look when Night 
Shift kicks in. The difference will seem 
extreme at first, so give yourself a couple 
of days to adjust before changing this.

2 Schedule Night Shift
Night Shift is usually active between 

sunset and sunrise, or you can tell it to 
switch on between times you want: turn 
on the Scheduled switch, tap the From/To 
row, select Custom Schedule, then dial in 
your desired times below that.

3Manually enable it
As you adjust to using Night Shift, 

you may find things are harsh to look at 
ahead of sunset or your scheduled start 
time. Though you can manually turn it on 
in its Settings page, there’s a shortcut in 
Control Centre to save you going there.
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Use new features of iOS 9.3
Discover the improvements Apple just made to your touchscreen device

IT WILL TAKE
 20 minutes

YOU WILL LEARN
 How to use the key 
features introduced 

or improved in the 
latest version of iOS.  

YOU’LL NEED
 iPhone 4s or newer, 

iPod touch (5th or 
6th generation, or an 

iPad 2 or newer.
OS X 10.11.4 (optional).

Don’t be fooled into thinking 
that iOS 9.3 has little to offer 
on the grounds of its relatively 
small bump in version number. 

Yes, it fixes and tweaks some existing features, 
but it also adds some significant new ones to 
your iPhone, iPod touch or iPad as well.

Its headline feature is Night Shift, which 
reduces the amount of blue light emitted by 
your device’s screen. Research says this kind 
of light disrupts your circadian rhythm and 
your sleep quality. The idea of counteracting 
this has been around for a long time – on the 
Mac, in the form of f.lux (free, justgetflux.com). 
Learn how to use Night Shift in iOS below.

If you have an iPhone 6s or 6s Plus, more 
of iOS’s built-in apps offer 3D Touch shortcuts 
when you press firmly on their Home screen 
icons. The most notable of these is Settings, 
which provides shortcuts to its Battery, Wi-Fi 
and Bluetooth pages. The App Store now has 
an Update All action that takes you directly 
to its Updates page and starts downloading 
whatever is available – though we’ve found 
that sometimes that process fails to start. 

Apple’s ebook reader, iBooks, now plays 
nicer with things in ePub or PDF format that 
you’ve bought from places other than the 

iBooks Store. The app can now sync those 
items between all of your devices over iCloud. 
However, you still can’t annotate PDFs, so you 
may prefer to stick with an app such as PDF 
Expert (£7.99, readdle.com) if you need that.
You’re now able to redownload your past 
purchases of audiobooks, and they’re eligible 
for Family Sharing too (see MF297).

Take note
Notes already became far more capable in 
iOS 9.0 with the ability to add checklists, 
sketches, media and other items. Now you can 
lock individual notes too, and later gain access 
to them using a password or Touch ID. (The 
former method is also avalable in OS X 10.11.4.)
There are new sorting options for arranging 
your notes, and new shortcuts to help you 
start a new sketch or checklist, too.

There’s a lot more to discover in iOS 9.3, 
including improvements to Health and News, 
sharing Live Photos with Macs using AirDrop 
or Messages, enhanced support for hardware 
keyboards, and the ability to pair multiple 
Apple Watches with a single iPhone. We’ll walk 
you through the most important features, but 
check the full list at bit.ly/ios9info as well. 
Alan Stonebridge

 HOW TO Feel more rested by using Night Shift 
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1 Set up a password
In Settings > Notes, tap Password and 

enter one to use with this app only. You 
can set a reminder (Apple can’t help with 
a forgotten password), and allow access 
using Touch ID – be careful that anyone 
registered to use it can unlock notes.

2 Protect a note
Open a note, then tap the Share icon 

and choose Lock Note. You can’t protect 
notes that have audio, video, a PDF or an 
iWork document attached, and locking is 
available for notes stored on your device 
or in iCloud, but not other account types.

3 Reset the password
When you unlock a note, all of them 

become accessible until you tap the lock 
icon, force the app to close, or lock your 
device. Changing the password updates 
notes protected by the old one. Resetting 
it leaves them alone, in case you recall it.

1Avoid library clutter
Adding a track from Apple Music to a 

playlist also adds it to your library. This is 
avoidable thanks to a new item in Music’s 
settings: switch off Add Playlist Songs to 
My Music in Settings > Music. There’s an 
equivalent setting in iTunes on the Mac.

2 Go to an album
At the Now Playing screen, you can 

tap the track’s name to go straight to the 
album it’s from. This is especially handy 
if you’re listening to a ‘radio’ station and 
it throws up a track by an artist or from 
an album you’re unfamiliar with.

3 Popular tracks
With so many albums for you to 

investigate, Apple Music now displays a 
star next to popular tracks in its library, 
helping you to identify good starting 
points for artists or albums of which you 
have little or no knowledge.

Improvements to photo editing 

The Photos app now grants you the ability to make multiple versions of the same 
photo on an iOS device, perhaps because you want to try out several photo filters 
or even just minor variations of the same one. Open an individual photo, or select 
more than one if you want to create copies of several at once, then tap the Share 
icon and choose Duplicate from the sheet’s bottom row. This also enables you to 
edit the still part of a duplicated Live Photo and retain the original with its moving 
part, where before you had to abandon changes to a Live Photo to watch its video.

Duplicating photos affords more experimentation 
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 HOW TO Take greater control of your music library 
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Anyone who’s needed to print 
a document from their iPad or 
iPhone will know the value of 
AirPrint. Apple introduced it 

back in 2010, and it’s steadily grown in 
popularity – over a thousand printers now ship 
with built-in AirPrint support (see  
bit.ly/mfairprint for a list). But don’t despair if 
your trusty printer isn’t supported – you can 
hook it up to an AirPrint-enabled print server. 
You could splash out up to £95 on something 
like StarTech’s Wireless-N USB AirPrint Server, 
but why spend all that money when we’ve 
come up with a do-it-yourself project that’ll 
cost you less than a third of that?

What you’ll need
This project uses the flexible Raspberry Pi 
Zero. We’ve shopped for all our components 
from one place (shop.pimoroni.com), and left 
out any unnecessary add-ons to keep the cost 
down – including a case, but if you have a bit of 
flexibility in your budget, the Best Buys box on 
page 69 suggests one of those.

You’ll need four products, totalling £30.20 
before postage: the Pi Zero with adaptors 
(product code RPI-009); the Broadcom USB 
Hub and Wi-Fi adaptor (BROAD-WIFI); an 
official power adaptor (RPI-SUPPLY); and a 
NOOBS 8GB card (NOOBS-SD-8GB). The Pi 
Zero is often out of stock, so sign up for email 
notifications to secure one when it’s next 
available, if necessary.

You can save money by reusing an existing 
MicroSD card, which must be 8GB or larger, 
and you’ll also need an SD card adaptor or 
USB MicroSD card reader depending on 
whether or not your Mac has an SD card slot. 
Follow the instructions at bit.ly/startnoobs to 
download NOOBS on to it.

You’ll need access to a monitor with an 
HDMI input, and a USB keyboard and mouse to 
install and configure Raspbian. The big issue is 
that the USB hub only has two ports – this isn’t 
a problem if your printer connects directly to 
the network (wirelessly or using Ethernet), but 
if it’s a USB model you’ll need to combine the 
mouse and keyboard on a single port. Apple’s 

Add AirPrint support to any USB or network printer in your home

IT WILL TAKE
 At least 30 minutes

YOU WILL LEARN
 How to set up a 

Raspberry Pi Zero as a 
print server so you can 

print wirelessly from 
Macs and iOS devices.

YOU’LL NEED
 Raspberry Pi Zero, 

a MicroSD card, and 
other accessories 

listed in the tutorial.

You can add 
AirPrint to 
your USB 

printer using 
a Raspberry Pi

Build an AirPrint receiver
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wired keyboards have two built-in USB ports, 
allowing you to connect the mouse through 
that. Or, consider this budget wireless 
keyboard and mouse set (£12.99 from bit.ly/
xentainput), which share a single USB receiver.

Basic installation
Start by inserting the NOOBS card into your 
Pi Zero, then connect the Broadcom adaptor 
to the Pi using the USB converter cable. 
Connect the keyboard to one USB port on the 
adaptor, plug the mouse into the keyboard, 
and your USB printer on the other port. 
Switch on the printer and monitor, then plug 
in the power – there’s no switch so, if all is well, 
the Pi should start up immediately.

You’ll see a screen with just one entry: 
Raspbian. Select that, then click the Install 
button followed by Yes, and wait for the files 
to be copied. This is a lengthy process, so be 
patient – while you wait, verify the language 
and keyboard settings are correct at the 
bottom of the screen. Once complete, click 
OK to restart the Pi Zero in Raspbian.

You’ll see a series of scrolling messages, 
and after about a minute the screen will go 
blank – again, be patient, and the Raspbian 
desktop should eventually appear (future 
startups are much quicker). Test both the 
keyboard and mouse are working, then click 

the network icon in the top-right corner to 
connect to your local Wi-Fi network.

Next, it’s time to get your hands dirty using 
Raspbian’s Terminal. Click the shortcut to it 
(the black monitor) in the menu bar. First, if 
your printer is connected using USB, enter 
lsusb. (Skip this if you’re planning to connect 
to a network printer.) This lists all the USB-
connected devices on your Pi, among which 
you should see your printer’s manufacturer, 
confirming it’s connected.

Enter sudo apt-get update && sudo 
apt-get upgrade to ensure installed packages 
are up to date, then the following command to 
install the Samba sharing components and the 
CUPS printing system: sudo apt-get install 
samba && sudo apt-get install cups. 
Follow any prompts and, after both packages 

Genius Tip!
 Visit bit.ly/pivnc for 

details on setting up 
VNC software on your 
Pi, which enables you to 
remotely access the Pi’s 
desktop from your Mac 
to administer it.

Jargon Buster
 CUPS stands for 

Common Unix Printing 
System, and is an 
open-source technology 
developed by Apple to 
allow a computer to act 
as a print server.

Once the AirPrint server is set up, your printer is also 
accessible from your Mac and other computers too.

You’ll spend a little bit of time with 
a command line for this project, 
but it doesn’t involve anything 
particularly complex.Adding AirPrint capabilities to your old home printer will extend its life for use with your Mac and iOS devices.

Make an  
AirPlay receiver

 Don’t miss out 
on our advice in 
MF298, see p78 

for details
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have been installed, enter this command, 
which lets you set up and manage your printer: 
sudo usermod -a -G lpadmin pi.

Printer setup is the trickiest part of the 
process, depending on whether it’s supported 
and what drivers are available for it, but at 
least CUPS is configured through your web 
browser, providing you with a more user-
friendly interface. The walkthrough opposite 
will help you with this part of the process.

Once you’ve successfully printed a test 
page, there’s just one last tweak: switch to 
CUPS’ Administration tab, turn on ‘Share 
printers connected to this system’ (and ‘Allow 
printing from the internet’ if required), then 
click ‘Change Settings’. Your printer will now 
be set up, shared and ready for the final stage.

Set up AirPrint
The Pi’s Wi-Fi adaptor has power management 
switched on, which can cause problems, so 
let’s disable it (its power consumption is 
minimal anyway). In Terminal, enter sudo 
nano /etc/network/interfaces. Find the 
first line that begins ‘wpa-conf’, and on a new 
line directly beneath it, above the ‘allow-
hotplug wlan1’ line, type wireless-power off.

Press ≈+x, then y when prompted to 
save your changes. Close the Terminal window, 
then reboot your Pi Zero for the change to 

take effect. To verify your settings, enter 
ifconfig in Terminal. If there’s no reference to 
power management, it has been disabled.

The final step of the process is simply to 
install a single app to enable AirPrint support, 
again from the command line: sudo apt-get 
install avahi-discover. Once done, that is 
literally it. On your iPad or iPhone you should 
find your printer is now visible as an AirPrint 
destination and, crucially, that it works.

Make it headless
There’s no need to keep the keyboard or 
monitor connected now, but it’s handy to 
perform a few tweaks should you need to 
access the Pi Zero later on. First, support for 
command-line access via your Mac’s Terminal 
app is already set up – just enter the following 
command to log on: ssh pi@raspberrypi.
local and enter yes when prompted, followed 
by your password, which is raspberry, and 
you’ll find yourself at the Pi’s command line. 
If you want remote access to the Pi’s graphical 
desktop, you’ll need to install VNC software on 
it – see the Genius tip on page 67 for details.

You can now shut down your Pi Zero, 
disconnect the keyboard and monitor, then 
power it back up. Congratulations, your printer 
is now AirPrint-enabled and easily accessible 
from other computers too.

Genius Tip!
 Once Raspbian is 

configured, go to Menu > 
Preferences > Raspberry 

Pi Configuration and 
choose ‘To CLI’ next 

to Boot to quicken the 
time it takes the print 

server to start up.

Jargon Buster
 NOOBS is software 

that comes preloaded 
on SD cards for Pi (or it 
can be downloaded) to 
simplify the installation 
of Raspbian and other 

operating systems.

1

2

3

4

1

Pi Zero
 We’ve chosen 

the Pi Zero due 
to its low cost 
and incredibly 

small size.

3

Power 
adaptor
 The official 

Raspberry Pi 
adaptor is a 
great choice for 
supplying power 
to the Pi Zero.

4

USB hub
 This Broadcom 

hub includes two 
USB ports and 
a built-in Wi-Fi 
adapter. It does 
not require a 
power supply.

2

Accessories
 You’ll need a 

MicroSD card, 
plus adaptors 

to connect 
your monitor, 

a keyboard 
and a printer.

EXPLAINED… What you’ll need 

2
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 HOW TO Install your USB printer 

1Access CUPS
In the menu bar, choose Menu > Internet > 

Epiphany Web Browser. Type 127.0.0.1:631 into 
the browser’s address bar and then press ® 
to access the CUPS management interface. 
Switch to its Administration tab and then click 
the Add Printer button.

3Check for a driver
You can change the printer’s name if you 

want, but make sure you click the checkbox next 
to Share This Printer before you click Continue 
again. CUPS will provide you with a list of available 
printer drivers – if one for your model is present, 
select it; if not, read on.

5 Install the driver
You may have to download and then 

compile the driver – instructions for doing this 
are provided on the website you got the driver 
from. Follow the instructions carefully, but be 
reassured that although they look complicated, 
it’s mostly a copy and paste job.

2Select your printer
Enter your user credentials (unless you’ve 

customised them, the username is pi and the 
password is raspberry), then click OK. Your 
printer should be listed under Local Printers 
and/or Discovered Network Printers. Select 
your desired connection and click Continue.

4Manually find a driver
Open a new browser tab, then try your 

printer maker’s website, or visit openprinting.
org/printers where you can browse by make 
and model to look up a recommended driver, 
which is listed at the top. Switch to the Drivers 
tab to locate links to the recommended driver.

6 Finish adding the printer
Switch back to the tab in Epiphany where 

you were adding a printer. Reload the page and 
entries relating to your printer will appear. 
Select one and then click Add Printer. Switch to 
CUPS’ Printers tab to select Maintenance > 
Print Test Page and check it’s all working.

Best Buys!
 Give your Pi Zero extra 

protection and reduce 
the number of cables 
you need to connect 
with these optional 
extras. You can get 
the case and shim from 
shop.pimoroni.com, 
and the Wi-Fi adaptor 
from modmypi.com.

Pibow Zero case
 Protect your Pi Zero by 

housing it in this neat, 
protective case for just 
£4. DIY assembly is 
easy, as is access to 
the MicroSD card.

USB to Micro-USB 
port shim
 This £2 extra provides 

a neat way to connect 
the USB hub directly to 
the Pi Zero, but don’t fit 
it until the Pi is headless.

Official Wi-Fi adaptor
 If your printer uses 

Ethernet rather than 
USB, reuse the hub and 
add this adaptor (£6) to 
the Pi once it’s headless.
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Q
I keep getting troubled by 
Olivernetko.download, which is also 
filling my logs. I am told to get a 

new version every day, which I already have 
and don't want. How can I get rid of it?
by M I K E  B I R D

A
Although Olivernetko is not actually 
full-fledged malware, it is infuriating 
adware that tries to make money out 

of you. As it can also download and install 
other apps without seeking your permission, 
it could easily bring malware to your Mac. 
You need to remove and avoid it as a matter 
of top priority.

First check in the extensions section of 
each of your web browsers’ preferences, and 
remove Olivernetko from any where you find 
it. Then check your ~/Library/LaunchAgents 
and ~/Library/Application Support folders for 
suspicious files, such as Olivernetko.download.
plist. Remove any instances you find, perhaps 
moving them to a holding folder in your 
Documents folder for the time being, before 
putting them in the Trash. 

Use an adware removal tool such as 
Anti-Malware for Mac (free, malwarebytes.org) 
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macformat.com

to clean any remaining traces 
from your Mac. Finally scrub the 
adware from Safari pages: open 
Apple’s browser, set it to open new windows 
to an empty page (in its General preferences), 
quit the app, then reopen it with ß held 
to clear its records of pages that were open 
during your previous session. Open its Search 
preferences and ensure Olivernetko hasn’t 
hijacked any of the settings there as well.

How can I break 
free of endless 
log references 
and prompts 
to update the 
Olivernetko app?

MalwareBytes’ removal tool is free, 
and should be able to clear the last 
vestiges of Olivernetko from your Mac.

Our resident genius 
solves your Mac and  

iOS problems

EXPERT 
ADVICE
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Networking 
Trace a route back to the internet with 
plain advice that’ll help you stay connected

GENIUS TIPS Networking

It’s best to assign a 
static IP address to each 
device that remains at 
home on your network
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refer to Devolo’s documentation to interpret 
what their current status indicates. If that 
doesn’t fix the problem, move your iMac to 
connect direct to the Home Hub using an 
Ethernet cable, to prove that you can hook up 
to the router correctly.

Unless your iMac is mobile – that is, you 
take it to other locations and use it on another 
network – assign it a static IP address on the 
same subnet as the router. The normal default 
address for Home Hubs is 192.168.1.254, so 
give your iMac an address of 192.168.1.1, with a 
subnet mask of 255.255.255.0. Using Network 
Utility on your iMac, select the Ping tool, and 
prove that it can see the router by pinging its 
IP address of 192.168.1.254.

To ensure the router doesn’t try to allocate 
your iMac's new static address to another 
device, connect to its admin page and set it to 
use DHCP to allocate addresses in the range 
192.168.1.10 to 192.168.1.250. Check no other 
device on your network is issuing IP addresses 
using DHCP, which would conflict with the 
router: if there is, turn off its DHCP server.

Lost network connection

Are powerline 
adaptors as good 

as Ethernet?
> With good quality 

modern mains cabling 
they can achieve the 

same gigabit transfer 
speeds as dedicated 

Ethernet connections. 
They can be more 

susceptible to electrical 
interference though, 

which Ethernet cabling 
is designed to minimise. 
If you can afford to run 
Category 5e or better 

cabling, Ethernet should 
deliver more consistent 
network performance. 

 
 
 
 

How can I tell if a 
network device 

provides DHCP?
> Check the device’s 

user guide, then 
connect to its admin 

interface. If you already 
have another device 
providing DHCP you 

should be able to 
disable that service 

altogether, or limit the 
range of IP addresses 

that your primary DHCP 
server can allocate.

Networking  
quick-fire 

questions 

Q
My iMac is connected via Ethernet 
cable to a Devolo 1200+ Wi-Fi hub, 
and the Devolo at the other end 

connects via another Ethernet cable to my 
BT Home Hub 5 to reach the internet. 
Although this worked fine, the iMac has now 
lost its internet connection, and its Network 
pane shows a self-assigned IP address. How 
can I restore the internet connection?
by J O H N  S T U B B S

A
Check that all physical connections 
are sound, and that none of the 
cables have been disturbed during 

cleaning. Inspect the Devolo adaptors and 
ensure their LEDs are white. If they aren’t, 

Macs and other 
devices that seldom 
move are best 
assigned static IP 
addresses, rather 
than using DHCP.
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Sudden loss of the Ethernet port

 macformat.com  @macformat JUNE 2016 | MACFORMAT | 73

run Apple Diagnostics (on Macs released after 
June 2013) or Apple Hardware Test (on Macs 
from before June 2013). 

If it passes the tests, you can be fairly 
confident the cause is a software driver issue. 
Back in February, Apple pushed out a silent 
update to its security protection which 
inadvertently disabled Ethernet ports in some 
Mac models. Review your logs using Console, 
looking back in the seconds after it last started 
up for complaints about a kernel extension 
(kext) being in the exclude list. Further 
information is on my blog at bit.ly/1Szrh4a.

Can I improve my 
internet speed by 
using Wi-Fi too?
> Ethernet and most 
modern Wi-Fi networks 
are much faster than 
the majority of internet 
connections. Hooking 
up your Mac to the 
same router using both 
Ethernet and Wi-Fi 
won’t make a positive 
difference to the net 
transfer speed, and 
could even reduce 
it slightly.

How do I switch 
between routers 
on one network?
> Set up the first 
network connection in 
the Network pane, and 
save it as a new location 
using the pop-up menu 
at the top of the pane. 
Set up the other and 
save it as a different 
location. Switching 
between them is just 
a matter of changing 
the Location setting.

Two broadband lines,  
double the speed?

OS X can spread traffic load between ports, 
which you can pair with a second broadband 
line to boost your internet connection.

Q
We can’t get an internet connection 
faster than 4Mbps. Could we double 
our effective bandwidth by getting a 

second broadband connection?
by D A V E  J O R D A N

A
Yes, you could, but it isn’t as simple 
as just adding an extra modem-
router. This is because each Mac 

or other device will normally connect one 
network port, such as an Ethernet port, to a 
single router at a time.

If multiple devices use the connections, 
you can set them up to use one or other of the 
routers, making allocations to try to even the 
load on the two internet connections. Macs 
with two built-in Ethernet ports, such as the 

Mac Pro, can be configured to use link 
aggregation to spread their load over 

each port and separate routers.
You can configure link aggregation 

in System Preferences’ Network pane: 
ensure that both Ethernet ports are 
connected to discrete modem-routers, 
and that both are activated in the pane. 
Click the button that’s labelled with a 
cog icon below the list of network 
interfaces on the left, then choose 
Manage Virtual Interfaces. In the next 
pane, click the + button to create a new 
link aggregate, and select the Ethernet 
ports to add to that. The two Ethernet 
ports will then work as one, using the 
Link Aggregation Control Protocol 
(LACP) to balance the traffic load 
between them.

Unfortunately, network devices 
which perform similar link aggregation 
are expensive, and not easy to obtain.

This log shows what happened when Apple inadvertently 
blacklisted the kernel extension needed for Ethernet.

With the extension disabled, the Ethernet port's MAC 
address was unreadable, causing many other problems.

Q
My iMac had been working perfectly 
on the internet, but when restarted 
it lost its Ethernet connection, 

complaining it had become disconnected. 
Its cables are fine. What can I do apart from 
connect the iMac using Wi-Fi?
by O R S O N  H U G H E S

A  
There are two likely explanations. 
More worrying is hardware failure: 
restart it with just a wired USB 

keyboard and mouse connected, holding D 
before the grey screen appears at startup to 



Mac Software 
Ease your app-fuelled anxieties and get your 
productivity back on track with this advice

Getting Amazon Prime Video to workSoftware 
quick-fire 

questions 
Can I watch BBC 
iPlayer in Safari 
without Flash?
> Currently iPlayer 

doesn’t serve its new 
HTML5 version to Safari 

for Mac. However, turn 
on Safari's Develop 

menu in its Advanced 
preferences, choose 

Develop > User Agent > 
Safari — iOS 9.3 — iPad, 

then connect to the 
iPlayer site. When told 

your Mac is an iOS 
device, iPlayer should 
then serve up HTML5 

video rather than Flash. 
 
 
 
 
 
 

How can I 
efficiently draw 

a lot of timelines?
> Look first at Aeon 

Timeline (£29.99, Mac 
App Store). Although it 

seems costly, it lays out 
timelines from simple 
data entry, saving you 

the pain of drawing 
each individually. 

It exports to various 
image formats, 

PDF or HTML.

Video service using Safari rather than Firefox, 
as Safari is generally reported to be the more 
reliable of the two for this. If you can’t get 
Safari to work, you may find the only way to 
view Amazon’s movies is to download and 
install the latest release of Chrome, which 
does not require the Silverlight plug-in. 
Because the video playback functionality 
that’s required is built into Google’s browser, 
this one often proves to be the most reliable 
option of all. 

If you still can’t get Silverlight or Chrome 
to work, or you want to avoid Chrome, then 
Opera might do the trick. Amazon provides 
further instructions for dealing with issues 
with the Amazon Video service at amzn.to/ 
1TRcuXU, which you may find helpful, including 
further Silverlight-specific troubleshooting.

Try the latest version of 
Chrome, which doesn’t 
require the Silverlight 
plug-in for Prime Video

GENIUS TIPS Mac Software

Q
I have taken out a free 
trial of Amazon Prime 
Video, but when I try 

to watch its streamed movies, 
I keep seeing an alert telling 
me that Microsoft Silverlight 
is not installed. My 24-inch 
iMac (Early 2008) is running 
El Capitan and has 4GB of 
memory installed. Although 
I have installed Silverlight 
several times, I cannot make 
that alert disappear so that 
I can watch Amazon’s movie 
library. Does Amazon Prime 
Video not work on Macs yet?
by S T E P H E N  S T U R G E S S

A
Yes, it does, but many 
other Mac users have 
reported similar 

problems in getting it set up and 
running. You should ensure that 
you have downloaded and 
installed the very latest version 
of Silverlight, as OS X will now block some 
older versions because they suffer from 
security vulnerabilities.

Microsoft provides test and demo pages 
against which you can confirm that Silverlight 
has installed and is working properly, such as 
the page at bit.ly/23EzVGF.

With Silverlight installed and proven to be 
working, try accessing the Amazon Prime 
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Before trying to use Silverlight 
to play streaming video, visit 
the plug-in’s test pages to 
check it works properly.

You can trick Safari for Mac 
into serving you HTML5 video.



Q
I have several old documents that 
were created using the spreadsheet 
module in AppleWorks. I’ve tried 

opening them using the current version 
of Numbers, but it refuses, reporting that 
the version of AppleWorks which I used is 
unsupported. How can I open them now?
by G A R R Y

A
Unfortunately this may not be 
possible without access to an old 
copy of AppleWorks, which can’t be 

run on any vaguely recent version of OS X. 
Older versions of Numbers are more 

likely to be able to open such old AppleWorks 
spreadsheets, but you will need to go back to 
that in iWork ’09 or earlier, which might still 

Opening old 
AppleWorks 
spreadsheets 
on today’s Macs  

Mac Software GENIUS TIPS

run under El Capitan. Alternatively, the free 
LibreOffice suite (libreoffice.org) may well 
cope with your AppleWorks files.

If neither of those works, the only solution 
is to find someone with an old Mac still running 
AppleWorks, although you will be very lucky 
to discover someone offering this as a service, 
as such. Save your files in an accessible format 
such as CSV or tab-delimited text, so that you 
can import those files to modern apps.

LibreOffice claims to be able to open a huge range of 
different file types, including many old spreadsheets.

Automatically 
saving incoming 
messages into 
folders on disk

2016 | MACFORMAT | 75 macformat.com  @macformat

Mail’s junk mail 
filter doesn't work. 
How do I fix it?
> Ensure OS X is fully 
up to date, then try 
resetting filtering in 
Mail's preferences, and 
letting it settle. If it still 
won’t work, consider an 
alternative such as 
SpamSieve ($30 – about 
£21, c-command.com), 
which works with most 
mail clients, runs as a 
separate app, and 
learns very well indeed.

How can I hide 
group addresses?
> When you send a 
message directly to 
a group of addresses, 
recipients will see all 
the addresses. To hide 
them, send the message 
to yourself and put the 
group addresses in the 
Bcc field (View > Bcc 
Address Field) instead. 
 
 
 
 
 
 
 

 

Why do some new 
messages not 
appear in Mail?
> Try rebuilding your 
inbox (or the mailbox 
where new messages 
should appear): select it, 
then choose Mailbox > 
Rebuild. If you have 
an old version of Mail, 
some people have had 
problems, particularly 
with Smart Mailboxes; 
updating to the latest 
release of Yosemite or 
El Capitan should help.

The Bcc field setting is sticky, 
so Mail always shows the field 
in new messages once it’s on.Q

How can I get Mail to save out 
incoming messages automatically 
into separate folders according to 

the sender's mail address?
by P A U L  S T A N T O N

A
The most practical way to do this 
directly in Mail is by setting a rule, 
which requires AppleScript, but is 

non-trivial. If you want to try your hand at it, 
there’s a helpful example at bit.ly/1VV4wNu 
that performs the same task for attachments 
to get you started.

You may find it easier to use a set of 
simpler rules, each of which calls a separate 
AppleScript to actually perform the task 
of saving. For example, if you get a lot of 
messages from me@me.com, you could make 
a rule in Mail's preferences which handles all 

messages from that address, and then simply 
calls your script to save each message to your 
designated folder for that sender.

The snag with these script approaches 
is that you will need to hard-code the path 
to each folder in which the messages are to 
be saved, which makes them inflexible and a 
nuisance to maintain. If you decide to move 
those folders, you would have to change every 
one of the scripts.

A much simpler approach, which does 
not require any AppleScript, would be to use 
a basic rule to move messages to different 
custom mailboxes in Mail according to the 
sender's address, then to manually save from 
each of those mailboxes as needed.

Use rules in Mail to deal with new messages, but beware 
that your desired action may require coding AppleScript.



iOS Software 
Swipe away your touchscreen troubles and 
rekindle your love of Apple’s mobile devices

iOS software 
quick-fire 

questions 
From where can 

I get the iPad Pro 
user guide?

>The iPad User Guide for 
iOS 9.3 covers all iPad 

models, and is available 
free from the iBooks 

Store (and the iTunes 
Store on your Mac). 

Normally user guides 
are also provided in PDF, 

but Apple has not done 
so for the iPad and 

iPhone ones. However, 
there’s a version you 

can read in a browser 
at apple.co/1SzQ8Vu.

How can I change 
my details that are 

used by AutoFill?
> The personal info 

about you that’s used 
by Safari's AutoFill 
feature is normally 

taken from the Contacts 
card designated as ‘me’. 

Choose your card in 
Settings > Safari > 

AutoFill > My Info. Edit 
the card in Contacts 

app, where it should be 
at the top of the list.

GENIUS TIPS iOS Software

Q
I don't use iTunes Match, and I am 
not even too sure which version of 
iOS my iPhone 5s is running, but 

the Music app keeps removing songs from 
my phone and putting them back into the 
cloud. This makes it impossible for me to 
listen to those tracks when I don't have an 
internet connection. How can I prevent this?
by É L I S E  G O Y E T T E

A
Discover which version of iOS your 
iPhone is running by going to 
Settings > General > About, and check 

Software Update alongside that – it’s worth 
updating to the latest version to gain fixes 
for security issues, and to smooth out earlier 
issues with iCloud, backup and other things.

It sounds like your device is automatically 
managing its storage and, when it runs low 
on free space, it’s sacrificing songs in Music. 
When you tap the row for a track that’s stored 

in the cloud (which will be tracks you have 
bought from the iTunes Store), the Music app 
downloads a copy to your device, but it only 
persists there for as long as you have plenty 
of free space. To ensure an item stays on your 
device, tap the adjacent ellipsis, then tap the 
cloud with a downwards-pointing arrow. 
Download progress indicators appear next to 

How do I prevent 
tracks disappearing 
from my iPhone?

relevant tracks, and will eventually change to 
tiny device icons, telling you iOS’s automatic 
storage management will no longer clear 
those items off your device. To manually get 
rid of such an item, tap its ellipsis, then the 
device icon, and pick Remove Download.

To see only music that’s available offline, 
tap My Music, then the category selector (just 
under the Recently Added row) and turn on 
the switch labelled Only Downloaded Music.

Music caches tracks played from the cloud, or you can 
download them to guarantee they’ll be available offline.

iOS is automatically 
managing its storage 
space, which is low, 
and sacrificing music
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BACK ISSUES Collect them all

Missed an issue?
Complete your collection of the UK’s 

No.1 magazine for Apple fans

Download back issues onto your 
iOS device at any time and keep them 

forever in your personal library. 
bit.ly/macformatipad

To order back issues of the print 
magazine, go to http://goo.gl/B7aFdk 

or phone +44 (0)844 848 2852 
and we’ll post them out to you.
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EDITED BY LUIS VILLAZON 

 LUIS’S APPLE CLASSIC!

Inspiring ideas for 
revamping your old  

Apple devices

REUSE 
OLD KIT

hristian has given me a first-gen 
MacBook Air to refurbish this month. 
At eight years old, it’s very old for 

a laptop, but it can just about run OS X Lion, 
so it could still be useful. What it really needs 
is a speed boost, but its processor, graphics 
chip and memory are all soldered onto the 
motherboard, so I can do nothing about them. 
I can change the hard disk though. The current 
one has a pitiful 80GB capacity – I have more 
storage in the cloud! Fitting a 128GB SSD will 
give me more room for apps and documents, 
and improve loading times. I can improve the 
battery life, too. The original one is well past 
its nominal lifespan of 
500 charge cycles, and 
is down to about half of 
its original 4.5-hour 
duration. Swapping it for 
an aftermarket battery is 
an easy way to freshen 
up this laptop.

What’s inside 

80–81  
MAKE AN OLD 
MACBOOK AIR 

USEFUL AGAIN
 Make Apple’s first 

ultra-slim notebook 
better by fitting an SSD.

 
82 

INSTALL AN SSD
 Learn how to remove 

the stock hard drive and 
connect a replacement.

Contact us

 Email your queries 
and your questions to 

lovemac@macformat.com

 Keep up to date by 
following us on Twitter  

@macformat

 Join the conversation 
at facebook.com/

macformat

 Get the latest 
subscription offers at 

macformat.com

A new hard disk and a fresh battery 
will revitalise this 2008 MacBook Air

 The clamshell iBook G3 looks like no other MacBook. Its translucent 
coloured case almost looks like a nursery school ‘speak-and-spell’ 
pretend laptop – but that’s what’s great about it. You don’t need a 
bag for it as there’s a built-in carrying handle. It looks fun and it feels 

robust. Back in 1999, it was no slouch either; Apple billed it as 
the world’s second-fastest portable computer 

(after the Lombard PowerBook G3). It came 
with 32MB of memory and a huge 3.2GB drive.

Fewer parts of a 
MacBook Air are 

ugpradeable than 
older MacBooks, 
but you can still 

revitalise one.

C



LOVE YOUR MAC The original MacBook Air
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A breath of 
fresh Air 
Boost your first-gen MacBook Air’s 
performance with two easy upgrades

Hardware 
quick-fire

questions 
Can I use Time 

Machine to backup 
the drive instead?

> You can, but it’s more 
work. You can’t start up 

from a Time Machine 
volume, so you’ll need 

to restore a working 
operating system first. 

Since the new disk won’t 
have a Lion Recovery 

Partition on it, you’d 
need to pay Apple for a 
Lion thumb drive, build 
your own from the Lion 

installer from the Mac 
App Store, or use the 

Recovery Disk Assistant 
(apple.co/1Sc8HSA). 

Cloning the original disk 
before swapping drives 

is much simpler. 
 
 
 
 
 
 
 
 
 

 
Can I connect the 

MacBook Air to an 
HDMI monitor?

> Yes, you can. You’ll 
need a Mini DisplayPort 
to HDMI adaptor, which 

will cost you less than 
£10 from Amazon. 

Your external monitor 
probably has a much 

higher native resolution  
(likely 1920x1080) than 

the 2008 MacBook Air’s 
built-in display, but most 

monitors will upscale 
a mirrored desktop 

without too much 
loss of sharpness.

2

Screen
 The 13.3-inch display has 
a resolution of 1280x800 
pixels, so you can watch 

720p movies on it.

4

Weight
 At 1.36kg, the 2008 

MacBook Air is nigh on 
the same weight as the 
current 13-inch model.

5

CPU
 The 1.6GHz Intel Core Duo 

processor is about  
three-and-a-half times  
less powerful than the  

Early 2015 MacBook Air.

1

Ports
 To preserve its sleek lines, 

the first-gen MacBook Air has 
a single USB port, headphone 

jack and Mini DisplayPort.

6

Soldered memory
 The biggest limitation of 

this MacBook Air is that its 
memory is soldered in place, 
so it can’t be upgraded past 

the standard 2GB.

3

Networking
 This MacBook doesn’t 

have built-in Ethernet or 
FireWire ports, only 

Wi-Fi and USB.

SuperDuper is an easy way to 
copy the contents of an old 
disk to a replacement one.

4

3

2

1

56
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on the small plastic tab, so you don’t wrench 
the connectors.

This provides access to the hard disk, 
which is in the playing-card-size box sitting 
underneath a daunting matrix of ribbon 
cables. Thankfully, Apple uses really nice 
ribbon connectors that use a contact pad, 
instead of an edge connector. The two cables 
on the right-hand side can just be prised gently 
up. The much smaller power cable on the left 
is more fiddly; its easiest to remove this using 

hen buying 
replacement 
Mac parts, ‘Early 

2008’ isn’t enough to specify 
which model you have, because there 
are often slight hardware changes made 
within a given generation. Instead you need 
the specific model number, which is printed in 
very tiny letters on the underside, next to the 
regulatory blurb and recycling information. 
This MacBook Air is model A1237. Armed with 
this detail, I did a quick search on eBay and 
found several listings from reputable sellers 
for compatible parts. A battery cost £17 and a 
128GB SSD of the right physical size was £50.

While I waited for them to arrive, I profiled 
the current battery life so I could compare the 
improvement after the upgrade. This simply 
involved charging the battery to full, then 
playing a full-screen QuickTime video with all 
of the Energy Saver options turned off until 
the battery died. It lasted 2 hours 13 minutes. 
I also cloned the hard disk to a USB drive using 
SuperDuper (£21.57, shirtpocket.com).

No tricky screws
Once the new parts arrived, the upgrade itself 
was pretty straightforward. It took me about 
45 minutes. The only screwdriver I needed 
was a Phillips #00 (the very small one from 
a watchmakers set). The back case is held on 
with 10 screws around the edge, of various 
sizes, so it’s important to keep track of which 
is which. I usually just put them down on the 
table in the same pattern as they appear on 
a MacBook, relative to me.

With the screws removed, the case slides 
off towards the screen hinge. The big black 
slab underneath is actually the battery, 
although it just looks like a piece of backing 
plastic. The battery is held in place with 
another eight screws of varying lengths 
around the edges, and a ninth screw in the 
middle that’s easy to miss. You need to unplug 
the battery from the motherboard by pulling 

W

The original MacBook Air 
came with a miniscule 
hard drive, which can be 
replaced with an SSD for 
a new lease of life.

The hard disk is that box 
underneath the daunting 
matrix of cables

Once the new SSD is installed, 
you can just copy your cloned 
disk back over to it.



LOVE YOUR MAC The original MacBook Air
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1Data cable
The ribbon cable from the old drive is 

held in place by a small black bar latch. 
This is covered by black tape. Peel the 
tape away, and push the bar away from 
the drive and toward the cable to unlock 
it. Next, remove the ribbon cable, insert 
it into the replacement SSD, and pull the 
bar latch back towards the drive.

2Drive caddy
SSDs aren’t vulnerable to vibration, 

unlike traditional spinning hard disks, so 
you don’t need to worry about reusing 
the foam padding glued to the old drive. 
You will need the rubber shock absorber 
surround so the SSD fits in the drive 
frame. Make sure it’s the right way round 
to line up with the screw mounting points.

3Screw clearance
There’s a thin black wire that runs 

along the top edge of the drive caddy. 
One of the clips that holds this in place is 
glued directly over the caddy fixing screw 
in the top-right corner. You don’t need to 
bother replacing this clip, but make sure 
that the black wire is clear of the screw 
holes for the laptop’s backplate.

 HOW TO Install the SSD 

Next Issue!
 Luis opens up an iPod 

classic to replace its 
mechanical hard drive 

with a much more 
energy-efficient SSD that 

can better take knocks.

and turned on the MacBook. The new drive 
was unformatted, of course, so the Mac 
booted from the clone on the USB drive, and 
I used Disk Utility to format the internal SSD 
and ran SuperDuper to clone the backup 
drive’s contents to the SSD.

While I was doing this, I ran the MacBook 
on battery power to drain it down to 2% 
capacity, and then plugged in the mains 
adaptor to charge it back up to 100%. This 
initial drain-and-charge cycle is important to 
condition a new battery. You shouldn’t drain 
it all the way to 0% if you can help it, as this 
causes corrosion on the cell electrodes and 
reduces the overall capacity of the battery.

Once it came round from the anaesthetic, 
this MacBook Air was noticeably livelier than 
before, and its battery life had roughly 
doubled. It’s still fairly slow compared to a 
recent model, but it’s easily useful enough 
to keep around for another year or two.

a pair of needle-nose 
pliers or tweezers. That 
just leaves one ribbon 
cable that seems to be 
attached directly to the 
drive frame. But, luckily, 
you can remove the 
drive from the frame 
without disturbing the 

cable. The frame is held in place with four 
screws, but one of them is hidden underneath 
a cable clip for the black wire that runs parallel 
to the screen hinge. See the walkthrough 
above for more detail on this, and how to 
install the new drive.

Back to life
After the SSD was securely connected and 
screwed into place, I connected the new 
battery and refitted the back cover of the 
MacBook. Then I plugged in the backup disk 

The SSD isn’t as fast as 
Apple’s latest ones, but the 

performance boost nicely 
extends the Air’s useful life.

 macformat.com  @macformat

The original MacBook Air uses 
the same 80GB ATA hard disk 

found in the iPod classic.
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Discover
HomeKit

Turning your house into a smart home used to be an expensive undertaking. 
Not any more thanks to Apple’s HomeKit tech. Rob Mead-Green explains all…

Automate your lights 
so they’re on when 

you come home.

Lights 

Don’t waste time in the 
morning: have HomeKit 
open the blinds for you. 

Blinds 

Keep your home at a 
comfortable temperature, 

right from your iPhone.

Thermostat 

84 | MACFORMAT | JUNE 2016

M
ost homes are pretty 
dumb when you 
think about it: you 
have to physically 
lock and unlock the 

doors, manually switch lights on 
and off, use timers to fire up and 
shut down your central heating… 
it all seems rather archaic now. 

Thanks to home automation, you 
can go from home to ‘smart home’ 
without the need for an expensive 
team of professionals – Apple’s 
HomeKit does away with all of that. 

HomeKit not only enables you to 
control the heating and lighting from 
your iOS device, but also enables 
these devices to work together, 

making your home truly smart.
Although HomeKit first 

appeared in iOS 8, it has taken 
smart device makers a little while 
to catch up. The great thing about 
it is that it’s so simple to set up and 
use, and you can use it in more 
than one location – your home and 
your office, say. Let’s get started…

 macformat.com  @macformat



There’s a lot more to home automation 
than simply switching lights on and off

Managing your smart home
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he thing that really 
separates an ordinary 
home from a smart home 
is the ability to create 
custom actions. In old 

school computer-speak you might call 
these macros – triggers for a series of 
commands or tasks that are carried 
out together or in sequence. 

Imagine that you’re driving home 
and want to be assured of a warm 
welcome. You could simply say, “Hey 
Siri, I’m coming home” to have it relay 
that command to HomeKit-compatible 
devices in your house, switching on 
the lights and the heating so that 
everything is ready for when you walk 
up to your front door.

HomeKit also includes support 
for geofencing – a wireless boundary 
around your home that can be set 
so it automatically locks the doors, 
closes the windows, switches down 
the heating and turns off the lights 
whenever you depart – and it can be 

set to carry out the opposite actions 
when you arrive home too, if that’s 
what you want.

Smarter living
HomeKit, like most smart home 
systems, offers different levels of 
granularity. You can create a ‘home’, 
comprising every room and all of the 
smart home systems contained within 
them; ‘rooms’, which can be tailored 
to control devices in different rooms 
in your home – you could have one 
called ‘kitchen’ or ‘living room’, 
for example; and you can also have 
‘zones’, which can comprise whole 
areas of your home – ‘upstairs’ and 
‘downstairs’, for example. 

Another smart home feature is 
something called a ‘scene’. These are 
the custom actions we referred to 
above. Scenes are incredibly powerful 
and can be both time and location-
based. Instead of you having to 
wander around the house turning 

down the heating, switching off the 
lights and locking all your doors when 
you’re about to turn in for the night, 
you could simply create a ‘bedtime’ 
scene using the smart home app on 
your iPad or iPhone, then tap it or say 
“Hey Siri, bedtime” to perform all of 
these things for you. Clever, eh?

HomeKit devices usually rely on 
Bluetooth Low Energy (also known as 
Bluetooth Smart) and/or Wi-Fi to relay 
the actions that you want to carry out, 
which is fine when you’re at home. 
But what if you’re away?

Which Apple devices?
iOS 9 can access HomeKit devices 
remotely using iCloud. Go to Settings 
> HomeKit and switch on Use iCloud, 
then to Homes > [your home name] > 
and switch on Allow Remote Access.

In iOS 8, you’ll also need a third-
gen or later Apple TV, to have iCloud 
Drive and iCloud Keychain enabled, 
and for the devices to be on the same 
network as your Apple TV, or within 
25 feet if triggered using Bluetooth.

T

Smart lights are some of the most useful and least 
expensive products to feature HomeKit integration.

Elgato’s Eve app is a great example of the complete control you can now get of your home’s systems.
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2 Finish adding it
Once found, your accessory should pair. 

In Elgato’s Eve app, you can capture the set-up 
code by pointing your iOS device’s camera at 
the printed sticker on the device. You can then 
assign it to the ‘room’ where it’s located.

3Choose your location
Next you need to set the location of the 

accessory – this could be your home or office. 
We’re using Elgato’s Eve app, but similar steps 
will apply to any other apps or devices you are 
using. The default setting is ‘Home’.

4Give it a name
For Siri to work with your HomeKit 

accessory, you need to give it a unique name. 
We’re setting up an Eve Energy smart plug 
here so we’re simply going to call it ‘Table 
Lamp’ as that is what’s plugged into it.

5Create a zone
If you have multiple HomeKit devices, you 

can assign zones to them. Here we’re adding 
our smart plug to a zone called ‘Downstairs’. 
So, when we say, “Hey Siri, turn off the lights 
downstairs”, it will do exactly that.

6Create a scene
 HomeKit can also create scenes – macros 

that cause certain HomeKit actions to take 
place. Here we’ve made a ‘Good Morning’ 
scene, which automatically switches on the 
lights when we say, “Hey, Siri, good morning”.

 HOW TO Add HomeKit gear to your home 

Genius Tip!
 Elgato’s Eve app gives 

you the ability to create 
‘rules’, which enable 
certain actions to take 
place when particular 
conditions are met. 
A rule contains three 
components: Triggers, 
Conditions and Scenes. 
Triggers can be location 
or value-based, so you 
could create a rule that 
automatically switches 
the lights on or off when 
you arrive or leave 
home, and another that 
fires up your central 
heating when your Eve 
Room sensor detects 
a drop in temperature.

Jargon Buster
 A geofence is a virtual 

perimeter around a 
particular location that 
you can set to trigger 
certain actions when 
you arrive or leave the 
house. Geofences are 
built into iOS and are 
used in apps like 
Reminders to prompt 
you to do certain things: 
“Remind me to buy milk 
when I get to the shop”, 
for example. Geofences 
are also very useful in 
HomeKit devices, 
because they enable 
your smart home kit to 
take certain actions 
without you having to 
do them manually.

1Add your accessory
To add your first accessory click on the cog 

in the top-right corner of the accessory’s app 
then tap Add Accessory to Home. The app 
detects nearby accessories, provided they are 
powered up and close to your iPhone or iPad.
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oing hand in hand with 
HomeKit, of course, 
is Siri, iOS’s virtual 
personal assistant. 
This means that instead 

of opening an app and tapping to 
get your smart home gear to do 
something, you can ask Siri instead.

Before you start using Siri to 
control your home, you need to give 
every HomeKit-compatible device 
in your home a unique name that 
Siri will recognise. You can’t just 
say, “Hey Siri, switch the table lamp 
on” if you have more than one table 
lamp. The good news is that you can 
also use Siri to action any Scenes 
you’ve set up, so saying “Hey Siri, 
I’m home” will automatically trigger 
lights, heating and anything else 
that you have included as part 
of your ‘Home’ scene. Creating a 
‘Goodnight’ scene will also enable 
Siri to switch off lights and turn 
down your heating, simply by you 
saying “Hey Siri, goodnight”. 

The complete list of HomeKit 
commands is at apple.co/1MAVC5V, 
but here are a few examples:

“Turn on the lights”  
“Turn off the lights”
“ Set the temperature to 22
“Turn on the printer in the office”
“Turn on the living room lights” or 
“Turn off the living room lights
“Set the home to 22 degrees”
“ Set the thermostat downstairs 
to 18 degrees”

“Goodnight”

As more HomeKit-enabled devices 
become available, the more 
capable Siri will come. At WWDC 
2015, Apple announced it was 
adding support for blinds, alarms, 
sensors, doors and windows, as 
well as programmable switches to 
HomeKit, which can be accessed 
securely using the HomeKit Access 
Protocol (HAP), which runs on top 
of Bluetooth.

The ability to take control of 
smart devices in your home may 
seem like a recent development, 
but the technology has been 
around for many years – and 
Apple is far from alone in wanting 
to command this space. One-time 
Apple Store darling Nest (nest.
com) was snatched up by Google 
in 2014, with the company creating 
its own set of ‘Works with Nest’ 
APIs that gadget makers can 
harness for their own devices, and 
it’s iOS-compatible. Rivals also 

include ZigBee (zigbee.org), an 
open standards, cross-platform 
wireless technology that’s been 
around since 2002. There’s also 
Z-Wave (z-wave.com), a proprietary 
home automation technology 
that’s already been integrated into 
hundreds of devices, and is iOS- 
and Apple Watch-compatible. For 
iOS users, HomeKit naturally offers 
the easiest way to get started, but 
rivals such as Savant (savant.com) 
have deeper integration with older 
home automation systems.

Alternative tech

Nest is one of the most popular routes 
into creating your first smart home.

G
Need your smart home to do something? Just ask Siri

Siri commands
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HomeKit gear to buy right now
Ready for some smart home action? You’ll need these…

This thermostat enables you to take control of your 
home’s heating from your iOS device, from home 
or the other side of the world. You can set custom  

on/off times plus temperatures 
for different times of day, and 
Auto Adapt cleverly adjusts 
your heating based on outside 
temperature. Netatmo reckons 
it can also shave up to 37% off 
your energy bill.

This security camera is 
the perfect way to keep 
tabs on what’s going on 
at home, whether you’re 
in or out. It includes motion 
and sound sensors and can 
automatically start recording 
when it detects movement,  
and you can use it as a baby 
monitor too.

Did you remember 
to close that window 
before you left home? 
This contact sensor 
can help tell you if you 
did, by transmitting its 
state to the Eve app on 
your iPhone. You’ll still 
have to go back and 
shut it, though.

This kit of three smart 
bulbs and a HomeKit-
compatible bridge is 
everything you need 
to enjoy atmospheric 
lighting at home. You 
can create custom on/off schedules and change the 
bulb colours to suit your mood, from presets or by 
picking your own. You can sync the bulbs with music 
and movies, and control up to 50 from one bridge.

 £150  FROM netatmo.com  FEATURES Automatic 
temperature adjustment, energy consumption report

 £170  FROM withings.com  FEATURES 1080p Full HD 
recording quality, live streaming, air quality sensor

 £35  FROM elgato.com  FEATURES Wireless contact 
sensor, open/closed states with time and duration data

 £150  FROM philips.co.uk  FEATURES Automated light 
schedules, preset and custom lighting modes

Need to know whether 
to take a brolly or 
a jumper with you 
before you head out? 
The water-resistant, 
battery-powered Eve 
Weather sensor can 
tell relay the essential 
info, both right now 
and over time.

 £100  FROM insteon.com  FEATURES Schedules and 
scenes, works with Insteon and HomeKit devices

 £45  FROM Elgato, elgato.com  FEATURES 
Temperature, air pressure and humidity data

US company Insteon is famous for 
its range of smart home devices, 
which include sensors, door locks, 
fans and security cameras. This 
hub makes most of its products 
compatible with HomeKit.
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Netatmo Thermostat

Withings Home Elgato Eve Door & Window

Philips Hue Starter Kit

Insteon Hub Pro Elgato Eve Weather
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£600!
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Win a Logi Circle camera
Keep your home secure in your absence and win one of five 
Logi Circle security cameras – winner of MF299’s group test!

 It’s always a good idea to keep your 
home safe and secure, especially when 
you’re not in the house itself. A home 
security camera can help you keep an 
eye on things from afar, and in our 
opinion there’s no better option than 
the Logi Circle – after all, it won last 
issue’s group test!

The 135° lens captures great quality 
Full HD video, and its built-in night vision 
ensures nothing is lost when the lights 
go off. You get 24 hours’ worth of cloud 
storage included, so even if the Circle 
gets taken, your recordings are still safe 

to be viewed again. It’s one of the few 
portable, battery-powered IP cams out 
there, so you can position it wherever 
you like for up to 12 hours – no need for 
a mains plug.

But, where the Circle really excels is 
with its iOS app. The handy ‘Day Brief’ 
feature condenses the day’s activity 
into a 30-second clip, allowing you to 
quickly see what happened and when. 
You can control the camera from afar 
through the app, and there’s even a 
microphone so you can keep your pets 
company while you’re away. 

 THE QUESTION
For your chance to win one of five Circle 
security cameras from Logitech, just 
answer the following question:

What is the viewing angle of the 
Logi Circle’s lens?
A) 110 degrees
B) 125 degrees
C) 135 degrees

For more details about Logitech’s 
security camera and other products, 
visit logitech.com.

 To enter, you can visit our website at futurecomps.co.uk/logicircle. 
  For full terms and conditions, go to futurecomps.co.uk/logicircle. By sending your entry, 
you agree to these competition rules and confirm you are happy to receive details of future 
offers and promotions from Future Publishing Limited and carefully selected third parties. 
 This competition closes on 6 June 2016. Over 18, GB residents only.

HOW TO
ENTER...

In association with
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 Awarded to a 
five-star product 
we believe is truly 
exceptional in its 

category. Given solely at the 
discretion of the Editor.

 Given to a 
hardware or 
software product 
that might not be 

the very best in its category, 
but is a noted for affordability.

 Our group test 
winner gets this 
award for being 
the best of its 

kind when pitted against 
other comparable products.

 The MACFORMAT Awards

 Manifesto – our ratings explained

Our authoritative reviews 
help you make more 

informed choices

BUYING 
ADVICE

What’s inside 

92–94  
APPLE KIT 

 Our look at the new 
iPad Pro & iPhone SE

95–97  
MAC HARDWARE 
 New iOS gadgets and a 
‘quantum dot’ monitor

98–101  
GROUP TEST 

 Improve docs with a 
colour laser printer 

102–104  
MAC SOFTWARE 
 Apps to enhance your 

Finder, and more!

105  
iOS SOFTWARE 

 New photo editor, and 
a cool tool for writers

 Our reviews are totally 
independent; we’re not 
affiliated with Apple or 
anyone else, nor are we 
influenced by advertisers. 
You can trust us to give 
an honest assessment 
of a product’s worth.

The prices quoted for 
products are correct at 
the time of writing and are 

the best we can find from 
a reputable online dealer, 
excluding delivery. 

 A brilliant thing in all regards, 
and worth every penny

 Strongly recommended; any 
flaws are only minor concerns

 Worth considering, though 
there may be better options

 Fundamentally flawed; look 
at alternatives as a priority

 A waste of your money and 
everyone’s time; do not buy!

Contact us

 Email your queries 
and your questions to 

letters@macformat.com

 Keep up to date by 
following us on Twitter  

@macformat

 Join the conversation 
at facebook.com/

macformat

 Get the latest 
subscription offers at 

macformat.com

iPHONE 
SE 
p94
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 This iPad’s display has 
me envious, given my 
months-old 12.9-inch 

model doesn’t have it. 
But I’m still uncertain 

about the ergonomics 
of either model being 
used with an external 

keyboard, like a laptop, 
which requires you to 

reach up to the screen 
for many interactions. 

I still prefer to use a 
MacBook for most work 

tasks, beyond typing.

Alan says…

No longer will you feel a bit 
stupid taking an iPad photo 
or video, because the new 

Pro is just as capable as the 
top-end iPhones thanks to its 

brilliant camera and, for the 
first time in an iPad, a flash.
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iPad Pro (9.7-inch)

 From £499  FROM Apple, apple.com/uk
 FEATURES True Tone display, Smart Connector, 12MP iSight camera, 4K video recording

The Air clears to make way for a smaller Pro

T
here’s no denying the 9.7-inch 
form factor is the sweet spot for 
most tablet buyers, and what was 

set to be the iPad Air 3 has turned out to 
be exactly that – except in name. The new 
iPad Pro has very much the same look and 
feel of the feather-light iPad Air 2, but with 
Pro features added: top-end camera tech, 
Apple Pencil support, and the best iPad 
display yet. Incremental improvements you 
might say, suitable and expected of an ‘iPad 
Air 3’, but in combination they make this 
hands down the best iPad model yet, and 
wholly suited to its Pro denomination.

We loved the iPad Air 2. It was an 
expression of Apple’s tablet vision so refined 
that it had seemingly reached the perfect 
balance of features. Apple was confident in 
that, which is why we see exactly the same 
thiness of 6.1mm here and no thinner. We said 
in 2014 that the iPad Air 2 just wouldn’t feel 
right if slimmed down further, and we now 
get an enhanced iPad of the same size and 
weight that made the Air 2 so attractive. 

Tonally good screen
While the Retina display here is identical to 
the Air 2’s in resolution (2048x1536 pixels) 
and density (264ppi), we have little to grumble 
about: it’s pin-sharp, and text in documents 
and Safari, for example, looks just sublime. 
Where the display differs is its anti-reflective 
coating. This particular iPad Pro is touted by 
Apple as 40% less reflective than the Air 2. 
We praised the Air 2 when we reviewed it for 
opening our eyes to how bad previous iPad 
screens were outdoors. We’re impressed 
again, though we struggled to see significant 
gains over the Air 2’s excellent screen.

What we do have is the ability in Settings 
to enable the True Tone feature. iOS 9.3’s 
Night Shift (see page 64) is designed to reduce 
your exposure to blue light by warming up 
the screen. The True Tone element of this 

iPad’s display (at the moment unique to this 
model) is a little like a ‘Day Shift’ feature, 
warming up the screen as it adjusts to 
ambient light. Coming from another iPad 
with a Retina display, you’ll take a little while 
getting used to the warmer look, but it’s a 
welcome change. It’s designed to complement 
Night Shift, and for the most part you won’t 
notice the screen changes colour, particularly 
when Night Shift activates on schedule – 
unless you’ve turned that up high, though 
hardly anyone will find that agreeable!

True Tone isn’t the only display change. 
This iPad Pro has the same P3 colour gamut 
as the most recent 4K and 5K Retina iMacs. 
We can’t complain about this tweak, which 
punches up reds and greens in particular, but 
the results are slightly less pronounced than 
on the iMacs. If you use one of those to edit 
photos, you’ll definitely prefer to have this 
iPad for the sake of consistent presentation.

Pro power
So, this iteration has the perfect form factor 
for most iPad users, a display that’s as yet 
unrivalled in an iOS device, and support for 

Reviewed by CHRISTIAN HALL



9.7-inch iPad Pro APPLE CHOICE

 It’s the perfect 
package for a tablet, 
delivering amazing 
performance, with 
key features from the 
flagship iPhone 6s.

 Stunning performer
 Apple Pencil support
 12MP/4K shooting
 Smartest chassis yet

VERDICT
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Apple’s much-loved Pencil, but how does it 
perform over the many other iPad models that 
are still available to buy today?

It’s powered by the same A9X and M9 
processors from the larger iPad Pro, although 
the Geekbench 3 app confirms that this one’s 
A9X is fractionally underclocked at 2.13GHz, 
compared to 2.24GHz in the 12.9-inch Pro. 
Any app we used to find any recognisable 
performance difference concluded nothing – 
this model is every bit as powerful as it’s 
bigger sibling, and having half the RAM (2GB 
here) makes no apparent difference either.

Our Geekbench tests (taking an average 
of three results) recorded the 9.7-inch iPad at 
5,292 points compared to the 12.9-inch’s 5,508 
on the multicore test. Comparing that to the 
iPad Air 2, it’s in the region of 20% better. 
Both Pros significantly outperform the rest 
of the iPad range, and the slight differences 
between their benchmark scores shouldn’t be 
a factor in choosing which is right for you – 
they are both Pro by name for a very good 
reason. We don’t doubt that this iPad was 
released because of the swell of buyers who 
still want this screen size. If 9.7-inches is your 

preferred option, it’s the most compelling 
upgrade in the iPad range so far.

The final additions that bolster the Pro 
nature of this iPad are a 12MP camera, the 
same as the iPhone 6s and, for the first time 
on an iPad, a flash. It’s easy to snigger at iPad 
photography or video shooting, but with this 
model in your hand you won’t feel like an 
amateur – you’ve got some great photo and 
video kit here. 4K recording is made all the 
more compelling with iMovie’s 4K editing 
update, but perhaps more useful is the 60fps 
setting for 1080p video recordings, in contrast 
with the 30fps limit on the 12.9-inch iPad Pro.

The camera protrudes from the body, just 
like on the iPhone 6 and 6s, but this didn’t 
detract from our enjoyment, and the annoying 
wobble you would expect with the iPad laid 
flat on a table is avoided. We also love the new 
design for cellular models, which dispenses 
with the black or white plastic block in favour 
of an aluminium area instead. Of course, this 
being an iPad Pro, it’s also equipped with 
Apple’s Smart Connector, which allows you 
to attach its external Smart Keyboard for a 
more laptop-like experience.

iPad Air 2 
From £349

SPECIFICATIONS 
  16 or 64GB
  2048x1536-pixel display  
at 264 ppi
 A8X and M8 chips
 8MP iSight camera
  1080p video recording 
at 30fps

iPad Pro (12.9-inch) 
From £679

SPECIFICATIONS 
  32, 128, or 256GB
  2732x2048-pixel display  
at 264 ppi
 A9X and M9 chips
 8MP iSight camera
     1080p video recording 
at 30fps

ALTERNATIVE CHOICES
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iPhone SE
Mini but mighty, the latest iPhone 
is simply a wonder to use

 From £359  FROM Apple, apple.com/uk 
 FEATURES 16GB or 64GB, Retina display, A9 chip, 12MP rear camera, Touch ID

T
he iPhone has been getting 
larger in recent years, but 
unless we’re very much 

mistaken, hands haven’t been evolving 
upwards and outwards at quite the same 
rate. Apple seems to have realised this and 
has done the unthinkable in an age of 
expansion: it’s brought out a smaller iPhone.

At first glance, you might be suspicious. 
Isn’t that the old iPhone 5s chassis? It is, but 
let’s not get too hung up on that. Yes, a new 
design would have been great, but that’s not 
the point of the SE. This is an iPhone aimed 
at upgraders, people who like the guts of the 
iPhone 6s but are put off by the substantial 
size and its equally large price tag. Keeping 
the old design (Apple calls it “beloved”) allows 
for a lower price point.

But, this is not a ‘cheap’ phone. It’s got 
the same A9 chip as the 6s, and the same M9 
motion coprocessor; the same 12MP camera 
with Live Photos; and the same pixel density 
in its Retina display. In some ways, it’s a 6s 
squeezed into a more palm-friendly form. 
In fact, the only things of note that the 6s has 
over the SE are 3D Touch, higher-res front 
camera and the 128GB capacity option. (The 
SE’s maximum is 64GB, and Apple has still 
stuck with 16GB as the entry-level option.)

Great things in small packages
In practice, the SE is an absolute pleasure to 
use. Its display is bright and crisp, and things  
zip along smoothly. The 12MP rear-facing 
camera produces fantastic images, and you 
rarely get the feeling that corners have been 
cut to bring the price down. Most importantly, 
perhaps, it’s easy to use with one hand!

It was in our benchmarking that the SE 
really shone. It beat every iOS device bar the 
iPad Pro in our CPU tests, and just beat the 6s 
in battery life. This kind of performance in 
such a tiny package is staggering.

 Affordable and 
powerful, this is an 

amazing iPhone 
that’s ideal for 

upgraders or those 
with smaller hands.

 Brilliant performance
 Compact design

 You can reach the 
corners with one hand!

 No 3D Touch

VERDICT

This kind of 
performance 
in such a tiny 

package is 
staggering

Reviewed by ALEX BLAKE

If you’re used to Apple’s larger phones, 
the iPhone SE may at first seem a little too 
small. You’ll probably misspell words, and 
content will feel a little more cosy and 
constrained – but this is a minor, passing 
concern; spend a few days with the SE and 
you soon get used to its compact dimensions. 

If you’re upgrading from the iPhone 5s or 
earlier, the SE will be perfect for you. It’s got 
all the grunt of Apple’s plus-size flagships, 
but without the pocket-obliterating, thumb-
straining, self-conscious-phone-call-making 
unwieldiness of the chunkier iPhones. And 
you’ll save yourself a pretty penny, too. In 
fact, this is Apple’s cheapest ever iPhone.

It’s not all perfect. The battery life can’t 
live up to the 6s Plus, and it’s missing a few 
features like 3D Touch and optical image 
stabilisation. But at this price we really can’t 
complain, and our experience has probably 
been tainted by using Apple’s larger iPhones 
for so long – if you’ve never had an iPhone 
bigger than four inches, you’ll have no 
problem. Even if you have, this is a powerful, 
compact phone that demands attention.

It may be housed in an iPhone 5s body, but the 
iPhone SE is a very different experience.

APPLE CHOICE Apple Kit
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360fly

Osmo Starter Kit 
with Numbers

Surround yourself with video

The FaceTime camera kids can love

T
he 360fly is like 
no other action 
camera. The 

exterior is formed of 
geometric patterns that 
form a spherical shape, 
to capture video in all 
directions. There’s no 
housing for the lens, so it’s 
remarkably open to the 
elements, but we found it 
stood up to a variety of 
weather conditions. 

Elsewhere on the body, 
you’ll find a small on/off 
push button on the side, and 
an even smaller microphone 
hole. The camera is water-

T
he iPad has 
become a de facto 
tool for children's 

entertainment and early 
years education, but if you 
fear your little ones are 
getting too much screen 
time, this is a worthwhile 
addition to their fun.

Osmo regains what your 
child may have been lacking 
through overuse of the 
touchscreen – real-world 
interaction. Here, a small 
mirror is placed over the 
front-facing camera of the 

resistant up to 50m – though 
a little rubber plug needs to 
be inserted into the mic hole. 

Although the camera 
is ‘360’, this refers to the 
horizontal rotation – you 
actually get a 240° field of 
view vertically. As the lens 
points up, the sharpest part 
of the what’s captured is 
directly above the camera; 
footage around the edges of 

iPad, while the iPad sits in a 
base unit, slightly tilted back. 
The area immediately in 
front of the child becomes 
the 'playing field', and 
through word, number and 
creative games a child can 
use their hands away from 
the touchscreen to engage 
with the educational games.

You soon realise that it's 
because of the speedy camera 
recognition that this device 
really does work well – it's 
also rather forgiving in terms 
of accuracy of placement 

 Share stunning 
and immersive 

360° video easily and 
without adding extras.

 Well-designed app
 Lacks adjustments

 A combination of 
the physical and 

virtual world that 
really works well.

 Kids will love it
 Longevity is an issue

VERDICT

VERDICT

 £399  FROM 360fly, 360fly.com  
 FEATURES Shock-resistant up to 1.5m, 5 atm water resistance, 

IP6X dust-resistance rating, accelerometer for camera orientation

 £98  FROM Osmo, playosmo.com  FEATURES iPad base unit 
and mirror, five games (three using physical items)

the frame is softer and lacks 
detail, although tone and 
colour are good.

All operations for the 
camera are handled by the 
Bluetooth-enabled 360fly 
app. It’s easy to use, but 
we would have liked some 
flexibility over white 
balance, sensitivity and 
frame rate settings. 
ALI JENNINGS

(something that’d quickly 
frustrate a child if it were too 
fussy). In the Numbers game, 
for example, it takes just a 
fraction of a second to add up 
the total of the tiles that a 
child has arranged, and they 
don't need to be at all straight 
or neatly arranged, Osmo 
just 'sees' it (as long as they 
aren’t out of camera range). 

Osmo is simple, fast, and 
generally has good quality 
games. But, many App Store 
learning apps go deeper for 
less cost. CHRISTIAN HALL

The large lens has a 
360° horizontal view, 
and 240° vertically.

Osmo’s Numbers game 
adds up the value of tiles 
in its view. It's real-time 
and a child doesn't need 
to be too neat either.
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Philips 276E6ADSS
A reasonably priced display 
that’s great for design work

 £240  FROM Philips, philips.co.uk  FEATURES 1920x1080-
pixel resolution, HDMI, DVI-D, VGA, audio passthrough

M
ost monitors 
produce colour 
that, well, 

most people would be 
happy with, but if you’re serious 
about your Photoshop work, video 
editing, page layout or any other 
creation, you shouldn’t settle for 
‘average’. Philips says this display 
reproduces 99% of Adobe RGB, the 
colour space that’s relied on by media 
pros. The focus on colour reproduction 
means it doesn’t have any extra features. 
There are no passthrough USB ports or 
built-in speakers, but there is a passthrough 
audio jack if you connect to your Mac using 
HDMI. The official name of this display is the 
276E6ADSS, but that’s so unmemorable that 
we’ll call it the 27-inch E-Line.

Aesthetically, this is a moderately 
elegant-looking device. It has a white bezel 
around the 27-inch LCD panel, and it rests on 
a slim, curved aluminium base. It has a 25° 
range of tilt, although only five of those are 
leaning back from vertical. We should add 
that this was fine in our studio environment, 
and it also has an extremely good viewing 
angle range. The specifications say this is 178° 
both vertically and horizontally; we prefer to 
say that what’s on the screen looks the same 
until you’re so nearly edge-on that it’s silly 
looking any more. So, the 27-inch E-Line gets 
a definite thumbs-up from us here.

Philips says this is the first monitor with 
‘Quantum Dot Colour Technology’, using 
nanomaterial that produces more precise 
colour control. The 99% Adobe RGB claim 
that Philips makes is a bold one. There are 
monitors that achieve this but, really, the vast 
majority settle at achieving the colour range 
of the more basic sRGB gamut. We tested the 
display with Datacolor’s Spyder and found 

 A very high-quality 
LCD panel that’s 

better than almost 
anything in its class, 
but its build quality 
doesn’t match that.

 Almost 100% Adobe 
RGB colour rendering
  Audio passthrough

 Cheap-feeling body
 Awkward controls

VERDICT

The 27-inch 
E-Line offers 
great colour 

accuracy, but 
its case isn’t 

as impressive

Reviewed by KEITH MARTIN

that our review unit achieved 98% of Adobe 
RGB, which is a negligible variance – you’re 
not going to notice it in practice.

Movies, crops and filters
On the technical front, the 27-inch E-Line is a 
really impressive display, but it isn’t all roses. 
The gloss-white plastic casing looks good, but 
it’s rather thin and prone to bending if you 
grip the top or the sides. It creaks and pulls 
slightly away from the LCD panel when tilted 
forward or back, somewhat undermining the 
display’s credentials as a high-quality device.

The buttons for power, calling up the 
on-screen controls and configuration are 
touch-sensitive spots under the front edge. 
There’s no tactile element, and you’ll have to 
look carefully to ensure you tap the right bit of 
smooth plastic, so it’s an annoyance that 
they’re halfway out of sight. We’ve seen this 
before, but it’s form over function.

The LCD display’s quality is undeniably 
great. Yes, you can find a Full HD, 27-inch 
display for £100 less, but you won’t get this 
one’s level of colour reproduction. The case’s 
quality isn’t as good, and the controls (like 
many) are annoying. Once it’s set up, though, 
you’ll rarely need them – except the power 
‘button’. We’re torn. You’ll simply have to 
decide whether build or colour matters most.

The 27-inch E-Line’s 
range of viewing angles 
is incredibly good.

APPLE CHOICE Mac Hardware



Head to Head APPLE CHOICE

VERDICT

JUNE 2016 | MACFORMAT | 97 macformat.com  @macformat

 A room-filling and surprisingly powerful 
speaker with Spotify Connect and a seamless 

set-up process. A superb performer.

 A solid speaker with good input and output 
options, but perhaps lacking the design finesse 
and transparent set-up options of some rivals.

Great sound and a physical 
remote for better manual control

An unusual design that results 
in crisp, room-filling sound 

 £400  FROM Cambridge Audio, cambridgeaudio.com  
 FEATURES Wi-Fi or Ethernet, Bluetooth, 3.5mm aux input

 £499  FROM Bowers & Wilkins, bowers-wilkins.co.uk  
 FEATURES Wi-Fi or Ethernet, Bluetooth, 3.5mm aux input

Ease of setup 
Download the app for iOS or Mac and in just a few taps the 
Zeppelin is connected to your Wi-Fi network. Connecting 

over AirPlay is a breeze, and you can link up using 
Bluetooth from any device that can stream audio. 

Network performance 
We saw virtually no startup lag when streaming music 

over AirPlay, and no dropouts while moving around our 
home. Bluetooth’s range is shorter, but it was equally 

impressive, maintaining a connection from the next room. 

Sound quality 
The Zeppelin is capable of astonishing volume given its 

size, and the clever design means that while bass is deep 
and rich, and mids and treble are crisp, a good balance is 
always maintained. This thing sounds much bigger than 

it has any right to, with fantastic clarity and accuracy.

Inputs and outputs 
There’s no physical remote, but there are handy controls 
on the unit for playback, volume and Bluetooth pairing. 

An Ethernet port is provided, as well as a mini jack 
auxiliary input for connecting cabled audio devices.

Ease of setup 
The speaker has an option to join your Wi-Fi network, 
but we had some difficulty at first getting this to work. 
Wi-Fi setup could perhaps be more streamlined, though 
streaming over Bluetooth was simple to set up. 

Network performance 
We had no issues streaming from different devices over 
Wi-Fi. Bluetooth performance was also excellent, with the 
speaker using aptX technology to more efficiently transfer 
high-quality audio streams between different locations. 

Sound quality 
A well-rounded sound with plenty of bass, though not at 
the expense of a balanced sound stage. Mids are solid, 
treble is crisp, and there’s plenty of power. Cambridge uses 
Balanced Mode Radiator technology to provide a sound 
that’s more room-filling and less directional. 

Inputs and outputs 
You get a physical remote and Ethernet, plus a manual 
bass level control on the back. A standard mini jack input 
for older MP3 players is joined by phono aux inputs, giving 
you more flexibility to connect other gear like turntables. 
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COLOUR LASER 
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Reviewed by CLIFF JOSEPH

T  raditionally, the printer market 
has been divided into two quite 
distinct categories. Inkjet printers 

were the low-cost option for home users, 
while businesses had to fork out hundreds – 
or even thousands – of pounds for high-speed, 
high-quality, network-connected laser 
printers. But, in recent years, those categories 
have become a bit fuzzy around the edges. 
The latest inkjets are starting to rival laser 
printers for speed and quality, while laser 
printers have come down in price to the point 
where they are now well within the budget of 
many home workers and small businesses. 
With that in mind, we’ve gathered together 
a number of affordable colour laser printers 
aimed at those kinds of buyer.

The traditional strengths of the laser 
printer remain the same, though. If you want 
to impress your colleagues and clients, then 
the high-quality text output of a laser printer 
is hard to beat, and even the low-cost laser 
printers that we’ve gathered together for this 

review can churn out pages at speeds no 
comparably-priced inkjet printer can hope 
to match. A low-cost laser printer does have 
to make some compromises, though. You’re 
unlikely to find a multifunction laser printer 
that also includes a scanner, copier or fax for 
less than £200, whereas those features are 
now standard even on inkjet printers costing 
less than £100. The traditional Achilles’ heel 

of the laser printer hasn’t gone away either, 
and they can’t match the high-quality glossy 
photo prints that you can get from even really 
low-cost inkjet printers. Even so, with more 
people now working from home, there’s a real 
demand for affordable colour laser printers 
that provide professional quality for your 
business documents and marketing materials.

How we tested
 To assess text quality 

we used a text-only 
document in Microsoft 
Word, which included a 
number of fonts, sizes 
and styles. For colour 
printing we used a PDF 
marketing brochure that 
combines text with 
some small product 
photos, graphs and 
charts. Laser printers 
aren’t designed for 
photographic work, 
but presentations and 
product brochures 
might occasionally 
require photo output, so 
we also included one A4 
photo print in our tests. 

PRINTERS  
ON TEST…
 Brother HL-3150CDW
 Canon LBP7110Cw
 Dell H625cdw
 Epson Aculaser C2900N
 Samsung Xpress C1810W
 Xerox Phaser 6500

If you want to impress your 
colleagues and clients, then 
a laser printer is hard to beat

 macformat.com  @macformat

Good quality laser 
printers aren’t just 
for big business 
users any more
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Things to consider…

…or lower?
 The cheapest colour 

laser printer we’ve ever 
seen is Oki’s C301dn 
(£80). Oki quotes speeds 
of 22ppm, but we 
wouldn’t bet on it.

Everything you need to know before getting started

1 Starter kits
Watch out for low-capacity ‘starter 

cartridges’. The Canon and Samsung printers 
reviewed here are cheap, but may only print 
800–1,000 pages before running out of toner.

2 Short fuse
As well as toner cartridges, laser printers 

also have mechanical parts, such as the ‘fuser’ 
that applies toner to paper. These may need to 
be replaced every 2–3 years, so check the cost.

3 In design
The Epson and Xerox printers support 

Adobe’s PostScript programming language, 
useful for designers who work with apps like 
Adobe Illustrator or InDesign.

4 Month by month 
Printer manufacturers give their printers 

a ‘recommended monthly volume’, indicating 
how many pages should be printed each month. 
It’s usually around 1,000–1,500 pages.

5 Size isn’t everything 
The more compact laser printers, like 

Brother’s HL-3150CDW, can match the speed, 
quality and features of big beasts like the Dell 
H625cdw – useful when space is at a premium.

6 Say cheese 
Inkjet printers still have the edge when 

printing photos. There are also specialised 
inkjet printers that use more inks for really 
accurate colour reproduction.

Colour Laser Printers APPLE CHOICE
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Higher:
 HP couldn’t find a 

low-cost laser for this 
review, but its Color 
LaserJet M553n zips 
along at 38ppm for a 
price of around £280.
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  As you’d expect, all these printers 
include a USB interface to connect 
directly to a Mac. The Brother, Dell, 
Canon and Samsung printers also 
have Wi-Fi for network connectivity, 
so that you can share the printer 
with other people on your home or 
office network. If you’re using an 

iOS device for office work, you’ll also appreciate the AirPrint 
support provided by Brother, Dell and Samsung. Canon 
doesn’t support AirPrint, but does provide a printing app for 
iOS devices. However, the Epson and Xerox printers are older 
models that lack Wi-Fi and rely primarily on Ethernet for their 
networking features. Many people – including the MacFormat 
team – do prefer to use reliable old Ethernet for their office 
network, so that’s not necessarily a deal-breaker, but it does 
mean that these printers aren’t ideal for use with iOS devices.

  The low-cost laser printers we’ve 
tested here really aren’t much more 
expensive than inkjet printers, but 
they do have to make a few 
compromises in order to keep the 
price down. Most of them are 
single-function printers, and it was 
only Dell’s multifunction H625cdw, 

pushing our price limit at £240, that includes a scanner as well. 
Dell and Brother were the only manufacturers to include 
duplex (two-sided) printing, although Samsung does include a 
manual duplex option with its C1810W.

One other thing to consider is size. The Canon, Brother and 
Samsung printers are relatively compact – just about small 
enough to fit onto a shelf in a small home office – but the bulky, 
heavy printers from Dell, Epson and Xerox will require a table 
all to themselves in your workspace.

 One of the main advantages of a 
laser printer over less expensive 
inkjet printers is the crisp, smooth 
text output that provides the very 
best quality for business documents. 
The six laser printers in this group 
test all share the same 600x600dpi 
resolution and produce similar high- 

quality text output. The same was true with our PDF test 
documents, which combined text with simple colour graphics.

Some laser printers can print on glossy photo paper, but 
laser technology still isn’t ideal for printing larger, high-quality 
photographs. The A4 photo prints produced by Brother, Epson 
and Xerox were rather grainy, while Canon’s printer noticeably 
oversaturated the colours. Dell’s photo output came out rather 
dark, while Samsung managed to be both grainy and dark. In 
other words, inkjet printers still rule the photo-printing roost.

 If you thought inkjet cartridges 
were expensive, wait until you see 
the cost of laser toner cartridges. 
A complete set of four CMYK 
cartridges can easily set you back 
£200 or more. Fortunately, you’ll get 
2,000–3,000 pages out of each set of 
them, which makes the pain a bit 

easier to bear. Watch out for Xerox, though, which sells its 
colour cartridges in two sizes. The standard ones work out at 
a whopping 15p per page for colour printing, so you need to get 
the XL cartridges to bring that down to about 9.5p, which is in 
line with the other printers in this test for colour printing. 
Mono (black-only) printing is fairly consistent across the group 
at around 2p per page, but Dell’s standard black cartridges 
work out at an extravagant 4p per page. Its XL cartridge is a 
better deal, bringing that cost down to a more competitive 1.8p.

TEST RESULTS

TEST RESULTS TEST RESULTS

TEST RESULTS

Test 1 Features

Test 3 Laser quality Test 4 Running costs

Test 2 Connectivity
Which features are right for you?

High-quality text and graphics? Keep an eye on ongoing costs

A good office printer can be shared

Brother HL-3150CDW  

Canon LBP7110Cw 

Dell H625cdw   

Epson C2900N    

Samsung C1810W  

Xerox Phaser 6500   

Brother HL-3150CDW  

Canon LBP7110Cw 

Dell H625cdw   

Epson C2900N   

Samsung C1810W  

Xerox Phaser 6500   

Brother HL-3150CDW  

Canon LBP7110Cw 

Dell H625cdw   

Epson C2900N   

Samsung C1810W  

Xerox Phaser 6500   

Brother HL-3150CDW  

Canon LBP7110Cw 

Dell H625cdw   

Epson C2900N   

Samsung C1810W  

Xerox Phaser 6500   



Colour Laser Printers APPLE CHOICE

 How 
do they 
compare?

Paul says…

The HL-3150CDW from Brother has a great balance of 
features, from high-quality prints to fast output.

 The ever-dropping 
prices of laser printers 
really makes them 
accessible to a lot more 
people than ever before. 
Making the decision 
between inkjets and 
lasers is much harder 
than it used to be – but 
it’s a nice problem to 
have with printers as 
good as these!

H625cdw and Brother’s more compact 
HL-3150CDW. On paper, Dell has an edge on 
speed at 23ppm, but Brother’s 18ppm should 
still be perfectly adequate for most people, 
and its lighter and more compact design 
makes the HL-3150CDW the best all-round 
option for use at home or in a small office. 
That gets it the nod from us.
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L
aser printing is a mature technology 
that’s been around for decades, and 
we’d be hard pushed to choose 

between these six printers when it comes to 
the quality of text and colour graphics they 
produce. That means your choice will largely 
depend on price and any specific features that 
you may require. If you’re a graphic designer, 
the PostScript support of the Epson C2900N 

and Xerox Phaser 6500 could be useful, with 
Xerox having a slight edge on pricing. 

For more general office use, we’d be 
inclined to focus on features such as duplex 
printing and Wi-Fi connectivity – preferably 
also with AirPrint for iOS devices. That 
narrows the choice down to Dell’s monolithic 

THE WINNER Brother
Size isn’t everything…

We’d be hard pushed to 
choose between these six 
printers when it comes to the 
quality of text and graphics

>THE SPECS > Brother > Canon > Dell > Epson > Samsung > Xerox

PRICE £190 £150 £240 £210 £160 £175

RESOLUTION 600x600dpi 600x600dpi 600x600dpi 600x600dpi 600x600dpi 600x600dpi

SPEED 18ppm 14ppm 23ppm 23ppm 18ppm 23ppm

iOS DEVICE 
COMPATIBILITY

AirPrint Canon Print app AirPrint n/a AirPrint n/a

CONNECTIVITY
Wi-Fi, Fast Ethernet 
(10/100), USB 2.0

Wi-Fi, Fast Ethernet 
(10/100), USB 2.0

Wi-Fi, Gigabit Ethernet, 
USB 2.0

Wi-Fi, Gigabit Ethernet, 
USB 2.0

Wi-Fi, Gigabit Ethernet, 
USB 2.0

Gigabit Ethernet,  
USB 2.0

DUPLEX PRINTING Yes No Yes No Yes (manual) No

PAPER TRAYS 
(INPUT/OUTPUT)

250/100 sheets 150/124 sheets
250/150 sheets + 
50-sheet second input

250/150 sheets 250/100 sheets 250/150 sheets

DIMENSIONS 
(HxWxD)

24x41x46.5cm 25.5x40.6x45.4cm 50x42.9x50.4cm 41.6x40.4x44cm 26.4x42x42.6cm 41.6x40.4x42.6cm

 FEATURES

  CONNECTIVITY

 LASER QUALITY

 RUNNING COSTS

 FINAL VERDICT
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Being able to access your file system, favourites and 
Finder windows from the menu bar is handy.

 macformat.com  @macformat

Default 
Folder X 5
Power up file management

 £27.09  FROM St. Clair Software, stclairsoft.com 
 NEEDS OS X 10.10 or higher

A
pple’s drive towards minimalism 
can prove frustrating in Open 
and Save dialogs, which have 

barely changed as OS X has evolved. 
Aside from some stashed favourites and a 
handful of recent places in a pop-up menu, 
they do little to speed up your workflow. 
By contrast, Default Folder X is chock-full 
of features that power up these dialogs in a 
major way, and boost other key areas of OS X.

The first time you use Default Folder X, 
its presence is felt. It surrounds the Open and 
Save dialogs, adding several new menus. 
These house all manner of commands, 
including the means to change a selected item 
(rename, duplicate, compress, and so on), and 
access to recent files, folders and open Finder 
windows and tabs. A less obvious but hugely 
useful transformation is the switching of the 
menu for accessing recent places and folders 
above the current location for one that lets you 
browse the entire file system at speed.

Access all areas
This menu is optionally mirrored in the menu 
bar and Finder’s toolbar, and there are other 
goodies lurking outside of Open and Save 

dialogs. Default Folder X’s extensive 
preferences enable you to define keyboard 
shortcuts for menu commands and favourite 
folders, the latter vastly speeding up access to 
key locations when using Finder or opening/
saving files. You can also create folder sets 
(for example, to have unique folder shortcuts 
for individual projects), which can be selected 
from the aforementioned menus. In addition, 
default folders can be defined for individual 
apps, and limited to a specific extension. 
So if you usually save TIFFs in one place but 
JPEGs in another when working in an image 
editor, you can configure the app to 
automatically go to the correct initial location 
to open or save a file according to its type.

This is all good stuff, but the latest version 
of Default Folder X isn’t all sunshine and 
roses. Although it adds full compatibility 
with El Capitan, it sometimes feels sluggish. 
It’s noticeably slow to appear when activated, 
and lags a touch when shortcuts are invoked. 
We also found the new features hit and miss. 
It’s great to have a recent files list and fast 
access to Finder tabs, but the new sidebar for 
stashing documents (available as a drawer in 
Finder) seems superfluous. Also, while we 
appreciate the app adding a tagging system 
for files and folders, we didn’t use it much 
after our initial curiosity wore off.

There’s also an ongoing nagging feeling 
that Default Folder X can be initially baffling 
and overwhelming – something that new 
features and added complexity fail to dispel. 
Still, as ever, it remains an app that rewards 
investment. Spend some time learning the 
ropes and setting things up, and you’ll gain 
many more savings in the long run; chances 
are, Default Folder X will become one of those 
apps your Mac feels naked without.

 Occasionally slow 
but still indispensable, 

Default Folder X is 
a huge timesaver 

 Speeds up navigation
 Per-app defaults
 Folder shortcuts

 Sluggish to activate 

VERDICT

Default Folder 
is chock-full of 
features that 

power up 
Open and 

Save dialogs

Reviewed by CRAIG GRANNELL
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TextSoap 8
Give reused text a good scrub

A
nyone who works 
with text, whether 
writing, editing or 

repurposing it, knows the 
pain of trying to work with 
the same passages of text 
in different tools.

TextSoap 8 is designed to 
fix this problem and many 
more that occur when taking 
text written in one tool and 
pasting it into another. For 
example, when someone 
sends you text in the body of 
an email that’s destined for 
your InDesign layout, you can 
use TextSoap to strip out stray 
hard returns so you won’t 
have to track them down later.

A
irfoil has been 
a popular audio 
utility for many 

years, and it’s still adding 
new features that make it a 
useful tool for people who 
need precise control over 
their Mac’s audio output.

This new version adds the 
ability to stream to Bluetooth 
speakers in addition to 
AirPlay speakers and devices 
such as the Apple TV (which 
were already supported). Of 
course, Bluetooth is already 
built in to your Mac, but 
Airfoil gives you more control 
by allowing you to select just 
one specific app – such as 

Version 8 has a new look 
that, while not perfect, is 
much more in keeping with 
El Capitan’s flat, pared-back 
aesthetic than previous 
TextSoap versions. Also new 
is the custom cleaner editor. 
Cleaners are actions in 
TextSoap that carry out 
specific functions on text. 
There’s a library of over 100 of 
them, but the custom cleaner 
editor allows you to add more 
by creating your own. 

iTunes or Spotify – as the 
audio source. Any other audio 
played on your Mac, such as 
BBC iPlayer running in 
Safari, will then continue 
to be played on your Mac’s 
internal speakers. This will be 
useful if you want to stream 
music to another room while 
using your Mac or if, like us, 
you like to listen to music on 
Bluetooth speakers while 
hearing a game’s sound effects 
coming from your Mac.

 $39.99 (about £28)  FROM Unmarked Software, unmarked.com  
 NEEDS OS X 10.10 or higher

In use, we found TextSoap 
worked well and did all we 
asked of it. Its interface isn’t 
as polished as we’d like: the 
buttons on the toolbar look 
like an afterthought, for 
example. On the plus side, 
support for OS X’s Services 
means you don’t even have 
to open TextSoap to use its 
functions; just call them from 
the contextual menu in any 
app that supports Services. 
KENNY HEMPHILL

You can also create a 
multiroom audio system by 
sending your audio source to 
multiple speakers, and Airfoil 
includes a free app called 
Satellite that streams audio to 
other Macs, iOS devices, and 
even Windows PCs.

Airfoil isn’t too expensive, 
and there’s a trial version that 
streams music for 10 minutes 
at a time to give you a taste of 
its capabilities before you buy. 
CLIFF JOSEPH

 If you need to clean 
up text for reuse, 

you’ll find TextSoap to 
be a real timesaver

 Lots of one-click fixes 
 Interface lacks polish

VERDICT

 A clever tool with 
more control than 

conventional Bluetooth 
and AirPlay streaming. 

 Selective streaming
 No video streaming 

VERDICT

Airfoil 5
An ingenious wireless audio tool
 $29 (about £20)  FROM Rogue Amoeba, rogueamoeba.com  
 NEEDS OS X 10.9 or higher

Mac Software APPLE CHOICE

If you can’t find a Cleaner in the 
library, you can create your own.

Airfoil lets you stream audio 
from an individual app.
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Day of the 
Tentacle
A true classic of 1993 gets a facelift

F
ew games remain 
playable decades 
after their original 

release, but this LucasArts 
point-and-click adventure 
holds up extremely well. 

DOTT is a time-travelling 
romp through a world where 
Purple Tentacle, a creation of 
mad scientist Dr. Fred Edison, 
has drunk toxic sludge that’s 
only caused a further thirst – 
for power. Edison’s set to kill 
Purple and his brother Green, 
until Bernard Bernoulli and 
his roommates Laverne and 

U
nless you’re a bit 
weird and don’t 
care about the data 

on your Mac, you have a 
duty to safeguard it against 
drive failure. Rather than 
making assumptions about 
the type of backup you want, 
Get Backup Pro offers four 
alternatives: ‘Backup’ copies 
user-defined items to another 
location; ‘Archive’ encrypts 
and compresses a volume or 
selected files; ‘Clone’ creates 
a bootable backup; and ‘Sync’ 
keeps things synchronised 
between computers or drives.

All four types use broadly 
the same method: create a 

Hoagie dash to Green’s aid, 
dumbly unleashing his evil 
brother at the same time. 

As Purple sets to work on 
world domination, Edison 
sends Hoagie and Laverne 
into the past and future using 
time machines made from 
portable toilets. You control 
the student protagonists, 
flushing items scavenged 
from three time periods to 
each other to manipulate the 
timeline and save the future.

project, decide on settings 
(exclusions, incremental/full, 
scheduling), and let the app 
get on with it. Sync’s ‘never 
delete anything’ option means 
you could constantly archive 
downloads to a huge drive. 
Projects can be coloured to 
help you easily check statuses.

Reliability is key in this 
kind of app, and we had few 
problems during testing. The 
app appeared slower to gather 
file data and clone things than 

 £10.99  FROM Double Fine Productions, doublefine.com  
 NEEDS OS X 10.6.6 or higher

This version’s voice acting 
is free of the crackles of 1993 
audio compression, and its 
redrawn graphics retain the 
original’s essence. Frames of 
animation remain few, though 
arguably that reinforces some 
quirky characterisations. The 
oddball concept means really 
having to think out of the box 
to solve some puzzles, though 
trying out things is just part 
of the frivolous fun. Get this 
game! ALAN STONEBRIDGE

SuperDuper, and there was a 
more noticeable performance 
hit in cloning, but the bootable 
clone worked. The exclusion 
and scheduling features did 
their jobs ably, and sync jobs 
impressed by not seeming to 
hurt performance at all.

You’re unlikely to switch 
from an already dependable 
back-up app, but this one’s 
low price makes it worth a 
look for alternative kinds of 
backup. CRAIG GRANNELL

 A preposterous plot, 
nice visuals and great 
voice acting add up to 
a chucklesome caper.

 Restrained remaster

VERDICT

 With plenty of 
options and a great 
interface, this is an 

excellent backup tool. 

 Nice interface design
 Excellent value

VERDICT

Get Backup Pro 3
This utility has your data covered
 £14.43  FROM BeLight Software, belightsoft.com  
 NEEDS OS X 10.9 or higher

APPLE CHOICE Mac Software

What possible harm could one 
insane, mutant tentacle do?

Get Backup Pro has plenty of options, yet its 
interface is friendly and straightforward.

 Some jokes lost in time



 macformat.com  @macformat JUNE 2016 | MACFORMAT | 105

ProCam 3
A huge collection of editing tools

T
his peculiar grab 
bag of tools for 
taking and editing 

photos and videos with 
your iPhone or iPad lacks 
polish, but it might contain 
just what you need.

Like many other ‘pro’ 
camera apps, ProCam allows 
you to  set exposure, shutter, 
ISO, focus and white balance 
manually – in a slightly fiddly 
but usable manner – as well as 
changing the aspect ratio and 
showing a range of grids to 
help compose dynamic shots. 
You can save in TIFF format 
rather than JPEG, toggle 
geotagging, and burn location 

U
lysses is one of 
our favourite Mac 
writing apps. It’s a 

fast and flexible text editor 
with Markdown support, 
which enables you to 
format documents or add 
links and other code with a 
few keystrokes. The arrival 
of an iPad app made it even 
more useful, and now there’s 
an iPhone version too.

Ulysses’ file management 
feels more like Mail than 
Finder: you create folders and 
subfolders, and then your 
documents are ‘sheets’. These 
can be dragged from folder to 
folder, and they automatically 

info and/or copyright into the 
picture itself.

Some features miss the 
mark for pros; the histogram 
is coarse and only shows 
overall light, not per-channel 
levels, and focus peaking 
(highlighting in-focus areas 
with an outline) needs 
conscious interpretation 
rather than being a quick 
shortcut when focussing 
manually. But there’s still 
loads of useful stuff here. 

sync with iCloud as you work 
on them. You can export your 
sheets in text, PDF, ePub, 
HTML or DOCX format.

Let’s be honest: the iPhone 
isn’t the best device to write 
on. However, Ulysses makes 
it as pleasant as possible with 
formatting and code options 
just one tap away from the 
keyboard, plus there’s easy 
access to tagging, image 
attachments, notes and 
writing goals. Pure HTML 

 £3.99  FROM Samer Azzam, procamapp.com  
 MADE FOR iPhone, iPod touch, iPad, Apple Watch

There’s a slow shutter mode, 
with presets for motion blur 
and light trails, and you can 
lower the shooting resolution 
of video, then add music when 
editing it, and extract frames.

Some options seem a bit 
pointless, but there are useful 
tools to be found. We wish the 
app looked as polished as 
Camera+, and there are some 
feature and interface gaffes, 
but there’s a lot on offer. 
CHRISTOPHER PHIN

confuses it – you need to mark 
the insertion point as a code 
block before adding your code 
– and the lack of WordPress 
output is a strange omission, 
but it’s easy to send HTML to 
the Clipboard and then paste 
it into a blog or CMS.

Ulysses’ publicity focusses 
on novels and journalism, but 
it’s great for scripts, blogs, 
note-taking and organising 
ideas too. It really is a superb 
app. GARY MARSHALL

 Reasonably priced, 
even if the selection 
of tools sometimes 

seems a little random. 

 Some tools are great…
 …but plenty aren’t

VERDICT

 Not just for novelists. 
This is a superb app 

for any kind of writing 
and any kind of writer.

 Extremely fast
 Lots of shortcuts

VERDICT

Ulysses Mobile 
You’ll love this app for writers
 £18.99  FROM The Soulmen, ulyssesapp.com  
 MADE FOR iPhone, iPod touch, iPad

APPLE CHOICE iOS Software

The geotagging feature is 
useful for quick organisation.

Ulysses is optimised for iOS devices 
and makes full use of larger displays.
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 Ever since the famous Bondi Blue iMac debuted 
way back in August 1998, Apple’s all-in-one 
desktop computer has been setting standards 
in gorgeous design and powerful performance. 
Apple’s spirit of innovation was as clear back then 
as it is today – the iMac was the first Macintosh to 
abandon the floppy disk in favour of USB ports, 
and its bright, colourful aesthetic set it apart as a 
playful pretender in a world of staid beige boxes.

These days Apple is again pushing boundaries 
with the iMac, blessing all of its 27-inch models 
with the world’s best display, which has a massive 
5K (5120x2880) resolution. Add in a quad-core 
Intel Core i5 processor (configurable from 3.2GHz 
up to 4.0GHz), 8GB of RAM, a fast and capacious 
Fusion Drive, and a powerful AMD Radeon R9 
graphics processor – and the large iMac is the 
desktop system to own. In 2015, Apple lowered the 
price of the top-spec 27-inch model by £150 and 
introduced the first 21.5-inch iMac with a Retina 
4K display. All iMacs (except the entry-level, 
21.5-inch model) have a quad-core processor.

 MODEL  KEY SPECIFICATIONS  PRICE

21.5-inch 
2.8GHz  
quad-core  
Intel Core i5

RAM 8GB of 1867MHz LPDDR3
GRAPHICS Intel Iris Pro Graphics 6200
STORAGE 1TB (5,400rpm)
DISPLAY 1920x1080 (IPS, sRGB gamut) 
ALSO Magic Mouse 2, Magic Keyboard

£1,049

21.5-inch 
3.1GHz  
dual-core  
Intel Core i5

RAM 8GB of 1867MHz LPDDR3
GRAPHICS Intel Iris Pro Graphics 6200
STORAGE 1TB (5,400rpm)
DISPLAY Retina 4K (IPS, P3 gamut)
ALSO Magic Mouse 2, Magic Keyboard

£1,199

27-inch 
3.3GHz  
quad-core  
Intel Core i5

RAM 8GB of 1867MHz DDR3
GRAPHICS AMD Radeon R9 M395
STORAGE 2TB Fusion Drive 
DISPLAY Retina 5K (IPS, P3 gamut)
ALSO Magic Mouse 2, Magic Keyboard

£1,849

 iMac

 Choose an iMac

  Inside your buying guide…

 Who’s it for?
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W
elcome to MacFormat’s Store Guide, the place to go to find out 
about all the Apple kit that matters – updated this issue to 
include the revamped 12-inch MacBook with speedier specs. 

We’ve chosen our top products from Apple’s product line-up, plus the 
best third-party kit that meets our quality standard.

Whether you’re a recent convert or a seasoned Apple user, we highlight 
a model of each product that’s ideally suited to your needs. So, check our 
handy tables to see which Mac, iPad or iPhone is best for you. We’ve also 
highlighted the gold standard in audio, storage, cameras, and many other 
categories to complement your Mac or iOS device with the best accessories.

Your complete guide to the 
best Apple hardware and 
third-party accessories

EDITED BY ALEX BLAKE 
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ENTRY LEVEL
 You’re just getting 

started in the world 
of Apple and need to 
know where to begin.

UPGRADER
 A firm Apple user, 

you’re ready to move 
on and get even more 
from your tech.

HIGH END
 Apple is your life. 

You prize quality and 
want the best that 
money can buy.

UPDATED
OCT 2015
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LATE 2016
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 The baby of Apple’s laptop family, 
the MacBook was recently updated 
with slightly improved specs and a new 
Rose Gold colour. Weighing in at just 
0.92kg, it’s Apple’s most lightweight 
laptop but still packs in a 226ppi pixel 
density in its 12-inch Retina display.

The MacBook is powered by an Intel 
Core M processor (at 1.1GHz, 1.2GHz or 
1.3GHz), which doesn’t require a fan to 
keep cool, so the MacBook runs silently. 
It also features a Force Touch trackpad, 
which can trigger different responses 
as you apply more pressure. All models 
of the MacBook come with 8GB of 
1866MHz memory, with no option to 
add more, and Intel HD Graphics 515 – 
that’s 25% faster than the previous 
iteration – and there are 256GB or 
512GB flash storage options. There are  
four colour options: Silver, Space Grey, 
Gold, and the new Rose Gold. 

 Following hot on the heels of the 
MacBook, the MacBook Pro recently 
gained a Force Touch trackpad. At the 
same time, the MacBook Pro range saw 
small boosts to its Intel and graphics 
processors. The top-of-the-line model 
is currently the only one to offer a 
discrete graphics processor, in the form 
of the AMD Radeon R9 M370X – the 
other models have an integrated Intel 
Iris or Iris Pro graphics processor.

All except the entry-level MacBook 
Pro are equipped with a Retina display, 
in either 13-inch or 15-inch sizes. They 
also have two Thunderbolt 2 and two 
USB 3.0 ports, an SDXC card reader, 
and their flash storage ranges from 
128GB to 1TB, depending on the model 
you pick as a starting point. Battery life 
is also improved, with the 13-inch model 
lasting 10 hours and the 15-inch model 
going strong for nine hours.

 If you need power – and we mean 
serious power – this is the computer 
for you. Even the entry-level model 
comes with 12GB of RAM, a quad-core 
3.7GHz processor, 256GB of speedy 
PCIe flash storage and dual AMD 
FIrePro D300 graphics cards. However, 
with a price point to match, it last being 
updated in 2013, and Thunderbolt 3 
just around the corner, consider 
holding out for the next version.

 A welcome update in 2014 brought a 
£100 price drop to the most affordable 
Mac. The mini has some interesting 
talking points: the entry-level model 
has a 1.4GHz dual-core Intel Core i5 
processor and 4GB of RAM, making it 
akin to the entry-level MacBook Air 
but with a 500GB hard drive and no 
display. Higher end models come with 
1TB storage (a Fusion Drive option is 
available), 8GB of RAM, a better 
graphics processor and either a 2.6GHz 
or 2.8GHz Intel Core i5 for £569 and 
£799, respectively. Those models can 
be upgraded to Core i7 processors, 
though there are no quad-core options 
available – you’ll need an iMac for that.

 MODEL  KEY SPECIFICATIONS  PRICE

12-inch 1.1GHz  
dual-core  
Intel Core m3

RAM 8GB of 1866MHz 
LPDDR3
GRAPHICS Intel HD 
Graphics 515
SSD 256GB

£1,049

12-inch 1.2GHz  
dual-core  
Intel Core m5

RAM 8GB of 1866MHz 
LPDDR3
GRAPHICS Intel HD 
Graphics 515
SSD 512GB

£1,299

12-inch 1.3GHz  
dual-core  
Intel Core m7

RAM 8GB of 1866MHz 
LPDDR3
GRAPHICS Intel HD 
Graphics 515
SSD 256GB or 512GB

£1,249 
or 
£1,419

 MODEL  KEY SPECIFICATIONS  PRICE

13-inch 
2.7GHz  
dual-core  
Intel Core i5

RAM 8GB of 1866MHz 
LPDDR3
GRAPHICS Intel Iris 
Graphics 6100
SSD 256GB

£1,199

15-inch 
2.2GHz  
quad-core  
Intel Core i7

RAM 16GB of 1600MHz 
DDR3L
GRAPHICS Intel Iris Pro 
Graphics
SSD 256GB

£1,599

15-inch 
2.5GHz  
quad-core  
Intel Core i7

RAM 16GB of 1600MHz 
DDR3L
GRAPHICS AMD Radeon 
R9 M370X
SSD 512GB

£1,999

 MacBook  MacBook Pro  Mac Pro

 Mac mini
 Choose a MacBook  Choose a MacBook Pro
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From 
£2,499

From 
£399

UPDATED
DEC 2013

EXPECTED
SOON

UPDATED
MAY 2015

EXPECTED
SOON

UPDATED
APR 2016

EXPECTED
2017

UPDATED
OCT 2014

EXPECTED
LATE 2016
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 Apple brought 3D Touch to the iPhone 
with the 6s and 6s Plus, providing extra 
interactions depending on the level of 
pressure you apply to the screen. For 
example, a light press on an email lets 
you ‘peek’ at its contents, so you can 
decide whether to delete it or, with a 
firmer press, ‘pop’ it open to reply to it.

While the new iPhone SE lacks 3D 
Touch, it matches many features of the 
iPhone 6s, from a 12MP rear camera 
and 4K video recording to an A9 chip 
and M9 motion coprocessor. All that 
comes in a compact 4-inch case, so it 
has plenty of power and is perfect for 
anyone put off by the larger iPhones.

All models have front-facing 
cameras for video calls. There’s also 
Live Photos, which capture the 
moments before and after you take a 
photo to make a short video, plus all 
feature high-quality Retina displays.

 Aside from the beautifully gargantuan 
12.9-inch iPad Pro (see right), there was 
a small but very welcome change to 
Apple’s tablet line-up last September 
with the addition of the iPad mini 4, 
which is essentially an iPad Air 2 in 
a smaller chassis. The Air 2 hasn’t 
changed since late 2014, though.

On the software side, iOS 9 has 
brought multitasking features, which 
are a boon for productivity. You can 
slide a second app over the right side 
of the one you’re working in (great for 
quickly checking email), then dismiss it 
to get back to work. Picture in Picture 
enables you to watch video in a corner 
of the screen – but it may be a bit too 
small on the mini. Those two features 
work on the Air 2, mini 2 and Pro and 
newer models. There’s also Split View, 
on the Air 2, mini 4 and Pro, which lets 
you work on two apps side by side.

 MODEL  KEY SPECIFICATIONS  PRICE

iPhone SE 
(4-inch 
display)

CAPACITY: 64GB
PROCESSOR: A9
3D TOUCH No
CAMERA 12MP photos,  
4K video recording

£439

iPhone 6s 
(4.7-inch 
display)

CAPACITY: 128GB
PROCESSOR: A9
3D TOUCH Yes
CAMERA 12MP photos,  
4K video recording

£619

iPhone 6s 
Plus  
(5.5-inch 
display)

CAPACITY: 128GB
PROCESSOR: A9
3D TOUCH Yes
CAMERA 12MP photos,  
4K video recording

£789

 MODEL  KEY SPECIFICATIONS  PRICE

iPad mini 4 CAPACITY 64GB 
PROCESSOR A8
CONNECTIVITY Wi-Fi
CAMERA 8MP
TOUCH ID Yes

£399

iPad Air 2 CAPACITY 64GB
PROCESSOR A8X
CONNECTIVITY Wi-Fi
CAMERA 8MP
TOUCH ID Yes

£429

12.9-inch 
iPad Pro

CAPACITY 128GB
PROCESSOR A9X
CONNECTIVITY Wi-Fi
CAMERA 8MP
TOUCH ID Yes

£799

 iPhone  iPad

 Choose an iPhone  Choose an iPad
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 The iPad Pro now comes in 9.7-inch 
and 12.9-inch sizes, packed with either 
32GB, 128GB or 256GB of storage. 
All models except the 32GB, 12.9-inch 
one are available with the option of 
mobile network connectivity. The Pro’s 
A9X chip is the most powerful in any 
iOS device, and it has an impressive 
four-speaker sound system, too. Adding 
the pressure-sensitive Apple Pencil 
makes it an accomplished drawing tool.

 Apple’s first foray into the world of 
high fashion certainly turned heads 
when it arrived on the scene. Apple has 
since released a slew of updates in the 
form of watchOS 2, which expands the 
capabilities of third-party apps, as well 
as a range of new case colours and 
strap options (although hardware 
specifications are unchanged). 

Among the new straps are several 
Woven Nylon models in various vibrant 
colours, plus a snappy yellow Sport 
Band made of comfy fluoroelastomer. 
The Watch comes in aluminium, 
stainless steel or 18-carat gold cases, 
the first of which now has Gold and 
Rose Gold colour options.

 iPad Pro

 Watch

From 
£499

From 
£259

UPDATED
MAR 2016

EXPECTED
SEPT 2016

UPDATED
SEPT 2015

EXPECTED
Q3 2016

UPDATED
MAR 2016

EXPECTED
Q3 2016

UPDATED
SEPT 2015

EXPECTED
MID 2016?
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 MONITOR

 NETWORK STORAGE

 PRINTER

 ULTRA HD MONITOR

 WIRELESS ROUTER

 PORTABLE STORAGE

 THUNDERBOLT DOCK

 MACBOOK BAG

 If you’re not fussed 
about 4K but still want 
exceptional image quality, 
this IPS display is truly 
superb. It offers 99% 
coverage of the Adobe 

RGB colour space, 10-bit colour and a 
2560x1440-pixel resolution. It has HDMI 
1.4, DVI and Mini DisplayPort connections, 
and four USB 3.0 ports for expansion.

 Winner of MF294’s NAS 
group test, the My Cloud 
Mirror provides Apple-like 
ease of use – but it’s no 
Time Capsule knock-off; 
with top performance 

(thrashing its group test rivals when it 
came to writing large files), whisper-quiet 
operation and a good range of features, 
it’s great if you want more from a NAS.

 This versatile laser 
printer got the nod in 
MF300’s group test. 
Its light design, feature 
list, and impressive print 
quality make it a great 

choice for home office users. AirPrint and 
Wi-Fi connectivity means it plays nice with 
your iOS devices. It’s not great for printing 
photos, but is a winner at everything else.

 The recent winner of 
our 4K displays group 
test, this 32-inch screen 
is a joy to work with, and 
a monitor of this size is 
the perfect setting for 4K 

to really come into its own. From stunning 
picture quality and top-notch contrast 
ratio to the reasonable price for such a 
wide display, it’s a winner all round.

 This aggressively-named 
router may be expensive, 
but it’s one of the best 
that money can buy. 
Sporting four aerials, the 
Nighthawk boasts four 

separate signals for a total speed of 2.5 
gigabits per second. And with dual-band 
802.11ac Wi-Fi, AirPrint support and an 
excellent app, it’s one powerful router.

 Light, speedy and 
astonishingly small, 
the Samsung T1 is the 
definition of portable SSD 
storage. As well as having 
an attractive design, it is 

among the best-performing drives of its 
kind that we’ve tested, features AES-256 
hardware-based encryption, and is more 
affordable now than when we reviewed it.

 Our MF297 group test 
winner got the nod for its 
beautifully compact form 
and superb menu bar 
tool, which lets you eject 
individual drives as you 

please (something its rivals failed to offer). 
It’s not the most laden with ports, but has 
everything that most people will need, 
and comes in at a great price point.

 A beautifully made bag 
with a surprising amount 
of space inside. You’ll love 
the little touches, such as 
its big chunky zips and 
flashes of colour. It’s easy 

to turn the Knomo James into a smart 
office bag by removing the backpack 
straps, and Knomo provides each bag with 
a tracking ID in case yours goes AWOL.

BEST BUYS… curated picks of third-party kit 

NEW!

ViewSonic VP2772 
£569
viewsonic.com

Western Digital 
My Cloud Mirror £255
wdc.com

Brother HL-3150CDW 
£149
brother.co.uk

AOC U3277PQU 
£574
aoc.com

Netgear Nighthawk X4S 
£252
netgear.co.uk

Samsung T1 SSD
From £88
samsung.com

CalDigit Thunderbolt 
Station 2 £180
caldigit.com/uk

Knomo James
£169
knomobags.com

 DESKTOP SPEAKER

 Just one listen to these 
desktop speakers will tell 
you they’re in a class of 
their own. Their firm bass 
and detailed, rich sound 
packs a punch thanks to 

80W output, and they feature Bluetooth 
streaming and a wide range of analogue 
and digital inputs. Hi-fi quality audio for 
£200? Sounds great to us!

Roth OLi POWA-5
£200
rothaudio.co.uk
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 WIRELESS SPEAKER

 IP CAMERA  iPHONE STAND  APPLE WATCH STAND

 This airship-inspired 
speaker is certainly 
striking, but it’s more than 
just a looker, with crisp, 
clear treble and refined 
bass output over previous 

Zeppelin models. Support for Bluetooth, 
Spotify Connect and AirPlay makes for 
plenty of connectivity, and dynamic EQ 
ensures controlled bass at all volumes.

 Winner of MF299’s 
group test, the Logi Circle 
is packed with features. 
It’s so easy to use and can 
be powered by batteries, 
making it highly portable. 

With a wide 135° field of vision, it captures 
plenty of detail, and is very affordable. The 
Logi Circle is a barnstorming all-rounder, 
and looks great on your mantlepiece.

 Charge your iPhone in 
style with this simple yet 
elegant stand. From the 
curved backstop to the 
rounded aluminium base, 
it oozes Apple-esque 

design chops and will fit right in among 
your other Apple kit. The Lightning 
connector can be tilted to help mount 
your iPhone on it, which is a nice touch.

 Nomad’s stand is an 
absolutely gorgeous 
Apple Watch charging 
dock – carved from a 
single piece of curved 
aluminium, it looks like 

it could have been designed by Apple. 
Its weighty base keeps everything in place 
and the cable management is so tidy that 
it looks like there’s no cable there at all.

BEST BUYS… curated picks of third-party kit 

 PORTABLE BATTERY PACK

Apple iPhone 6s Smart 
Battery Case £79
apple.com/uk

 Despite that silly-looking 
hump on its back, the 
official battery case for 
the iPhone 6 and 6s is 
impressive. It’s easy to fit, 
the buttons feel great, 

and the soft inner lining protects against 
scratches. It isn’t the largest capacity case, 
yet it has more than enough juice for busy 
days, and the bump is surprisingly comfy.

Bowers & Wilkins 
Zeppelin Wireless £499
bowers-wilkins.co.uk

 ON-EAR HEADPHONES

 Wireless headphones 
are often blighted by 
meagre battery life, but 
not so with these cans, 
which run for more than 
25 hours. They offer 

active noise-cancelling, brilliant wireless 
range, superb comfort and a huge range 
of intuitive touch controls, making these 
the wireless headphones to beat.

Plantronics Backbeat 
Pro £125
plantronics.com

Logi Circle
£120
logitech.com

 IN-EAR HEADPHONES

 These in-ear buds 
impress on nearly every 
level. They come with 
easy-to-use inline controls 
and a steel-reinforced 
cable, while faultless low 

and mid range reproduction and a crafted, 
premium feel make them earphones of 
distinction. They are a world away from 
Apple’s cheap earbuds.

RHA MA 750i
£90
rha-audio.com

Just Mobile AluBolt
£41
just-mobile.com

 PORTABLE BLUETOOTH SPEAKER

 Hi-fi king Kef brings its 
audio know-how to the 
portable speaker world 
and blows away the 
competition. Firm bass, 
a rich, detailed sound 

and sturdy build combine to form one 
impressive package, while you won’t be let 
down by the solid battery life. It’s one of 
the best portable speakers you can buy.

Kef Muo
£299
kef.com

Nomad Stand for 
Apple Watch £50
hellonomad.com

 ACTION CAMERA

 GoPro has built a truly 
formidable reputation for 
itself as an action cam 
champ, and rightly so. 
The Hero4 Session may 
be compact, but it’s a 

great all-rounder. Internal waterproofing, 
an outstanding app and impressive video 
quality, combined with an affordable price 
tag, make it a firm favourite at MacFormat.

NEW!

GoPro Hero4 Session 
£159
gopro.com
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Where's Tim?
Find Apple's CEO & friends

Find them all!
1x Tim Cook
1x Jony Ive
1x Steve Wozniak
1x Steve Jobs poster
4x Anglepoise iMacs
2x Bondi Blue iMacs
1x Original Macintosh
10x iPods 
1x  Apple-themed birthday cake
1x  Apple Car 
8x iPad Pros
4x El Capitan desktops
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